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WARNING! 

Programmable control devices such as EZRACK PLC are not fail-safe devices and as such must 

not be used for stand-alone protection in any application. Unless proper safeguards are used, 
unwanted start-ups could result in equipment damage or personal injury. The operator must be 

made aware of this hazard and appropriate precautions must be taken. 
 
In addition, consideration must be given to the use of an emergency stop function that is 
independent of the EZRACK PLC. 
 
The diagrams and examples in this user manual are included for illustrative purposes only. The 
manufacturer cannot assume responsibility or liability for actual use based on the diagrams and 
examples. 
 

Trademarks 

This publication may contain references to products produced and/or offered by other 
companies. The product and company names may be trademarked and are the sole property of 

their respective owners. EZAutomation disclaims any proprietary interest in the marks and names 

of others. 

 
© Copyright 2017, EZAutomation 

All Rights Reserved 

 
No part of this manual shall be copied, reproduced, or transmitted in any way without the prior 

written consent of EZAutomation.  EZAutomation retains the exclusive rights to all information 

included in this document. 
 
Designed and Built by AVG 
4140 Utica Ridge Rd. Bettendorf, IA 52722-1327 

 
Marketed by EZAutomation 
4140 Utica Ridge Road Bettendorf, IA 52722-1327 
Phone: 1-877-774-3279 (EASY)    Fax: 1-877-775-3279     www.ezautomation.net  
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Technical Support 
 
For technical questions please consult this manual, the hardware manual or the EZRack PLC 
Designer Pro tǊƻƎǊŀƳƳƛƴƎ {ƻŦǘǿŀǊŜ IŜƭǇΦ Cƛƴŀƭƭȅ ȅƻǳ Ŏŀƴ ŦƛƴŘ ŀƴǎǿŜǊǎ ƛƴ ǘƘŜ ŘƻǿƴƭƻŀŘΩǎ 
section of our website www.ezautomation.net. If you still need assistance, please call our 
technical support at 1-877-774-EASY or FAX us at 1-877-775-EASY. 

 
 
Manual Revision History  

Revision Date Pages Affected Changes Made 

A.1 June 2017 All Original 

A.1.1 July 2017 Section 8.7 Added Information 

A.2.0 October 2017 All Name change, auto addressing 
change, Add Ch. 9 and Ch. 10 

A.2.1 January 2018 Section 2.5.8, 
Section 3.2, 
Chapter 11 

BCD32 support dropped, Sparkplug 
support added, Upgrade Firmware 

  

http://www.ezautomation.net/


 

10 
 
 
 
 
 
 
 
 
 
 

#ÈÁÐÔÅÒ ρȡ 'ÅÔÔÉÎÇ 3ÔÁÒÔÅÄ 
In ǘƘƛǎ /ƘŀǇǘŜǊΧ 

1.1 EZRack PLC Designer Pro .......................................................................................................... 11 

1.1.1 System Requirements ....................................................................................................... 11 
1.1.2 Installation ........................................................................................................................ 11 

1.2 EZSTART (Creating/Opening PLC project) ................................................................................ 14 

1.2.1 Programming Ladder Logic ............................................................................................... 18 
1.2.2 Creating a Complete Rung ................................................................................................ 20 

 
  

1 
EZAutomation 



 

11 
 

1.1 EZRack PLC Designer Pro   
EZRack PLC Designer Pro is an intuitive and simple to use Relay Ladder Logic (RLL) Editor for 
ǇǊƻƎǊŀƳƳƛƴƎ 9½!ǳǘƻƳŀǘƛƻƴΩǎ 9½Rack PLC. EZRack PLC Designer Pro includes functionality to 
create new EZRack PLC programs, edit existing EZRack PLC programs, simulate EZRack PLC 
programs, go online and monitor the EZRack PLC, and debug any EZRack PLC programs.  
 

1.1.1 System Requirements  
The EZRack PLC Designer Pro works on Windows PCs running Windows 7 or Windows 10 and 
requires at least 60 MB of free space on hard drive for installation. 
 
Use an EZ-PGMCBL cable, EZ-WiFi module or Micro-USB to transfer/write your program from the 
PC to EZRack PLC. 
 
After initial setup the EZRack PLC can be connected to over Ethernet. 
 

1.1.2 Installation  
The EZRack PLC Designer Pro is distributed as a single setup file. The setup file for the Designer 
Pro is EZRack PLC Designer Pro x.x.x (FULL) Setup.exe. 
 

 
 
Installation of the EZRack PLC Designer Pro is quick and simple. Just run the setup file and follow 
the on screen instructions. The default directory where the software ƛƴǎǘŀƭƭǎ ƛǎ άC:\ Program Files 
(x86)\ EZAutomation\EZRack PLC 5ŜǎƛƎƴŜǊ tǊƻέ. You may also choose to install EZRack PLC 
Designer Pro in another directory as specified in installation settings. If you are familiar with the 
installation process, you may skip the detailed instructions. 
 
To Install  
Below are the detailed instructions for installing the software. Just follow the instructions step 
by step to install EZRack PLC Designer Pro on your hard drive. 
 

1. Double click on the Setup file. It will verify the installer files. 
 
 
 
 
 
Once verifying is complete, it will show you the next window. 
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2. /ƭƛŎƪ άbŜȄǘέ ōǳǘǘƻƴΦ    
 
 
 
 
 
 
 
 
 
 

3. Please read the License Agreement text 
and if you accept, ŎƭƛŎƪ ƻƴ άL !ƎǊŜŜέ 

 
 
 
 
 
 
 
 
 
 
 

4. The setup program will display the dialog 
box below to allow you to choose the 
installation folder. As a default, the folder 
is άC:\ Program Files (x86)\EZAutomation 
\ EZRack PLC Designer Proέ. You can 
change this if you would like to.  
 
Click the Install button to start 
installation. 
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5. During installation you will see a dialog 
box which will list in detail the files being 
copied to your hard drive for installation.  

 
 
 
 
 
 

 
6. After copying necessary files and making registry entries, the installation is complete, 

and you will see the dialog box below. Click the Finish button to finish the installation. 
The setup program will place a shortcut icon on your desktop. 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
To Uninstall  
If you need to uninstall this program, you can use the Uninstall command from Start->All 
Programs->EZRack PLC-> Uninstall. 
 
The uninstaller will prompt you to make sure that you want to uninstall EZRack PLC Designer Pro 
and all its components from your computer. If you select YES, all the components of EZRack PLC 
Designer Pro will be uninstalled from your computer. 
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1.2 EZSTART (Creating/Opening PLC project)  
You can start the EZRack PLC Designer Pro in one of the following 2-ways: 
1. Click the EZRack PLC Designer Pro Icon. 
2. Select the program using Start>All Programs>EZAutomation>EZRack PLC Designer Pro. 
 
The dialog box allows you to select Programming mode, Project folder location, and Project 
Name. In addition, you can configure the EZRack PLC I/O base (defining I/O module locations 
and addresses) from this dialog box. 
 

Step 1: Select ACTION 
 
 
Open / New Project:  
Select this mode to create a new 
program or edit an existing 
program in OFFLINE mode.  
 
 
 
 
 
 
 
 
 
Read From PLC 
This mode allows you to first 
read an existing project from a 
PLC, save it on PC, and then edit 
your program OFF-LINE. You may 
want to use this mode if you do 
not have your program on your 
computer. For reading back the 
program, the EZRack PLC can be 
in RUN or PROGRAM mode. 
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Step 2: Select Project Name 
Enter the name of the project. The Project 
Location field indicates the folder name 
where the Project will be saved. If need 
be, use the Browse button to select a 
different Project location.  
 
 
 
 
 

Step 3: Selecting and Configuring I/O Base 
 
(You can do this later when you start 
programming) 
Select the I/O base for your PLC. Currently, 
EZRack PLC offers I/O bases for 3, 5, and 7 
modules.  After selecting the I/O base size, 
click on the Configure I/O button to define 
the placement and the addresses of the 
I/O modules (See dialog box on left). 
 
 
 

The Module slot positions are identified as M1, 
M2, M3 etc., on the I/O base. The dialog box shows 
only the available module positions for the 
selected I/O base. For example, a 3-module base 
will show only M1-M3 positions, while a 7-slot 
base will display rows M1-M7. 
 
To Manually Configure a module on a position, 
double click the row corresponding to the position 
number (say M1) or click the Add/Edit button.  
 
OR 
 
You can also Auto Configure the IO Modules by 
ŎƭƛŎƪƛƴƎ ǘƘŜ ά!ǳǘƻ /ƻƴŦƛƎǳǊŜ Lh aƻŘǳƭŜǎέ ōǳǘǘƻƴΦ 
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Manual Configuration 
After clicking the Add/Edit button you will get the Edit 
IO Module Data Dialogue Screen. Select the module 
ǘȅǇŜ ŦǊƻƳ ǘƘŜ ŀǾŀƛƭŀōƭŜ ƳƻŘǳƭŜǎ ŀƴŘ ƛǘΩǎ I and/or O (IR 
and OR for analog) addresses from respective drop 
downs. You select the start address of the module, 
and the software computes and fills up the end 
address of the module automatically. 
 
 
 

Auto Configure 
For Auto Configure please make sure that the PC 
and PLC are connected (either serially, over 
micro-usb, or over Ethernet). 
 
 
 
 
After clicking the ñAuto Configure IO Modulesò 
button you will see dialog on the next page. 
 

 

 
 
 
 
 
 

 
 

The EZRack PLC Designer Pro will read back the PLCs configuration and the table on the next 
page will display the results. It will also display the rack size detected in the configuration. 
 
Current Configuration -- This the currently selected configuration in the EZRack software.  
 
Detected Configuration -- This the detected configuration of the EZRack PLC. 
 
Select Configuration -- Please select whether to use the current configuration in the software or 
the detected configuration. You can also select All in the section right under the title. 
 
Final Configuration -- This will display the configuration which will be now configured in the 
software. 
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Please note: there are certain module families which include multiple modules of different types 
like ñSinkingò or ñSourcingò for Digital Outputs and ñVoltageò or ñCurrentò for Analog modules 
cannot be differentiated. Therefore please make sure the correct module is selected under the 
detected configuration. 

 

Step 4: Configure PC to PLC Communication 
(You can do this later too, when you start programming) 
This allows you to select the communication port on your PC that would be used to transfer 
developed ladder logic to the EZRack PLC. You can make this selection later in the COM 
Configuration options of main design screen. 
 
Serial Communication 
For serial communication you can use a serial cable (EZ-PGMCBL see 
Appendix 1). If your computer does not have a serial port then we 
recommend using an USB to Serial Converter. Serial Communication is 
also the option used when using a Micro-USB cable to program you 
PLC. The EZRack PLC Designer Pro will auto detect the Com Port that 
are currently being used. Please select the correct Com Port which 
corresponds to the communication cable. The EZRack PLC utilize fixed 
serial com parameters (set at 38.4 Baud, 8, N, 1). 
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Ethernet Communication 

Ethernet communication can be 
used once the EZRack PLC IP 
address is configured. To use 
Ethernet Communication please 
specify the IP address of the PLC 
you wish to communicate with. Please note that if your computer has 
trouble communicating please check that your PC subnet and gateway 
match the PLCs. 

    
AVG WiFi 
You can also purchase an EZ-WiFi module to use to communicate with 
the EZRack PLC, to do so select the AVG WiFi option. The AVG WiFi 
option will automatically detect any EZ-WiFi module and then it can be 
used exactly like the Ethernet and Serial communication options. 
 

 
 
Simulator 
At any time you can simulate your logic by loading it to the simulator. 
This allows you to see how your created logic functions without needing 
any external equipment. Note: This does not download the project to a 
PLC. 
 

 
 
Communication Options Table 

Communication 
Type 

PC to PLC Connection Option 

Functionality 

Transfer 
to PLC 

Read from 
PLC 

Monitor PLC 
(Online) 

Debug PLC 
(Online) 

Upgrade 
Firmware 

Serial Cable (EZ-
PGMCBL) 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ 

Micro-USB 
Cable 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ* 

Ethernet 
Ethernet (Input IP 
Address) ṉ ṉ ṉ ṉ ṉ* 

EZ-WiFi AVG WiFi ṉ ṉ ṉ ṉ ṉ* 

USB Drive 
USB Drive (Create USB 
file) ṉ X X X ṉ* 

ṉ* Note: Upgrading using these methods requires the EZRack Editor v2.1 or higher and the firmware on the EZRack 

PLC to be vA.0.297 or higher. If try to upgrade from vA.0.256 or lower these methods will not work. 
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1.2.1 Programming Ladder Logic  
Once you make your selections in the first dialog box and click OK, you will come to the main 
programming screen as shown below: 

To program a rung, perform the following steps: 
1. Select instruction. You can select instructions using a menu, or tool bar, or the operator 

bar on the right. The operator bar provides all instructions symbols organized by types. 
Once you select an instruction, the cursor changes shape. Click on the location in the 
rung area where you want to place the instruction. 

 
2. Connect all placed instructions by using the Line tool. 

 
3. Double click on any instruction to program its parameters. 

 
4. At any time you may Syntax check the logic by selecting View>Syntax Check - Current 

Logic. 
 

5. Once you are satisfied with the Ladder Logic, you can transfer the developed project to 
the EZRack PLC by selecting File > Transfer to PLC menu. 

 
¢ƘŀǘΩǎ ŀƭƭ ȅƻǳ ƴŜŜŘ ǘƻ Řƻ ǘƻ ǇǊƻƎǊŀƳ ƭŀŘŘŜǊ ƭƻƎƛŎ ŦƻǊ EZRack PLC. The following chapters 
describe the EZRack PLC Designer Pro User Interface, Ladder Logic Programming, and 
Instructions in detail.  

Toolbars (Section 2.2, 2.3, & 2.4) 

Main Ladder Logic 
Programming Area 

Project View / Quick Access Bar 
(Section 2.6) 

Operator Bar (Section 2.7) 
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1.2.2 Creating a Complete Rung  
This short example is provided to show you just how easy it is to create a completed rung using 
EZRack PLC Designer Pro. To complete a rung, perform the following steps: 

1. Place an instruction onto the Main Logic window. In this 
ŜȄŀƳǇƭŜΣ ǿŜΩǾŜ ǳǎŜŘ ǘƘŜ Normally Open Contact 
instruction. 
2. tƭŀŎŜ ǘƘŜ ƻǘƘŜǊ ƛƴǎǘǊǳŎǘƛƻƴǎ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ƛƴŎƭǳŘŜ ƛƴ ȅƻǳǊ 
rung onto the Main Logic window. In this examǇƭŜΣ ǿŜΩǾŜ 
used another Normally Open Contact and a Normally 
Open Coil instruction. 
3. Use the Line Tool to draw a horizontal line connecting 
the first Normally Open Contact instruction to the 
Normally Open Coil instruction. 
4. Use the Line Tool to draw a vertical line connecting the 
first Normally Open Contact instruction to the second 
Normally Open Contact ƛƴǎǘǊǳŎǘƛƻƴ ŀƴŘ ȅƻǳΩǊŜ ŦƛƴƛǎƘŜŘ 
completing a rung.  

 
5. Now you just need to add 
addresses by double clicking on 
the instructions.  
 
6. In the instruction dialogue input 
a Tag Name and click OK or press 
enter. The instruction will prompt 
you for a Tag Address. For this 
example use Tag Name: Start 1, 
Start 2, and Motor. For Tag address 
use S1, S2, and S3. 

 

7. ¢Ƙƛǎ ƛǎ ǿƘŀǘ ȅƻǳǊ wǳƴƎ ǎƘƻǳƭŘ ƭƻƻƪ ƭƛƪŜ ǿƘŜƴ ȅƻǳΩǊŜ 
finished. LǘΩǎ Ƨǳǎǘ ǘƘŀǘ ŜŀǎȅΗ 
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2.1 Main Programming Screen  

 
 
Title Bar 

The title bar displays the software name and logo as well as the name of the project currently 
open. 
 
Main Menu Bar 

This contains all of the drop menus available in EZRack PLC Designer Pro. Some of the menus are 
context sensitive, so they are hidden or displayed based on context. See Section 2.5 for more 
information. 
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Project View / Quick Access Bar 

This displays different elements being used in your current 
project. The Project View can also be used as a navigational tool. If 
you click onto an element in Project View, it will be displayed in 
the Logic Display Window. It also has quick access to most used 
functions like Transfer to PLC. Please see Section 2.6 for more 
information. 
 
 
Status Bar 

This line at the bottom of the screen displays the status of the 
current project. And current PLC Status if Online with PLC. 
 
Instruction Icons / Operator Bar 

This area contains all of the RLL Instruction 
icons you will use in your project. Please see 
Section 2.7 for more information. 
 
 
 
 
 
 
 
 
 

 
 
 
 
Toolbars 

This is another way for you to access the RLL instructions and many other functions in EZRack 
PLC Designer Pro. Please see Section 2.2, 2.3 and 2.4 for more information. Most Toolbars are 
hidden away as default but can be accessed in Edit > Toolbars. 
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¶ Zoom In  

¶ Zoom Out 

¶ Syntax Check 

¶ Select Tool 

¶ Line Tool (Alt-L or double click in Ladder Logic) 

¶ Go To Rung 

¶ Go To Label 

¶ Tag Database 

¶ Toggle Operator Bar for Instruction Display 

¶ Monitor Mode / Edit Mode 

 
 
 
 
 
 
 
 
 
 
 
 
 

2.2 Standard Toolbar  
The EZRack PLC Designer Pro offers multiple toolbars for convenient access to many functions 
and instructions. These toolbars can be displayed or hidden using menu Edit > Toolbars. This 
section describes various tool bars available in EZRack PLC Designer Pro. For more information 
about these options see the MENU Section 2.5. 

¶ Open Project      

¶ Save Ladder  

¶ Save Project  

¶ Cut 

¶ Copy 

¶ Paste     

¶ Undo 

¶ Redo 

¶ Toggle Project View 

¶ Print       

¶ About 

¶ Help 

¶ Zoom Default 
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2.3 Instructions Toolbars  
 

2.3.1 Relay/Boolean Operations  
The Instructions Toolbar consists of icons for all the 
instructions available for Relay type instructions. 
These commands are also found in, and accessible 
from, the Main Menu > Instructions.  
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Normally Open Contact 

¶ Normally Closed Contact  

¶ Positive Contact  

¶ Negative Contact  

¶ Normally Open Coil  

¶ Normally Closed Coil  

¶ Set Coil  

¶ Reset Coil  

¶ Normally Open Contact ς Immediate Input  

¶ Normally Closed Contact ς Immediate Input  

¶ Normally Open Coil - Immediate Output  

¶ Normally Closed Coil - Immediate Output  

 
 
 
 
 
 

2.3.2 Compare Operations  
The Compare Operations Toolbar consists of icons for 
all the instructions available for Compare Operations. 
These commands are also found in, and accessible 
from, the Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Equal To 

¶ Not Equal To  

¶ Greater Than  

¶ Less Than  

¶ Greater Than or Equal To  

¶ Less Than or Equal To  

¶ Limit  

¶ Compare Values 
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2.3.3 Math Operations  
The Math Operations Toolbar consists of icons for all 
the instructions available for Math Operations. These 
commands are also found in, and accessible from, the 
Main Menu > Instructions. 

 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
  

¶ Add  

¶ Subtract  

¶ Multiply  

¶ Divide  

¶ Modulo  

¶ Absolute Value  

¶ X=Y Conversion  

¶ Format Conversion  

¶  Advanced Math  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.4 Bitwise Operations  
The Bitwise Operations Toolbar consists of icons for 
all the instructions available for Bitwise Operations. 
These commands are also found in, and accessible 
from, the Main Menu > Instructions. 

 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
 

¶ And  

¶ Or  

¶ XOR  

¶ Not  

¶ Shift Left   

¶ Shift Right  

¶ Rotate Left  

¶ Rotate Right  
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2.3.5 Move Operations  
The Move Operations Toolbar consists of icons for all 
the instructions available for Move Operations. These 
commands are also found in, and accessible from, the 
Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Move Data      

¶ Move Block  

¶ Block Fill  

¶ Move Table of Constants  

¶ Bit Move  

 

2.3.6 Timer/Counter /Drum   

The Timer/Counter/Drum Operations Toolbar consists 
of icons for all the instructions available for Timed 
Operations. These commands are also found in, and 
accessible from, the Main Menu > Instructions. 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

  

¶ Timer 

¶ Counter  

¶ Drum 

 

 

2.3.7 Program Control Operations  
The Program Control Operations Toolbar consists of 
icons for all the instructions available for Program 
Control Operations. These commands are also found 
in, and accessible from, the Main Menu > 
Instructions. 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Jump  

¶ For Loop  

¶ Next  

¶ Call Subroutine  

¶ Return (from a subroutine)  

 

2.3.8 String Operations  

The String Operations Toolbar consists of icons for all 
the instructions available for String Operations. These 
commands are also found in, and accessible from, the 
Main Menu > Instructions. 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
 

¶ String Move  

¶ String Compare  

¶ String Length  

¶ Pack String 

¶ Unpack String 
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2.3.9 Communications Operations  

The Communications Operations Toolbar consists of 
icons for all the instructions available for 
Communications Operations. These commands are 
also found in, and accessible from, the Main Menu > 
Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
 

¶ Open Port 

¶ Send to Serial Port 

¶ Receive From Serial Port 

¶ Close Port 

¶ Send to Marquee 

¶ Modbus Master 

 

2.3.10 Data Log Operations  

The Data Logging Operations Toolbar consists of icons 
for all the instructions available for Data Log 
Operations. These commands are also found in, and 
accessible from, the Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

¶ Log to File 

 

2.3.11 Datatype Conversion 
Operations  

The Datatype Conversion Operations Toolbar consists 
of icons for all the instructions available for Datatype 
Conversion Operations. These commands are also 

found in, and accessible from, the Main Menu > 
Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
 
 

¶ X=Y Conversion 

¶ Format Conversion 

 

2.3.12 Process Alarms / Faults 
Operations  

The Process Alarms / Faults Operations Toolbar 
consists of icons for all the instructions available for 
Process Alarms / Faults Operations. These commands 
are also found in, and accessible from, the Main 
Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 
 
 

¶ Alarm 

¶ User Defined Faults 
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2.3.13 Analog Operations  

The Analog Operations Toolbar consists of icons for 
all the instructions available for Analog Operations. 
These commands are also found in, and accessible 
from, the Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Ramp Generator    

¶ Scale (Linear) 

¶ Scale (Non-Linear) 

 

2.3.14 Function Blocks Operations  

The Function Operations Toolbar consists of icons for 
all the instructions available for Function Operations. 
These commands are also found in, and accessible 
from, the Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

 

¶ Alarm 

¶ Change of Values 

¶ Compare Values 

¶ Find Min & Max Value 

¶ Flasher 

¶ Limit 

¶ Ramp Generator 

¶ Scale (Linear) 

¶ Scale (Non-Linear) 

¶ String Pack 

¶ String Unpack 

¶ User Defined Faults 

 

2.3.15 IIoT  Operations  

The IIoT Operations Toolbar consists of icons for all 
the instructions available for IIoT Operations. These 
commands are also found in, and accessible from, the 
Main Menu > Instructions. 
 
All the icons for instructions shown in this section will 
be described in detail in Chapter 3 ς RLL Instructions. 

¶ IIoT (MQTT) Publish 
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2.4 PLC TOOLBAR  
The PLC Toolbar consists of icons for all the PLC hardware related functions. 

2.4.1 Project Operations  
The Project Toolbar consists of icons for all PC to PLC commands. These commands are also 
found in either Main Menu > File or Main Menu > PLC. Please see description under Menus for 
details of these functions. 

 

¶ Write to PLC       

¶ PLC Information  

¶ Reboot PLC  

¶ PLC Time and Date  

¶ COM Configuration  

¶ OEM Packager  

 

2.4.2 Online / Simulate Operations  
The Online / Simulate Toolbar consists of icons for going online with the PLC. You can also 
simulate your project with a virtual PLC. These commands are also found in Main Menu > 
Monitor . This functionality will described in detail in Chapter 4 ς Simulating / Monitoring / 

Debugging PLC Logic. 

 

a. Online 

b. Simulate 

c. COM Configuration 

2.4.3 Debug Operations  
The Debug Toolbar consists of icons for going debugging your project. These commands are also 
found in Main Menu > Monitor. 
  

¶ Start Debug 

¶ Run Debug 

¶ Single Step 

¶ Enable Outputs 
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2.5 MENUS  
The Main Menu bar consists of the following menus: 

 
Each of the above menus has a pull-down menu with further available options which will be 
described in this section. 
 

2.5.1 File Menu 
When you click onto the File Menu, you can access the following functions: 

 
Open Project 
To open an existing project or to create a new project 
while in a programming window, click on File > Open 
Project. The Step 1, Project Information dialog box 
will appear. Click on one of the SELECT ACTION 
buttons. Choose from the available project files or 
enter a new Project Name. Click on OK to open the 
project, or Exit to quit without opening. 
 
Close Project 
Click on File > Close Project to quit the current 
project. 
 
Save Ladder 
Click on File > Save Ladder to save the current ladder 
logic only. 
 
 

 
Save Project 
Click on File > Save Project to save the current project. Ladder, Project 
Attributes and databases will all be saved. 
 
/ƻǇȅ tǊƻƧŜŎǘ !ǎΧ 
Click on File > Copy Project As... to create a copy of your project under another name. Note: 
Current save file will remain open. 
 
{ŀǾŜ tǊƻƧŜŎǘ !ǎ tǊƻǘŜŎǘŜŘΧ 
Click on File > Save Project As Protected to save the current project as a password protected 
file. The Protection Password dialog box will appear, as shown on the following page: 
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Once saved, if you attempt to open this project again or read 
this project from an EZRack PLC, you will then be prompted to 
enter your password, as shown below: 

 
The password protection feature will prevent unauthorized users from viewing/editing the 
project, but will still allow a user to read from or write to an EZRack PLC. 
 
In the event that a user should not have 
access to edit a project, but have the 
ability to write to an EZRack PLC, click 
Cancel in the window above. This will 
provide the option to transfer the project 
to the EZRack PLC, as shown. 
 
 

 
 
 
Click Yes, and you will be prompted to 
transfer your project, as shown here. 
 
To Transfer your project first make sure the 
PC to PLC Connection selection is set to the 
configuration you are using. For serial cables 
or Micro-USB cables use the correct COM 
port. For Ethernet make sure the correct IP 
address is entered.  
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Copy RunƎǎΧ 
When you click on CƛƭŜ Ҕ /ƻǇȅ wǳƴƎǎΧ following window 
will appear. 
 
Using the Copy Rungs options you can copy rungs from 
another project into your existing project. Please select the 
rungs you would like to copy from the source project. Then 
select the place you would like to copy them to. If copying 
between Main Logic just select main logic. Otherwise select 
the subroutine you wish to copy to. 
 

 
Transfer to PLC... 

Transfer to PLC allows you to transfer the current 
(open) project to the PLC connected to your 
computer. 
 
If you would like to password protect this project 
on the PLC, select and input your password here. 
Note: There is no admin password therefore if you 
forget the password you cannot read back this 
project. 
 
Please make sure to configure your PC to PLC 
communication per what the connection is. See the 
communication options table below for more 
information. 
 

Communication Options Table 

Communication 
Type 

PC to PLC Connection Option 

Functionality 

Transfer 
to PLC 

Read from 
PLC 

Monitor PLC 
(Online) 

Debug PLC 
(Online) 

Upgrade 
Firmware 

Serial Cable (EZ-
PGMCBL) 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ 

Micro-USB 
Cable 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ* 

Ethernet 
Ethernet (Input IP 
Address) ṉ ṉ ṉ ṉ ṉ* 

EZ-WiFi AVG WiFi ṉ ṉ ṉ ṉ ṉ* 

USB Drive 
USB Drive (Create USB 
file) ṉ X X X ṉ* 

ṉ* Note: Upgrading using these methods requires the EZRack Editor v2.1 or higher and the firmware on the EZRack 

PLC to be vA.0.297 or higher. If try to upgrade from vA.0.256 or lower these methods will not work. 
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/ǊŜŀǘŜ h9a tŀŎƪŀƎŜΧ 
Create OEM Package allows you 
to create an executable file 
which can be used without 
EZRack PLC Designer Pro to 
transfer both the PLC project 
and PLC firmware (if need be) to 
the EZRack PLC.  
 
This screen allows you to 
configure display settings for 
this OEM exec file. Also here you 
attach the firmware if needed. 
After clicking OK the packager 
will create the file which can 
then be sent to your user.  

 
/ǊŜŀǘŜ ¦{. [ƻŀŘŜǊ CƛƭŜΧ 
The create USB Loader File option can be used to load a PLC program to the EZRack PLC over an 
USB drive. To do so please follow the directions below. 
 

Load PLC project over USB Drive (Creating USB Loader File & Loading file to EZRack PLC): 
1. To create USB Loader File click on File > Create USB Loader File. The following dialog will 

appear. 

 
2. Use the Browse option to navigate to navigate to the USB drive.  
3. Click the Create USB Project FIle to create the avg.plc file(file must be named avg.plc to 

function). 
4. The USB is now ready to be used. 
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How to use USB to Load project onto EZRack PLC 
5. Please turn off the EZRack PLC. 
6. Insert the USB into EZRack PLC. 
7. Apply power to the EZRack PLC. Upon power up the PLC project will be transferred to 

the PLC. 
Note: Only 1 file can exist on the USB at a time to be loaded to the PLC. 

 
Create USB Firmware File 
There may be occasional upgrades to your EZRack PLC internal software, also referred to as the 
Exec or Firmware. This can be done over USB drive. Firmware can also be updated over other 
communication, please see Upgrade Firmware section. To do so please follow the direction 
below. 
 

To Upgrade Firmware (Creating USB Firmware File and Upgrading EZRack PLC): 
1. Back up the user program currently stored in the PLC and save to disk. Firmware 

upgrade will clear the project on the PLC. 
2. Go to File > Create USB Firmware File. After clicking you get the following dialog. 

 
3. Use the first Browse to navigate (click the on Browse button) to the new firmware file 

(.hex_plc file). 
4. Use the second Browse to navigate to the USB drive. Note: This file should go into the 

main folder of the USB drive, please do not hide it within sub-folders. 
5. Once both Firmware file and Create location have been selected please click the Create 

USB Firmware File. 
6. The USB should now have a file ezr_fw.mme file which is your firmware file. Note: The 

USB should not have a USB Loader file (avg.plc file). If it does please delete this file.  
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How to use USB to Upgrade EZRack PLC 
7. Insert the USB with the file ezr_fw.mme on it into the EZRack PLC. Note: This will clear 

the PLC project. 
8. Wait, the EZRack PLC will start alternatively flashing the red and yellow LED while it is 

upgrading the firmware. 
9. Once the firmware upgrade is finished the PLC will automatically restart.  
10. You will now have to download the project. Or you can use a different USB to load the 

project back on the PLC. 
 
Print 
When you click on the Print menu item, you will 
be asked if you want to save the project. Click 
on Yes or No. Once you click Yes or No it will 
take you to another screen as follows: 
 
Using this screen, you can choose if you want to 
print the Tag Database or the Rungs in the 
ladder logic program 
 
 
Print Setup 
Choose or change your print settings here. 
 
Exit 
Click on Exit to quit the program. 
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2.5.2 Edit Menu  
When you click onto the Edit Menu, you can access the following functions: 
 

Undo / Redo 
The Undo command is used to reverse the previous 
action. This function must be performed next in order 
for the action to be undone. The undo command goes 
back sixteen levelǎ ƻŦ ǳƴŘƻΦ wŜŘƻ ǿƛƭƭ άǊŜŘƻέ ǘƘŜ 
previously undone action. 
 
 
Cut 
This allows you to Cut (remove) a selected item(s) to 
the clipboard. 
 
 
Copy 
This allows you to Copy (without removing) a selected 
item(s) to the clipboard. 
 
 

Paste 
This allows you to Paste a selected item from the clipboard onto the displayed screen. 
 
Select All 
Click on Select All to select all items on the displayed screen. 
 
Delete 
Click on Delete to remove a selected item without placing it on the clipboard. 
 
Edit 
Select an object and then click on the Edit command to make changes to ŀƴ ƻōƧŜŎǘΩǎ κ 
ƛƴǎǘǊǳŎǘƛƻƴΩǎ ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎΦ 
 
 
 
 
 
 
 



 

39 
 
Toolbars  
Click on Toolbars to see the available menu where you can 
click on the desired toolbars to be displayed on the toolbar 
section of the main screen. 
 
 
When Edit Multiple 
¢ƻƻƭōŀǊǎΧ is selected, it 
further takes you to the 
following screen which 
allows you to hide/select 
multiple toolbars from 
one dialog box. You can 
also restore the default 
toolbar configuration 
here. 
 
 
 
Default Tag Data Type 
Default Tag Data Type allows you select the default Tag (memory location of PLC) type. Every 
time a new Tag is added after this, it will have the default type as chosen by this command 
through the following screen: 

 
Go to wǳƴƎΧ 
Use this option for a convenient way to quickly navigate to the desired rung. The menu will open 
the following dialog box: 
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Dƻ ǘƻ [ŀōŜƭΧ 
Use this option to go the specified label as shown in the following screen: 

 
Show Address on Instruction 

The EZRack PLC can show the address of the Tag or not show based on this 

selection. If this is selected the tag address is displayed otherwise it is 
hidden.   
 
 
For Example: 
 

Tag Name and Address     Tag Name Only 
 
 
 
Address Suggestion Preferences 
The EZRack PLC will suggest addresses based on the select starting point here. Initially it will start 
from Address 1 and suggest the next available address. The user can at any point tell the software 
to start suggesting from a different starting point. For example if starting address is set to 200 
then if 200 is available that will be the next suggested address, if it is not then it will go to 201 and 
so and so forth. 
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2.5.3 View Menu  
When you click onto the View Menu, you can access the following functions: 

 
Syntax Check ς /ǳǊǊŜƴǘ [ƻƎƛŎΧ 
Use this option to display any errors present in the 
logic currently being displayed on the screen. Once 
selected, it displays the following message if NO errors 
are found. 
 
 

 
 
 
If there are errors in the current logic, then it displays a similar screen as below with all the 
errors present along with their position (e.g. rung etc.): 

Syntax Check ς !ƭƭ [ƻƎƛŎΧ 
When using Syntax Check ς All Logic, EZRack PLC Designer Pro checks the entire ladder logic 
program and displays the errors if found as shown above for Syntax Check ς Current Logic. 
 
 
aŀƛƴ [ƻƎƛŎΧ 
Click on this option to display the Main Logic in the Main Window of EZRack PLC Designer Pro 
when Interrupt or Subroutine logic is present in the Main Window. Main Logic, as the name 
suggests, is the main logic of your control program.  
 
You can place some of the functions as Subroutine Logic, which is then called from main logic. 
You may want to use Subroutine to write some logic once and use at many places in your main 
logic (by calling it), or just to organize your main logic in modules. 
 
The interrupt logic is a special logic section, which is executed when an external interrupt 
occurs. The purpose of interrupt logic is to provide a fast response to some time-critical events. 
You will need to use the Interrupt input module to trigger execution of Interrupt logic. 
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LƴǘŜǊǊǳǇǘ [ƻƎƛŎΧ 
Click on this option to display Interrupt Logic in the Main Window of EZRack PLC Designer Pro. 
 
 
Subroutine Logic 
Click on this to display the Subroutine Logic in the Main Window of the EZRack PLC Designer Pro. 

 
Note: To display and switch between Main Logic, Interrupt 
Logic, and Subroutine Logic, you can also use the Project 
Window to display the appropriate logic in the Main Window. 
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2.5.4 Subroutine Menu  
Subroutines have two main uses. One, you can write some commonly used functions once, and 
use those multiple times within the main logic by calling the subroutine. Second, you can use 
subroutines to write modular logic. You can have multiple subroutines within a project. You can 
call a subroutine from another subroutine. Such nested calls cannot exceed 8 levels deep. Total 
maximum number of subroutines is 64. When you click onto the Subroutine Menu, you can 
access the following functions: 
 

 
Add 
Use this function to add a Subroutine. 
 
Rename 
This function can be used to rename a Subroutine. 
 
Delete 
This function can be used to delete an existing subroutine. 

 
 
Note: Subroutines can also be added by right clicking on 
Subroutine in the Project Window. 
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2.5.5 Rung Menu  
When you click onto the Rung Menu, you can access the following functions: 

 
Insert New Rung 
Click on this to add a new rung to the main ladder logic program. 
 
Insert Rows 
This function is used to add single 
or multiple rows within a rung. In 
order to use this function, first 
select the RUNG in which you wish 
to add single or multiple rows. Then 
click on the sub menu as follows to 
add the appropriate number of 
lines within a RUNG.  
 

 
If you click on LƴǎŜǊǘ aǳƭǘƛǇƭŜ wƻǿǎΧ, the following screen will appear and will require the 
number the rows to be added within a RUNG. 

 
Delete Row 
Use this function to delete excessive rows from a RUNG. 
You must select a RUNG from where a row is to be 
deleted. If Logic exists on the row being deleted, it will 
prompt you with the following message: 
 
 
Cut 
Use this function for cut and paste functions for RUNGS present in ladder logic. Before you apply 
this function you must select the desired RUNG which is to be Cut. Once RUNGS are cut using 
this function, they can be pasted into the desired location using the Insert Copied Rungs 
function. 
 
Copy 
This function is used to Copy the selected Rungs present in ladder logic. Once copied they can be 
pasted using the Insert Copied Rungs function. 
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Insert Copied Rungs 
This function is used to paste RUNGS that have been Cut or Copied using the Cut and Copy 
functions in the Rung menu. 
 
Delete 
Use this function to delete the selected rungs from ladder logic. 
 
Insert Label / Comment 
Use this function to insert Label/Comment for a RUNG whose label and or comment were 
deleted using the Delete Label / Comment function. 
 
Edit Label / Comment 
Use this function to add Labels and Comments for individual rungs. Labels are useful when using 
the Jump instruction, which allows you to skip RUNGS and go to the one specified in Jump 
instruction. 
 
Clear Label 
Can be used to clear label of an individual RUNG. 
 
Clear Comment 
Can be used to clear the comments of an individual RUNG. 
 
Delete Label / Comment 
This function can be used to delete a Label and Comment for an individual RUNG. When 
deleted, a rung can be re-labeled / commented by using the Insert Label / Comment function in 
Rung Menu > Insert Label/Comment. 
 
Show Label / Comment 
Use this function to Hide or Display the Labels and Comments for all the RUNGS present in the 
ladder logic program. 
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2.5.6 Instructions Menu  
All the Instructions used for Relay Ladder Logic are 
explained in detail in Chapter 3 - RLL Instructions. When 
clicked on appropriate Instruction, the EZRack PLC Designer 
Pro allows you to place that instruction in ladder logic by 
clicking in the Main Programming window. 
 

      Relay/Boolean Instructions Menu 
 
 
 
 
 
 
 
 

 
Compare Instructions Menu 

 
 

           Math Instructions Menu 

Bit Logic Instructions Menu 
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Move Instructions Menu         Timer/Counter/Drum Instructions Menu 
 
 
 
 
 

      Program Control Instructions Menu 
   String Operations Menu 

 
 
 
 
 

                 
   Communication Instructions Menu 

        Data Logging Instructions Menu 
 
 
     Datatype Conversion Instructions Menu 
 
 

    Function Block Instructions Menu  
 
     Process Alarms/Faults Instructions Menu 

 
 
 

   Analog Instructions Menu 
   
 
 
 
                
                  IIoT Instructions Menu 
 
 
Line 
The Line Tool allows you to connect instructions and objects in the ladder logic. 
 
Selection 
Click on this function to switch back to the Selection Tool from the Line Tool 
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2.5.7 PLC Menu  
The PLC menu allows you to access and control the EZRack 
PLC. In order to utilize most of the functions present in this 
menu, EZAutomationΩǎ EZRack PLC must be connected to the 
programming PC. If the corresponding PLC is not connected 
to the programming PC, the following error messages will 
appear: 

 
 
Note: For all functions in the PLC Menu, upon communication timeout EZRack PLC Designer Pro 
will inform you that the function could not be completed due to a communication issue. 
 
Information 
Click on this function to acquire 
information for the PLC connected to 
the programming PC.  
 
When connected, it displays 
information regarding Status, Firmware 
Revisions, MAC Address, IP address and 
Memory used as shown in the following 
screen: 
 
 
 
 
Reboot 
Use this function to perform a Warm Reboot of the corresponding PLC while connected to the 
programming PC as shown in the following screen: 
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Clear Program 
This function is used to clear the existing program present in the memory of the PLC. When 
used, it will prompt for confirmation as follows: 

 
Warning: If you select Yes, the corrŜǎǇƻƴŘƛƴƎ t[/Ωǎ ǇǊƻƎǊŀƳ ǿƛƭƭ ōŜ cleared! 
 
Time/Date 
This function can be used to Monitor and Change the current Time and Date settings on a PLC. 
¢ƘŜ t[/Ωǎ ŎƭƻŎk can be set for either 24-hour or 12-hour along with the option to synchronize 
ǘƘŜ t[/Ωǎ ŎƭƻŎƪ ǿƛǘƘ ǘƘŜ clock of the programming PC as shown below: 

 
Start PLC 
Use this function to Start the corresponding PLC into RUN mode. 
 
Stop PLC 
Use this function to Stop the corresponding PLC when present in RUN/Program mode. 
 
 
 
 
 
 



 

50 
 
/ha /ƻƴŦƛƎǳǊŀǘƛƻƴΧ 

This function is only available when programming in Offline 
mode. Use this function to select the COM 
port / EtƘŜǊƴŜǘΩǎ Lt ŀŘŘǊŜǎǎ ƻŦ ȅƻǳǊ t[/ 
based on how you are connecting i.e. via 
the COM port or Ethernet port. Please see 
the Communications Options Table for 
more information. The following screen 
appears when this function is selected: 
 

 

¶ Serial Communication refers to communication through serial cable (EZ-PGMCBL see 
Appendix 1) and through Micro-USB cable. 

¶ For Ethernet communication, please enter the IP address of your corresponding PLC. 

¶ The AVG WiFi option will automatically detect any EZ-WiFi module and then it can be 
used exactly like the Ethernet and Serial communication options. 
 

Communication Options Table 

Communication 
Type 

PC to PLC Connection Option 

Functionality 

Transfer 
to PLC 

Read from 
PLC 

Monitor PLC 
(Online) 

Debug PLC 
(Online) 

Upgrade 
Firmware 

Serial Cable (EZ-
PGMCBL) 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ 

Micro-USB 
Cable 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ* 

Ethernet 
Ethernet (Input IP 
Address) ṉ ṉ ṉ ṉ ṉ* 

EZ-WiFi AVG WiFi ṉ ṉ ṉ ṉ ṉ* 

USB Drive 
USB Drive (Create USB 
file) ṉ X X X ṉ* 

ṉ* Note: Upgrading using these methods requires the EZRack Editor v2.1 or higher and the firmware on the EZRack 

PLC to be vA.0.297 or higher. If try to upgrade from vA.0.256 or lower these methods will not work. 

 
Switch Monitor Mode / Switch to Edit Mode 
Click on this function to switch between Monitor and Edit mode when connected to the 
corresponding PLC. Please see more information on Online Edit Mode and Monitor Mode in 
Chapter 4. 
Note: Monitor mode will not allow any editing of the ladder logic program present in the PLC. 
 
PID Monitor... 
Click on this to open the dialog box for the PID Monitor function. Please see more information in 
Chapter 6 ς PID. 
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2.5.8 Setup Menu 
When you click onto the Setup Menu, you can access the 
following functions: 
 
¢ŀƎ 5ŀǘŀōŀǎŜΧ 
The EZRack PLC Designer Pro will auto fill tag addresses for 
you. This functionality is explored more in section 3.3.2 
Auto Generated / Auto Fill Tags. 

 
Tag Database allows you to view and add/edit current and 
new Tags (memory addresses) of your corresponding PLC. 
Click on this function to display the following screen: 
 

 

 

 
As shown the Tag Database will display all the Tags that have already been entered for your PLC. 
The tag database will be prepopulated with the PLC system tags and any output / input module 
tags for any module that has been configured in your I/O setup. For more information please 
see the I/O Configuration section. 
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Add Tag 
Clicking onto the Add Tag button will 
display this screen:  
 

As shown in the Add New Tag Details 
screen, you can add the Tag Name 
and change the Tag Address. Based 
on the tag datatype the Memory type 
will change, also the Tag address will 
be preselected for you but you can 
change it. For more information 
please see the section 3.3.2 Auto 
Generated / Auto Fill Tags. You can 
also specify the Initial Value of the 
Tag that is being added, where the 
Initial Value is the value that the PLC 
assumes for this particular Tag when using it the first time. 
 
Tag Name: Every memory address (Tag) can also be assigned a Tag Name which is used while 
ǇǊƻƎǊŀƳƳƛƴƎ ǘƘŜ t[/Φ 9ΦƎΦ άhмέ ƛǎ ǘƘŜ ƳŜƳƻǊȅ ƭƻŎŀǘƛƻƴ ƻŦ physical output 1 present on an IO 
module. The tag name of prepopulated tags can also be changed. For I/O module tags the tag 
name has a specific format of M#.Tag_Name where # refers to the module position. The tag 
name is then used in all instructions to select this tag. Other than in specified cases "." cannot be 
used. Refer chart below for information on prepopulated tags and their format. 
 
Address Suggestion Preference 
The EZRack PLC will suggest addresses based on the 
select starting point here. Initially it will start from 
Address 1 and suggest the next available address. 
The user can at any point tell the software to start 
suggesting from a different starting point. For 
example if starting address is set to 200 then if 200 
is available that will be the next suggested address, 
if it is not then it will go to 201 and so and so forth. 

 
 

 
Tag DataType: The tag datatype will determine the Memory Type and how many address it will 
consume in memory. Discrete datatype will use S memory type, everything else will use R 
memory type. I/O tags are automatically generated based on the select I/O modules in the I/O 
Configuration.  
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Address: Address is used to specify the actual Tag (memory address) of the corresponding PLC. 
For example, O1 refers to Output 1, R1 refers to internal register 1, SR1 refers to system register 
1 etc. Please see section 3.3.1 Memory Map for more information on address ranges and 
specifications. 
 
Initial Value: When initial value is enabled you can enter the value that the tag will start with 
upon program load. All tags are retentive so upon power cycle the tag will retain the last value it 
was set to. Note: Retentive tags are battery backed therefore please make sure your battery has 
power. 
 

Example: 
As described above, the 
following screen is an example 
of adding a valid Tag whose 
Address is S1, Data Type is 
Discrete, and the Tag Name is 
Light1. Also, the Initial Value has 
ōŜŜƴ ŀǎǎƛƎƴŜŘ ǘƻ ōŜ hb ƻǊ άмέΦ  
 
 
When you have entered your 
Tag information, click on Apply 
Changes to add the new Tag 
created by Edit Tag Details. Click 
Close to return back to the main 
Tag Database screen. The # of 
Characters can only be specified 
when using an ASCII type Data Type for a word register and the maximum number of characters 
is 126. The main Tag Database screen also offers features for easy handling of Tags entered in 
the database. The section below describes all the functions available in this screen. 
 
 

Selection Menu 

 
You can either use the buttons in the bottom row or you can right click on the tag to access the 
selection menu. 
 
Add Tag: Use this to add new tags to the database. 
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Add Bit-In-Register Tag: This will add bit within words tag to the tag database. Will only function 
for the first 16 bits of a word, please select the needed word before pressing the tag.  
 
Edit Selected Tag: Will bring up Edit Tag Details screen and you can change the Tag Name, Tag 
Data Type, Address and Initial Value for the Tag. 
 

 

Duplicate Selected Tag: This option will bring up the 
duplicate tags dialog. Using this the tag can be 
duplicated either with the same address or 
incrementing the address by a set amount. 
 

 

 

 

  

Delete Selected Tag: This will delete the selected tag. 
 

 
 

When you select a tag in the tag database you 
will have the following options: Edit Selected 
Tag, Duplicate Selected Tag, and Delete Selected 
Tag.  
 

 
 
Search and Replace 

The Search and Replace function can be 
used to find and replace Tags present in 
the Tag Database. This allows you to 
easily make changes to Tags previously 
entered in the database. 
 

Filters 
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Filters allow you to only display certain tags in the tag database. Use the Show All Tags to go 
back to default view with all tags visible. 
 

Discrete Inputs: Will only show (I) discrete inputs. 
 
Discrete Outputs: Will only show (O) discrete outputs. 
 
Analog Inputs: Will only show (IR) analog inputs. 
 
Analog Outputs: Will only show (OR) analog outputs. 
 
Discretes: Will only show (S) internal discretes. 
 
Registers: Will only show (R) internal registers. Includes bit within words for internal registers. 
 
Floats: Will only show floating point tags. 
 
Strings: Will only show string tags. 
 
System Discretes: Will show all System Discretes. 
 
System Registers: Will show all System Registers. 
 
Highlight Unused Tags 
When this check box is checked, it will highlight all the tags in the PLC database which are not 
being utilized by an instruction. When checked it will highlight unused Tags as follows: 
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As shown in the above screen, all the Tags not being utilized anywhere in the PLC program will 
be highlighted.  
 
You can also delete these Tags which might be present in access by clicking on Delete Unused 
Tags which will prompt the following message: 

 

  

 
If YES is selected, the corresponding Unused Tags in the database will be deleted. 

 
 

 
 

 

Table of Tag Formats 
This table describes all the different possible tag formats that exist. While it may look 
complicated most of these are auto created for you so the user only needs to create the basic 
tags. Note: All tags can have their name modified except for system and reserved tags. 

 
Tag Name 
Structure 

Possible Data 
Types 

Description How Created Example 

TAG_NAME Discrete or 
Register 

This is the basic tag the suer can create and 
modify the address of. 

User Created. LIGHT, VALUE1 

TAG_NAME.# Discrete (Bit 
within word) 

Bit access to the register. Works with Registers 
only. 

User Created. VALUE1.0 

TAG_NAME.RES# Register Reserved tags for internal calculations. Auto Created for certain 
function blocks. 

VALUE1.RES1 

M#.INPUT_# Discrete Module # Inputs. User can changed name. Created during I/O Config. M1.INPUT_1 

M#.OUTPUT_# Discrete Module # Outputs. User can changed name. Created during I/O Config. M3.OUTPUT_7 

M#.INPUT_REG_# Discrete Module # Input Registers. User can changed 
name. 

Created during I/O Config. M7.INPUT_REG_3 

M#.OUTPUT_REG_# Discrete Module # Output Registers. User can changed 
name. 

Created during I/O Config. M5.OUTPUT_REG_5 

M#.TAG_NAME Discrete or 
Register 

Specialty module # tags. User can changed 
name. 

Created during I/O Config. M4.CNTR1_COUNTS 

_SD_TAG_NAME Discrete System discrete. Always in project. _SD_FIRST_SCAN 

_SR_TAG_NAME Register System register. Always in project. _SR_MINUTES 
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I/O Address Format for EZRack PLC 
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¢ŀƎ /Ǌƻǎǎ wŜŦŜǊŜƴŎŜΧ 
This function is extremely useful for 
identifying the objects and instructions 
utilizing a certain PLC Tag in the ladder logic 
program as shown in the following screen:  
 
As shown, Tag Cross Reference provides all 
the details where and how many times a 
certain Tag is used in the ladder logic 
program. In ǘƘŜ ŜȄŀƳǇƭŜ ǎƘƻǿƴΣ ǘƘŜ ά/[h{9έ 
discrete is being used in two instructions: The 
Log Data to File instruction is present in Rung 
2, Row 3, Column 4 and the Normally Closed 
Contact instruction is present in Rung 2, Row 
3, Column 1.  

 
Tip: Use the Cross Reference function before changing the functionality of any Tag. This will 
allow you to figure out very quickly where and how many times that register is utilized in the 
ladder logic program. 
 

Tag Cross Reference By Ladder LogicΧ 
This function allows you to see all the tags 
used in specified locations. You can therefore 
cross reference the tags used in the message 
database or PID Loop with the ones used in 
your main logic, interrupt logic and 
subroutines. 
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Read AVG Panel/PLC TagsΧ 

This function is particularly useful when 
using EZRack PLC with AVG Panels. Using 
this function, the Tag Database of a project 
can be very easily populated by 
automatically reading from a pre-existing 
Tag Database of an AVG Panel or another 
EZRack PLC project. Click on this function to 
display this screen. 
 
As shown in the example screen, you can 
decide which pre-existing project is to be 
used for copying and adding the Tag 
information to the existing Tag Database. 
Click on the Browse button to select the 
directory and the name of the project to be 
utilized for copying the Tag information. 
As shown in the Read AVG Panel/PLC 
¢ŀƎǎΧ screen, you also have the option to 
select the action in case the Tag being 

copied to the Tag Database already exists. 
 
Export Tags 
Click on this function to expand this menu as shown:  
 
When Comma delimited is selected, this function exports all the Tags in the Tag Database into a 
CSV file as specified by the user in the following screen: 
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When ¢ƻ 9ȄŎŜƭΧ is selected, this function automatically opens Excel software on the 
programming computer and exports all the Tags in the Tag Database as shown below: 

 
bƻǘŜΥ ²ƘŜƴ ǳǎƛƴƎ ǘƘŜ ά¢ƻ 9ȄŎŜƭΧέ ŦǳƴŎǘƛƻƴΣ ǘƘŜ EZRack PLC Designer Pro software automatically 
ƻǇŜƴǎ ŀ ƴŜǿ ά.ƻƻƪмΦȄƭǎέ ŦƛƭŜ ŀƴŘ ŜȄǇƻǊǘǎ ǘƘŜ ¢ŀƎ ƛƴŦƻǊƳŀǘƛƻƴΦ !ƭǎƻ ǘƘŜ ŦƛƭŜ ƛǎ bh¢ ǎŀǾŜŘ ƻƴ ǘƘŜ 
hard drive unless you manually save it. You must have Microsoft Excel software installed on your 
computer to utilize this function. 
 
 
Import Tags 
Click on this function to expand this menu as shown: 
 
 
 
 
When Comma delimited is 
selected, this function imports 
all the Tags present in a CSV 
file as specified by the user in 
the following screen:  
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Once the user has selected a CSV file which is to be 
imported, the following screen will appear and 
prompt user as follows for more information: 
 
Select first row contains header information if the 
csv file has header information like Tag Name, Tag 
Address, etc. 
 
Select only Import address for tags that have the same Name and Data Type if you want to 
overwrite the tag address information of tags already in the project. 
 
 
 
When 9ȄŎŜƭ ŦƻǊƳŀǘΧ is selected, 
this function imports all the Tags 
present in an Excel file as 
specified by the user in the 
following screen: 
 
 
 
 
 

 
Once the user has selected an Excel file which is to be 
imported, the following screen will appear and 
prompt user as follows for more information: 
 
Please make sure to map the correct headers to the 
corresponding Tag database header. 
 
Select first row contains header information if the csv 
file has header information like Tag Name, Tag 
Address, etc. 
 
Select only Import address for tags that have the 
same Name and Data Type if you want to overwrite 
the tag address information of tags already in the 
project. 
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Project hǇǘƛƻƴǎΧ 
Click on the Miscellaneous button to 
select options for Multiple Drop, 
Clearing registers on program upload, 
and Displaying information for 
warnings as shown in the following 
screen: 
 
Multiple Drop: This option allows you 
to add multiple elements after 
selecting the element e.g. select NO 
Contact and put 5 of them in your 
ladder logic. 
 
 
Clear Register on program upload: When the project is transferred to the PLC, this options 
means all the registers will be cleared and set to initial value of the transferred project (no initial 
value equals 0). 
 
Display duplicate warning: EZRack PLC Designer Pro allows you to use coils with the same 
address in multiple places but unless done correctly this type of coding can cause problems. 
Therefore this option will warn you about these instances and if there is no need please use coils 
such that there are no such instances. 
 
Password: To always require a password for project read back from PLC select this option and 
enter the password. Note: There is no admin 
password therefore if you forget the 
password you cannot read back this project. 
 
Clear registers: The EZRack PLC has 
retentive registers therefore upon power up 
the registers are set at the last known 
values. If you would like to clear registers 
upon power up you can use these options to 
select the specific range of registers to clear. 
Note: Retentive tags are battery backed 
therefore please make sure your battery has 
power. 
 
The Application Color tab allows the user to edit the color and configuration for the Ladder Logic 
programming window as shown in the screen above.  
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Lκh /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧ 
Click on this function to select the I/O configuration for your corresponding PLC as shown in the 
screen below: 

 
 
 
 
The Module slot positions are identified 
as M1, M2, M3 etc., on the I/O base. The 
dialog box shows only the available 
module positions for the selected I/O 
base. For example, a 3-module base will 
show only M1-M3 positions, while a 7-slot 
base will display rows M1-M7. 
 
 
 
 
 

 
To Manually Configure a module on a position, double click the row corresponding to the 
position number (say M1) or click the Add/Edit button.  
 
OR 
 
You can also Auto Configure ǘƘŜ Lh aƻŘǳƭŜǎ ōȅ ŎƭƛŎƪƛƴƎ ǘƘŜ ά!ǳǘƻ /ƻƴŦƛƎǳǊŜ Lh aƻŘǳƭŜǎέ 
button. 
 
 
Manual Configuration 
After clicking the Add/Edit button you will get the Edit 
IO Module Data Dialogue Screen. Select the module 
ǘȅǇŜ ŦǊƻƳ ǘƘŜ ŀǾŀƛƭŀōƭŜ ƳƻŘǳƭŜǎ ŀƴŘ ƛǘΩǎ I and/or O (IR 
and OR for analog) addresses from respective drop 
downs. You select the start address of the module, 
and the software computes and fills up the end 
address of the module automatically. 
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Auto Configure 
For Auto Configure please make sure that the 
PC and PLC are connected (either serially, over 
micro-USB, or over Ethernet). 
 

 
 
 
 
 
 
After clicking the ñAuto Configure IO Modulesò 
button you will get the following dialog. 
 

 

 

 

 

 

 

The EZRack PLC Designer Pro will read back the PLCs configuration and the table above will 
display the results. It will also display the rack size detected in the configuration. 
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Current Configuration -- This the currently selected configuration in the EZRack software.  
 
Detected Configuration -- This the detected configuration of the EZRack PLC. 
 
Select Configuration -- Please select whether to use the current configuration in the software or 
the detected configuration. You can also select All in the section right under the title. 
 
Final Configuration -- This will display the configuration which will be now configured in the 
software. 
 
Please note: there are certain module families which include multiple modules of different types 
like ñSinkingò or ñSourcingò for Digital Outputs and ñVoltageò or ñCurrentò for Analog modules 
cannot be differentiated. Therefore please make sure the correct module is selected under the 
detected configuration. 

 

Ethernet Setup... 

Select this function for defining the Ethernet 
settings for your corresponding PLC. When 
selected, the following screen will be shown. 
 
As shown, you can specify the IP Address, Subnet 
Mask, and Gateway for the corresponding PLC. To 
set the PLC Ethernet parameters please use either 
serial cable, Micro-USB cable, or AVG WiFi.  
 
You can also configure the EZRack PLC to use a 
DNS server. Please enter the IP address of the 
DNS servers here. If you do not want to use this 
option please leave them as 0.0.0.0. 
 
 
Note: You cannot set Ethernet parameters over 
Ethernet. 

 
Note: Transferring a project to the PLC does not set these parameters. 
 
PID... 
Click on this to open the PID Setup dialog box (explained in greater detail in Chapter 6). 
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Upgrade Firmware  
There may be occasional upgrades to your EZRack PLC internal software, also referred to as the 
Exec or Firmware. (Check the EZAutomation website periodically for information about software 
and firmware upgrades.) 

 

To Upgrade Firmware (Serial, Ethernet and Micro-USB): 
1. Back up the user program currently 
stored in the PLC and save to disk. Firmware 
upgrade will clear the project on the PLC. 
2. Click on Upgrade Firmware and 
navigate (click the on Browse button) to the 
new firmware file (.hex_plc file). 
3. Select the appropriate communication 
option (please see table below) under PC to 
PLC Connection and click on the OK button 
to begin the upgrade. 
4. If the PLC is running you will be asked to 
stop the PLC. If the PLC is not stopped the 
firmware upgrade will not happen. 
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5. On the next screen click continue to start the upgrade. The status bar will let you know 

when the upgrade is complete. 
 

Note: For Ethernet and Micro-USB the firmware will first download then an upgrade will 
happen. You can cancel the upgrade only during download. When upgrade is happening on 
the PLC the red and yellow LED will alternate flashing. 
 
Note 2: If Ethernet or Micro-USB firmware upgrade fails then the firmware upgrade over a 
serial cable will always work to fix any corrupted firmware.  

 

 
To Upgrade Firmware (USB): Please see the Create USB Firmware File section. 
 
Communication Options Table 

Communication 
Type 

PC to PLC Connection Option 

Functionality 

Transfer 
to PLC 

Read from 
PLC 

Monitor PLC 
(Online) 

Debug PLC 
(Online) 

Upgrade 
Firmware 

Serial Cable (EZ-
PGMCBL) 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ 

Micro-USB 
Cable 

Serial (Select Com Port) ṉ ṉ ṉ ṉ ṉ* 

Ethernet 
Ethernet (Input IP 
Address) ṉ ṉ ṉ ṉ ṉ* 

EZ-WiFi AVG WiFi ṉ ṉ ṉ ṉ ṉ* 

USB Drive 
USB Drive (Create USB 
file) ṉ X X X ṉ* 

ṉ* Note: Upgrading using these methods requires the EZRack Editor v2.1 or higher and the firmware on the EZRack 

PLC to be vA.0.297 or higher. If try to upgrade from vA.0.256 or lower these methods will not work. 
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Message Database 
The Message Database for EZRack 
PLC Designer Pro is used for 
populating a messages which can 
be utilized with the Send to 
Marquee instruction. Click on this 
function to display the Message 
Database Edit screen. 
 
Note: For more information on 
how to use the Send to Marquee 
instruction please see Chapter 5. 
 
 

 
 
 
Click onto the Add/Edit button to display the following 
screen:  
 
In the Add New Message window, add the details of 
the message as shown. You can select the message 
number, marquee address, message positioning, and 
message text along with options for previewing the 
messages exactly how they would appear on an 
EZMarquee when sent. Click on Add New Message to 
add the message to the database and continue the 
same operation for all the messages that need to be 
populated. 
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av¢¢ {ŜǘǳǇΧ 
The MQTT Setup allows you to configure the options for the Industrial Internet of Things (IIoT). 
For more information about IIoT and how it works please see Chapter 8. To use the setup follow 
the directions below: 
 
The needed information for this setup is: 

Information Type Description Example 

Domain Name This is the broker URL. Used to find your 
broker that you have configured.  

m12.cloudmqtt.com 

Port Number Port number that your broker uses. 16581 

Client ID Individual connection ID. Needs to be different 
for every client otherwise will encounter 
problems. Can be random. 

ee097f5c-fa36-4929-
9414-fad17b3df3bd 

User Name Your configured username for EZRack PLC 
connection to broker. Should be different for 
every client. 

 

Password Your configured password for EZRack PLC 
connection to broker. Should be different for 
every client. 

 

 

Instruction to setup MQTT: 

1. Go to {ŜǘǳǇ Ҕ av¢¢ {ŜǘǳǇΧ. You will see the following dialog box appear. 
 
2.  Use the Domain Name Lookup 
with the Domain Name from the 
broker to find the Broker IP 
Address.  
 
3. Enter the port number from the 
broker. 
 
4. Select your keep alive interval if 
wanted. See section 8.6 for more 
information. 
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5. Enter a unique client ID or generate one using the Generate Unique Id button. 
6. Enter the user name and password for your broker. 
7. Go to the MQTT topics. 

 
8. In the MQTT Topics use the Add Topic button to create the prefixes for your tags. 

The publish instruction will publish the tagname as a topic but if you want to have 
more topic information create the prefix here. For example: 
 
bƻǘŜΥ !ŦǘŜǊ ǘƘƛǎ ǘƻǇƛŎ ŀƴ άκέ ƛǎ ŀǇǇŜƴŘŜŘ 
 
Topic: EZRack PLCPLC/Machine1 
TagName: Speed 
 
Published Topic: EZRack PLCPLC/Machine1/Speed 
 

9. Now in your ladder logic add the IIoT (MQTT) Publish instruction and configure it. 
For configuration options please see Section 3.3.16. 
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EtherNet/IP Adapter {ŜǘǳǇΧ 
The EZRack PLC supports Ethernet/IP Adapter communication. This communication is for the 
EZRack to act as Adapter to external device Scanner. This section will define how to setup the 
EZRack PLC and how to setup an Allen-Bradley PLC to act as Scanner to the EZRack PLC. 
 

EZRack PLC Setup 
To setup the EZRack to communicate as an Ethernet/IP Adapter follow the direction below: 
 

1. Go to Setup > EtherNet/IP Adapter Setup... You will see the following screen appear: 

 
2. This screen allows you to setup which tags are to be used for the Adapter. You can either 

use a contiguous block of registers (example R1-R250) or you can select the registers you 
would like to send. The maximum number is restricted to 250 Input and 250 Output. 

 
3. Important information for the setup of Scanner is the Connection Parameters of the Input / 

Output Assembly Instances and the Input / Output Word size. Make sure to setup this 
information in your Allen-Bradley PLC after you have selected all tags that you will send and 
receive. 
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System Discretes: 
 

_SD_EIP_SCAN
NER_CONNECT
ED 

SD26 Read Only Indicates when the EtherNet/IP Adapter is connected with 
an EtherNet/IP Scanner. 

_SD_EIP_SCAN
NER_TIMEOUT 

SD27 Read Only Indicates when the EtherNet/IP Adapter connection times 
out (after 3000 mSec) 

 
 
System Registers: 
 

_SR_EIP_
SCANNER
_IP1 

SR21 Read 
Only 

This will have the IP address of the EtherNet/IP Scanner which is 
connected to the EZ Rack PLC. 

_SR_EIP_
SCANNER
_IP2 

SR22 Read 
Only 

This will have the IP address of the EtherNet/IP Scanner which is 
connected to the EZ Rack PLC. 

_SR_EIP_
SCANNER
_IP3 

SR23 Read 
Only 

This will have the IP address of the EtherNet/IP Scanner which is 
connected to the EZ Rack PLC. 

_SR_EIP_
SCANNER
_IP4 

SR24 Read 
Only 

This will have the IP address of the EtherNet/IP Scanner which is 
connected to the EZ Rack PLC. 

 

Allen-Bradley Setup 
To setup an Allen-Bradley PLC to communicate to the EZRack PLC please use RSLogix 5000. 
 

1. In the selected project under your Ethernet option click to Add New Module. 

 
2. In the Select Module Type find the Generic Ethernet Module. Select this module and the following 

dialog will show up: 
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3. Add a name for your module and put in the Comm Format as Data INT. Also put in the IP Address of 
your EZRack PLC. 
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4. Copy the Connection Parameters from the EZRack PLC to the Connection Parameters of the New 

Module. Set the Assembly Instance Configuration to 1. 

5. Click OK to create the module. In the Connection settings please use an RPI of 10 ms or more. A faster 
RPI does work but is not as reliable. You can also choose to use any of the other settings all function 
with the EZRack PLC. 
 

 
6. After hitting apply you have created a connection between the EZRack PLC and the Allen-Bradley PLC. 

As soon as both projects are transferred to their respective PLCs they will communicate together and 
exchange the selected tag information. Note: Allen-Bradley tags will be in the Controller Tags area 
under the name of the Generic Ethernet Module. 
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2.5.9 Monitor  Menu  
When you click onto the Monitor Menu, you can access the 
following functions. These functions and there uses are 
explored in more detail in Chapter 4. Note: Most functions are 
not available unless you are Online or Simulating your project.  
 
Go Online 
Click on this function to go online with an EZRack PLC. The 
EZRack PLC Designer Pro will communicate with the PLC using 

the COM parameters setup in t[/Ҕ/ha /ƻƴŦƛƎǳǊŀǘƛƻƴΧ. The EZRack PLC Designer Pro will 
either transfer and Go Online with the currently open project or go online with the project that 
is in the PLC. If you are transferring the currently open project you will get the option to save the 
project that is on the PLC. Use this function before entering Monitor Mode or Debug Mode. 
More information is in Chapter 4. 
 
Simulate 
Click on this function to simulate your currently open project without need for any external 
hardware. After clicking this the EZRack PLC Designer Pro will transfer this project to the 
simulator and then behave like you are Online with a PLC (No need for any PLC and does not use 
configure COM parameters). When simulating you can also use Monitor Mode and Debug 
Mode. More information is in Chapter 4. 
 
Start Debug 
Click on this function to start Debug mode where you can add break points to your logic to 
examine what is happening. To start Debug Mode please be either Online with your PLC or 
Simulating your project. More information is in Chapter 4. 
 
Run  
When in Debug Mode (need to Start Debug before this can be used) click on this function to Run 
your logic. With no break point Run will start normal logic running. If there is a breakpoint then 
Run will cause your logic to do 1 scan till your breakpoint where it will stop. Clicking Run again 
will execute the rest of your logic till the next breakpoint. More information is in Chapter 4. 
 
Single Step 
When in Debug Mode (need to Start Debug before this can be used) click this function to single 
step through your logic. Single step only works after you have reached a breakpoint. Before this 
function can be used, Run needs to be clicked with a breakpoint added to your logic. This 
function does not single step through rows, it will single step by rungs. More information is in 
Chapter 4. 
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Enable / Disable Outputs 
When in Debug Mode (need to Start Debug before this can be used) click on this function to 
enable or disable your outputs. When debugging it might be useful to not have the PLC activate 
your outputs therefore use this function to disable them. As soon as Debug Mode is left then 
outputs will be re-enabled. More information is in Chapter 4. 
 
Switch Monitor Mode / Switch to Edit Mode 
Click on this function to switch between Monitor and Edit mode when connected to the 
corresponding PLC. Please see more information on Online Edit Mode and Monitor Mode in 
Chapter 4. 
 
Note: Monitor mode will not allow any editing of the ladder logic program present in the PLC. 
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2.5.10 Window Menu  
When you click onto the Window Menu, you can 
access the following functions. This menu will also 
list all the currently open windows (e.g. Main 
Logic, Subroutine Logic, and etc.). 
 
Close 
Use this function to close the current ladder logic 

window open in the main programming window. Double click on the ladder logic window in the 
Project View window to show them again. 
 
Close All 
Use this function to close all the ladder logic windows open in the main programming window. 
Double click on the ladder logic window in the Project View window to show them again. 
 
Cascade 
Click here to view open screen files in the window. Screens will cascade down the window, 
overlapping each other, but with their title bars in view. This is helpful when you are making 
changes to two or more screens at the same time. Click on the title bar of one of the screens to 
bring it to the front. The title bar is grayed out in screens that are not currently active. 
 
Tile 
Click here to view open screen files in the window. Screens will be arranged within the window. 
This is helpful if you want to copy or cut and paste objects or drawings between screens. The 
title bar is grayed out in screens that are not currently active. 
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2.5.11 Help Menu  
When you click onto the Setup Menu, you can access the 
following functions: 

 
IŜƭǇ ¢ƻǇƛŎǎΧ 
Click on Help Topics to view the help topics for the EZRack PLC Designer Pro Software. The help 
window is in Compiled HTML format. Use the Contents tab to view help topics by category. Click 
on the Index tab to view an alphabetical list of all help topics. Click on the Search tab and enter a 
word or words to search the help topics for. 
 
About EZRack PLC Designer tǊƻΧ 
Click on About EZRack PLC Designer Pro for copyright, manufacturer, and version number of the 
EZRack PLC Designer Pro Software. 
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2.5.12 Right -Click Menus  
In addition to the drop-down menus mentioned earlier in this section, there are two more 
menus available to give you more options while working with your EZRack PLC Designer Pro. 
They can be accessed by right-clicking in two different areas in the Main Programming Screen. 
These menus change based on what the current EZRack PLC Designer Mode is (Offline or 
Online). The Online menus will be discussed in Chapter 4, the menus settings discussed here are 
for Offline Mode only. 

 
Rung Edit Right Click Menu 
The first menu can be accessed by right clicking in the rungs 
area of the Main Programming Screen. 
 
When you right click in the Rung area (in the square above) 
the following menu will appear: 
 
Through this menu, you can access the following functions: 
Insert New Rungs, Insert Rows, Delete Rows, Cut, Copy, 
Insert Copied Rungs, Delete, Insert Label/Comment, Edit 
Label/Comment, Clear Label, Clear Comment, Delete 
Label/Comment, and Show Label/Comment. 
 
These functions are the function that are available in the 
Rung Menu of the Main Menu. Please see Section 2.5.5 of 
this chapter. 

 
Instruction Edit Right Click Menu 
The second menu can be accessed by right clicking in the 
Main Logic area of the Main Programming Screen. 
 
When you right click in the Main Logic area (in the square 
above) the following menu will appear: 
 
 
Through this menu, you can access the following functions: 
Cancel Selection, Edit, Cut, Copy, Paste, Delete, Select All, Go 
to Rung, Go To Label, Ladder Options, and Tag Database. 
 
These functions are the function that are available in the Edit 
Menu and in the Setup Menu of the Main Menu. Please see 
Section 2.5.2 and 2.5.8 of this chapter. 
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2.6 Project View / Quick Access Bar  
This side menu is a project view as well as a quick access bar to some 
often used functionalities. This is used to navigate through your created 
project logic including Main Logic, Interrupt Logic, and all Subroutine 
Logics. Then for quick access of menu items you have your different 
subsections, please see below for information on what you are 
accessing. 
 
 
 
 
Main Logic:  
As the name suggests, is the main logic of your control program. You 
can place some of the functions as Subroutine Logic, which is then 
called from main logic. You can have only 1 Main Logic. 
 
Interrupt Logic: 
The interrupt logic is a special logic section, which is executed when an 
external interrupt occurs. The purpose of interrupt logic is to provide a 
fast response to sometime critical events. You will need to use the 
Interrupt input module to trigger execution of Interrupt logic. You can 
have only 1 Interrupt Logic. 
 
 

Subroutine Logic: 
You may want to use Subroutine to write some logic once and use at many places in your main 
logic (by calling it), or just to organize your main logic in modules. You can have up to 64 
subroutines. You use the Program Control Instructions to call subroutines. To add subroutine 
right click on this selection or use menu option Subroutine. See Chapter 3 ς RLL Instruction for 
more information.  
 
Hardware Setup: 
ü I/O Table Layout ς Opens the I/O Configuration table. Please see Section 2.5.8 for more 

information. 
ü I/O Graphical Layout ς Opens the I/O Graphical Layout. Please see Section 2.8 for more 

information. 
 

Communication Setup: 
ü COM Configuration ς Opens the COM Configuration. Please see Section 2.5.7 for more 

information. 
ü Ethernet Setup ς Opens the Ethernet Setup. Please see Section 2.5.8 for more information. 
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Database: 
ü Tag Database ς Opens the Tag Database. You can see all the tags for this project. Please see 

Section 2.5.8 for more information. 
ü Tag Cross Reference ς Opens the Tag Cross Reference. This allows for locating all references 

to a tag. Please see Section 2.5.8 for more information. 
ü Message Database ς Opens the Message Database. You can see all messages for this 

project. Please see Section 2.5.8 for more information. 
 
PID Tuning: 
ü PID Setup ς Opens the PID Setup. This dialogue is used for creating up to 8 PID loops. Please 

see Chapter 6 for more information. 
ü PID Monitor ς Opens the PID Monitor. This is used for fine tuning PID loops when online 

with PLC. Please see Chapter 6 for more information. 
 
CPU Control: 
ü Start PLC ς Starts the PLC. PLC logic will start to execute. 
ü Stops PLC ς Stops the PLC. PLC logic will not execute if stopped. 
ü Transfer to PLC ς Transfers current open project to PLC. Please see Section 2.5.1 for more 

information. 
ü Create USB Loader file ς Creates USB Loader file that can be used to transfer project to 

EZRack PLC. Please see Section 2.5.1 for more information. 
 
Monitor:  
ü Go Online ς EZRack PLC Designer Pro goes online with PLC. Please see Chapter 4 for more 

information. 
ü Simulate ς Simulates the current open project. Please see Chapter 4 for more information. 
ü Switch to Monitor Mode / Edit Mode ς Switches current mode from Monitor Mode to Edit 

Mode and vice versa. . Please see Chapter 4 for more information. 
 
Debug: 
ü Start Debug ς Starts Debug Mode. This available after EZRack PLC Online with PLC or when 

Simulating Project. Please see Chapter 4 for more information. 
ü Run Debug ς Run Debug Mode. This available after in Debug Mode. Please see Chapter 4 for 

more information. 
ü Single Step ς Single Step through PLC Project. This available after you have Run Debug. 

Please see Chapter 4 for more information. 
ü Enable Outputs ς Enable Outputs or Disable Outputs when in Debug Mode. Please see 

Chapter 4 for more information. 
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2.7 Operator Bar  
The operator bar contains all the different instructions elements that can be used in the ladder 
logic. There are three ways to add instructions to ladder logic. First you can use the Instructions 
Menu (Section 2.5.6). Second you can use the Toolbar (Section 2.3.#). And finally you can use the 
operator sidebar right next to the Ladder Logic. The toolbar and sidebar can be hidden in the 
Edit>Toolbars Menu (Section 2.5.2). Below you can see all the possible instructions, please see 
Chapter 3 ς RLL Logic for more information. 
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2.8 I/O Graphical View  
The I/O Graphical view 
allows for both viewing 
the current status of the 
outputs and configuring 
the I/O the same way the 
I/O Table can.  
 
To configure please 
double click on module or 
click Auto Configure IO 
Modules. 
 
 
 
 

 
View Current Output Status 
When in Monitor Mode (Online with PLC or Simulating project) the I/O Graphical View will show 
you which outputs are ON and OFF. For Analog outputs it will indicate the value of the Analog 
output. 
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Manual Configure 
To manual configure the I/O in a specific slot 
double click on full or empty slot.  
For example if you double click on Slot M1 you 
will get the following dialogue allowing you to 
change the module in the slot. 
 
OR 
 
Auto Configure 
To auto configure click on the auto configure 
button. For Auto Configure please make sure 
that the PC and PLC are connected (either 
serially, over micro-usb, or over Ethernet). 

 
 
 
!ŦǘŜǊ ŎƭƛŎƪƛƴƎ ǘƘŜ ά!ǳǘƻ /ƻƴŦƛƎǳǊŜ Lh aƻŘǳƭŜǎέ ōǳǘǘƻƴ ȅƻǳ 
will get the following dialogue. 
 
 
 
 
 

 
The EZRack PLC Designer Pro will read 
back and let you know which modules 
are currently plugged into your PLC. If 
the PLC base is different size, EZRack 
PLC Designer Pro will also ask you if 
you would like to change your PLC 
base. For each module the system will 
then ask you to confirm the type 
module and whether you would like to 
change that position to this modules.  
 
Please note: ŎŜǊǘŀƛƴ ƳƻŘǳƭŜǎ ǎǳŎƘ ŀǎ ά{ƛƴƪƛƴƎέ ƻǊ ά{ƻǳǊŎƛƴƎέ ŦƻǊ 5ƛƎƛǘŀƭ hǳǘǇǳǘǎ ŀƴŘ ά±ƻƭǘŀƎŜέ 
ƻǊ ά/ǳǊǊŜƴǘέ for Analog modules cannot be differentiated so make sure the correct module is 
being selected. 
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3.1 Ladder Logic Programming in EZRack PLC  
EZRack PLC Designer Pro is used for developing relay ladder logic (RLL) programs using a 
Personal Computer (PC) running windows (Windows 7 or Windows 10). A PLC accepts inputs 
from a variety of devices such as Switches, Sensors, etc.; processes inputs according to user 
programmed control logic; and controls a variety of devices (e.g. relay, motors, valves etc.) 
connected to the outputs of the PLC. The Relay Ladder Logic is the user programmed control 
algorithm. 
 
A ladder program is made up of a set of instructions to achieve the desired control processes. 
Ladder Logic is built on the basis of electrical relay diagrams. A ladder diagram graphically 
represents the elements of an electro-mechanical circuit. The user makes rungs of a ladder 
comprised of series or parallel combinations of the input devices and memory locations, which 
are usually followed by an output device or memory location. The Output element is usually the 
last element on the rung. Based on the conditional state of the inputs, Output receives an action 
signal. When the logical rung continuity is not achieved, the output is not executed. 

 
 
An example of a rung is shown in the picture on the left. 
 
 

 
If you are new to RLL programming, here is a simple sequence you should follow to develop RLL 
(Relay Ladder Logic) programs: 
ω Define your machine automation or automated process 
ω Determine hardware requirements for the control action 
ω Define a control algorithm 
ω Assign inputs and output parameters of the process to the control algorithm 
ω Develop ladder program on a PC using EZRack PLC Designer Pro Software 
ω Match I/O addresses of the Controller to the correct input/output devices 
ω Simulate your program on PC using PLC Simulator 
ω Load the program into the PLC 
ω Validate / Debug the program 
ω Run program 
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3.2 Memory Map  
Each instruction is associated with one or more memory locations in the PLC. When tested, the 
logic instructions test, set, reset bits and/or modify values in associated bits and/or registers. 
EZRack PLC supports several types of memory elements (please see the hardware manual for a 
description of these). The tables below summarize various memory types and the ranges for 
each. 
 

Description Syntax Access Range Use 

Discrete Inputs I Read Only 1-128 For physical Discrete inputs (Input Image table, see below) 

Discrete Outputs O Read/Write 1-128 For physical outputs (Output Image table, see below) 

Discrete Internals S Read/Write 1-1024 General Purpose bits 

System Discretes SD See Table 1-16 System bits (some read-only) 

Input Registers IR Read Only 1-64 For Input modules providing register type information (such 
as counter module, analog input module) 

Output Registers OR Read/Write 1-64 For output modules providing register type information 
(such as counter module, analog output module) 

Registers Internals R Read/Write 1-16384 General purpose internal registers 

System Registers SR See Table 1-20 System Register (some read-only) some read-write 

 
What is Image Table? 
EZRack PLC first reads Inputs and stores them in its internal Image Table. Then it executes the logic where any 
reference to Inputs/Outputs made is read from the Image Table only (except for Immediate instructions) and NOT 
from the actual values of Inputs/Outputs on the EZLGX IO Modules. During execution, any Outputs changed are also 
written to the Image Table. After completion of the RLL execution, EZRack PLC writes the Outputs from the Image 
Table to EZLGX IO Modules and reads the Inputs again to the Image Table and the process continues. 
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3.2.1 System Discretes  
The table below describes all of the System Discretes available in EZRack PLC Designer Pro. 
 

System Discretes Name 
System 

Discretes 
Description Read/Write 

_SD_FIRST_SCAN SD1 First Scan Bit: Bit is On ONLY during the first scan of logic Read Only 

_SD_TOGGLE_100MS SD2 
Bit toggles every 100 mSec (the bit is ON for 100 mSec, and then off for 
100 mSec) 

Read Only 

_SD_TOGGLE_1S SD3 Bit toggles every second (the bit is ON for 1 Sec, and then OFF for 1 sec) Read Only 

_SD_RUN SD4 
Run Bit: Bit is 1 while PLC is executing ladder logic; HMI status 
indication  

Read Only 

_SD_OPEN_PORT SD5 
Setting this bit will open the port at the specified baud rate. Next, it will 
search for the Message Database for the defined message number in 
SR20. 

Read/Write 

_SD_SET_BAUD SD6 
If ON the baud rate of the serial port is set to 38400. If OFF the Baud 
Rate to is set to 9600. 

Read/Write 

_SD_MESSAGE_ERROR SD7 
This system discrete will be set if the Message Database is not defined 
or the message number is NOT defined. 

Read Only 

_SD_SEND_BUSY SD8 
This bit is set when a valid message is unable to be sent and will be 
retired. 

Read Only 

_SD_ANALOG_FILTER SD9 
If SD9 is ON, analog module input values will averaged so that value is 
more consistent and does not fluctuate as much. 

Read/Write 

NA SD10-13 Reserved ς DO NOT USE  

_SD_LOW_BATTERY SD14 Indicates low battery Read Only 

NA SD15-24 Reserved ς DO NOT USE  

_SD_USB_STATUS SD25 
Indicates the current status of USB. Whether there is a USB in (1) or if 
there is no USB (0). 

Read Only 

_SD_EIP_SCANNER_CON
NECTED 

SD26 
Indicates when the EtherNet/IP Adapter is connected with an 
EtherNet/IP Scanner. 

Read Only 

_SD_EIP_SCANNER_TIME
OUT 

SD27 
Turns ON when the EtherNet/IP Adapter connection times out (after 
3000 mSec). Note will be always OFF if EtherNet/IP Adapter never 
connected. 

Read Only 

_SD_SPARKPLUG_CONFI
G_ERROR 

SD29 This bit will turn on if the Sparkplug configuration has an error. Read Only 

_SD_SPARKPLUG_PUBLIS
H_ERROR 

SD30 
This bit indicates if the EZRack PLC is not able to publish a message to 
the broker. 

Read Only 

_SD_SPARKPLUG_RUNNI
NG_STATUS 

SD31 
This bit is ON if the Sparkplug MQTT is connected to the Broker and 
publishing correctly. 

Read Only 
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3.2.2 System Registers  
The table below describes all of the System Registers available in EZRack PLC Designer Pro. The 
numbers in these registers are in Binary format. 
 

System Register Names 
System 

Registers 
Description Read/Write 

Data 
Type 

_SR_MAJOR_REV SR3 Firmware Major Revision Read Only U16 

_SR_MINOR_REV SR4 Firmware Minor Revision Read Only U16 

_SR_BUILD_REV SR5 Firmware Build Number Read Only U16 

_SR_WATCHDOG_TIMER SR6 Watchdog Timer Register; Increments every 10 ms Read Only U16 

_SR_SCAN_TIME SR7 Scan Time in ms Read Only U16 

_SR_ERROR_MASK SR8 Status ς used to indicate errors (See below for defined bits) Read Only U16 

_SR_ERROR_NUM SR9 Error Message Number (see below for defined errors) Read Only U16 

_SR_SECONDS SR10 Real Time Clock (RTC) Second Read/Write U16 

_SR_MINUTES SR11 RTC Minute Read/Write U16 

_SR_HOUR SR12 RTC Hour Read/Write U16 

_SR_DAY SR13 w¢/ 5ŀȅΥ мҐ{ǳƴŘŀȅΣ нҐaƻƴŘŀȅΣ Χ тҐ{ŀǘǳǊŘŀȅ Read/Write U16 

_SR_DATE SR14 RTC Date Read/Write U16 

_SR_MONTH SR15 RTC Month Read/Write U16 

_SR_YEAR SR16 RTC Year (only 2 digits) Read/Write U16 

_SR_CLOCK_MODE SR17 Clock Mode: 0=24 Hour, 1=12 Hour Read/Write U16 

_SR_AM/PM SR18 AM/PM (0=AM, 1=PM) Read/Write U16 

_SR_UPDATE_PLC_TIME SR19 
Update Clock:In Ladder Logic ONLY Set to 1 to update internal 
clock with the value in these registers. If setting time from a 
ŎƻƳǇǳǘŜǊ ƻǊ IaLΣ 5hbΩ¢ ǿǊƛǘŜ ǘƻ ǘƘƛǎ ōƛǘΦ 

Read/Write U16 

_SR_MESSAGE_NUMBER SR20 
The message number to be displayed if valid. A message 
number not defined in the message database is not a valid 
message and therefore the default message will be displayed. 

Read/Write U16 

_SR_EIP_SCANNER_IP1 SR21 
This will have the IP address of the EtherNet/IP Scanner which 
is connected to the EZ Rack PLC. 

Read Only U16 

_SR_EIP_SCANNER_IP2 SR22 
This will have the IP address of the EtherNet/IP Scanner which 
is connected to the EZ Rack PLC. 

Read Only U16 

_SR_EIP_SCANNER_IP3 SR23 
This will have the IP address of the EtherNet/IP Scanner which 
is connected to the EZ Rack PLC. 

Read Only U16 

_SR_EIP_SCANNER_IP4 SR24 
This will have the IP address of the EtherNet/IP Scanner which 
is connected to the EZ Rack PLC. 

Read Only U16 

_SR_TIME_ZONE SR29 
This register is used to set the timestamp of messages to 
correspond to GMT (UTC). 

Read/Write S16 

_SR_SPARKPLUG_CURREN
T_BROKER_INDEX 

SR30 
If multiple Brokers are defined this register will indicate which 
broker is connected (0-3) Read Only U16 

_SR_SPARKPLUG_STORE_
FORWARD_FIFO_COUNT 

SR31 
When Store and Forward is enabled this will indicate how 
many tag updates are stored Read Only U16 

_SR_SPARKPLUG_TASK_C
OUNTER 

SR32 
Each time that Sparkplug communication is initiated this 
counter will increment. Read Only U16 
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The PLC reports its errors in two system registers: SR8 and SR9. SR8 uses bits for indicating errors, while 
SR9 uses values to indicate the same errors. When these errors occur, the PLC halts the execution of 
ladder logic, but continues to communicate. So an HMI can be used to detect these errors. When PLC 
halts execution of ladder logic, the outputs are disabled. 

 
Status Reported in SR8 

(PLC stops executing ladder logic if error detected) 

Error Type Bit Set to 1 

Invalid User Program Bit 0 (lsb) 

No Label for Jump Bit 1 

Invalid Move data range Bit 2 

System Error Bit 3 

 
 
 

  

Error Number Reported in SR9 
(PLC stops executing ladder logic if error detected) 

Error Number Description 

0 No Error 

1 Invalid User Program 

2 No Label for Jump 

3 Invalid Move data range 

4 System Error 

5 Either FOR without NEXT, or NEXT 
without FOR 
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3.3 RLL Instructions in EZRack PLC 
This section provides you with detailed information about using the RLL (Relay Ladder Logic) 
instructions in EZRack PLC. These 15 groups (1-8 similar instructions per group) of different 
instructions is adequate to develop some of the most powerful control programs and at the 
ǎŀƳŜ ǘƛƳŜ ƛǘΩǎ ŎƻƴŎƛǎŜ ŜƴƻǳƎƘ ǘƻ ǇǊƻǾƛŘŜ ǘƘŜ ǎƘƻǊǘŜǎǘ ƭŜŀǊƴƛƴƎ ŎǳǊǾŜΦ 
 
Each of the following sections is dedicated to a type of instructions. It is organized in such a way 
that you will find: 

¶ Available Data Types and how to use them 

¶ How to use the instructions 
ω Descriptions of every individual instruction, including a graphical example and 

supported data types 
 
The following table is provided as a quick reference to all RLL instructions available in EZRack 
PLC Designer Pro, as well as a brief description of what each instruction is used for. 

 
 
 
 
 

Instruction Description 

Relay/Boolean Instructions 

NO Contact When the corresponding memory bit is a 1 (on) it will allow power flow through this element. 

NC Contact When the corresponding memory bit is a 0 (off) it will allow power flow through this element. 

Positive Transition 
If the corresponding bit has changed from 0 (off) to 1 (on) in the current scan, power flows through 
this element. 

Negative Transition 
If the corresponding bit has changed from 1 (off) to 0 (on) in the current scan, power flows through 
this element. 

NO Coil As long as the power flows to the instruction, corresponding memory bit is remains 1(on). 

NC Coil As long as the power flows to the instruction, corresponding bit to remains 0 (off). 

Set Coil 
When power flows to the instructions, corresponding bit is set to 1 (on) and remains 1 (on) even if the 
rung condition goes to false (use RESET COIL instruction to turn the corresponding bit Off). 

Reset Coil 
When power flows to the instructions, corresponding bit is set to 0 (off) and remains 0(off) even if the 
rung condition becomes false (use SET COIL instruction to turn the corresponding bit on). 

NO Immediate 
Input 

EZRack PLC reads the addressed bit immediately from the input module (instead of memory). The 
power flows through the instruction if the read bit is 1 (on). (Please note all the bits corresponding to 
the input module are updated with the read value). 

NC Immediate Input 
EZRack PLC reads the addressed bit immediately from the input module (instead of memory). The 
power flows through the instruction if the read bit is 0 (off). (Please note all the bits corresponding to 
the input module are updated with the read value). 

NO Immediate 
Output 

The bit status is immediately written to corresponding output module. The bit remains 1(on) as long as 
the power flows to the instruction. 

NC Immediate 
Output 

The bit status is immediately written to corresponding output module. The bit remains 0(on) as long as 
the power flows to the instruction. 
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Instruction Description 

Compare Instructions 

Equal To Allows power flow through this element if the data value of Input 1 register is Equal to Input 2 register. 

Not Equal To 
Allows power flow through this element if the data value of Input 1 register is NOT Equal to Input 2 
register. 

Greater Than 
Allows power flow through this element if the data value of Input 1 register is Greater Than Input 2 
register. 

Less Than 
Allows power flow through this element if the data value of Input 1 register is Less Than Input 2 
register. 

Greater Than or 
Equal To 

Allows power flow through this element if the data value of Input 1 register is Greater Than or Equal to 
Input 2 register. 

Less Than or Equal 
To 

Allows power flow through this element if the data value of Input 1 register is Less Than or Equal to 
Input 2 register. 

Limit 
Allows power flow through this element if the data value of Input register is within the data values of 
άIƛƎƘ [ƛƳƛǘέ ŀƴŘ ά[ƻǿ [ƛƳƛǘέ ǊŜƎƛǎǘŜǊǎ. 

Compare Values 
Compares 2 Inputs and evaluates whether Input 1 (>, <, =) Input 2. Turns on 1 of 3 discretes based on 
results. 

Math Instructions 

Add Adds two data values in Input 1 and Input 2 registers and stores the result in Result register. 

Subtract 
Subtracts Input 2 register data value from Input 1 register data value and stores the result in Result 
register. 

Multiply Multiplies two data values in Input 1 and Input 2 registers and stores the result in Result register. 

Divide 
Divides Input 1 register data value by Input 2 register data value and stores the result in Result 
register. 

Modulo 
Divides Input 1 register data value by Input 2 register data value and stores only the remainder in 
Result register. 

Absolute Converts a negative data value from Input 1 register to a positive value and stores it in Result register. 

X=Y Conversion 
Copies the data value of Input register, converts it into Result registers data type, and stores the data 
value in Result register. 

Format Conversion 
Converts the data value from Source register in Binary, BCD, or GRAY code to the data value of Result 
register in Binary, BCD or GRAY Code. 

Advanced Math 
Performs an advanced operation on a Input register value and outputs the resulting value into a Result 
register. 

Bit Logic Instructions 

AND 
Performs a bitwise AND operation between the data values of two registers Input 1 and Input 2. The 
result is stored in Result register. 

OR 
Performs a bitwise OR operation between the data values of two registers Input 1 and Input 2. The 
result is stored in Result register. 

XOR 
Performs a bitwise XOR operation between the data values of two registers Input 1 and Input 2. The 
result is stored in Result register. 

NOT 
Performs a bitwise NOT operation on the data value of Source register and stores the result in 
Destination register. 

Shift Left 
Performs a logical Shift Left on the data value of Input 1 register by the data value of Input 2 register 
and stores the result in Result register. 

Shift Right 
Performs a logical Shift Right on the data value of Input 1 register by the data value of Input 2 register 
and stores the result in Result register. 

Rotate Left 
Performs a logical Rotate Left on the data value of Input 1 register by the data value of Input 2 register 
and stores the result in Result register. 

Rotate Right 
Performs a logical Rotate Right on the data value of Input 1 register by the value of Input 2 register and 
stores the result in Result register. 

RLL Instructions Table (Continued) 
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Instruction Description 

Move Instructions 

Move Data Moves data value of Source register to Destination register. 

Bit Move 
Moves either words to bits or bits to words with user-specified length for the number of words to 
move. Maximum of 16 words can be moved at a time. 

Move Block 
Moves a block of memory area. Source register defines the starting area of memory address/register 
to Move from and Destination register defines the starting area of memory address/register to move 
to. The number of elements to move is user defined. 

Block Fill 
Fills a block of memory area. Source register defines the data value to Fill with and Destination register 
defines the starting area of memory address/register to Fill to. The number of elements to move is 
user defined. The number of elements to Fill is user defined. 

Move Table of 
Constants 

Loads a table of user defined constants to a consecutive memory/register locations with the starting 
memory address/register location defined by Destination register. 

Timer/Counter/Drum Instructions 

Timer 
This instruction starts timing when called and once it reaches the preset value as defined by the data 
value of Timer Preset Value register, it will stop timing and will allow power flow through the element. 

Counter 
This instruction starts counting either Up or Down by the increments of one until the counter reaches 
the data value of Counter Preset Value register. The Counter will then allow power flow through the 
element. 

Drum 

Time and/or Event driven drum type sequencer with up to 16 steps and 16 discrete outputs per step. 
The outputs are updated during each step. Counts have a specified time base (1MSec to 1 Sec) and 
every step has its own counter along with an event to trigger the count. After the time expires for one 
step, it transitions to the next step and completes up to 16 steps total. After the completion of all the 
steps this element allows power flow through it. 

Program Control Instructions 

Jump 
Skips the rung containing Jump instruction (after execution of the rung) to a rung with the label 
specified in the JUMP instruction and continues executing the program thereafter. 

For Loop 
Executes the logic between the FOR Loop and NEXT instructions by ǘƘŜ Řŀǘŀ ǾŀƭǳŜ ƻŦ ά[ƻƻǇ /ƻǳƴǘέ 
register. 

Next Statement Specifies the return/end point for the FOR Loop instruction. 

Call Subroutine 
Calls a Subroutine specified by the label in CALL Subroutine instruction and is terminated by the 
RETURN instruction. 

Return Terminates a subroutine and returns back to the main logic. 

String Instructions 

String Move 
Moves the data value (string type) of Source register to Destination register by the number of 
characters specified by the user. 

String Compare 
Allows power flow through this element if the data value (string type) of Source 1 register is Equal to 
Source 2 register by the number of characters specified. 

String Length 
Computes the length of a null-terminated String register (string type) and stores the result in Save 
Length in register. 

String Pack Combines data from 2 or more Numeric and/or String Tags into 1 common Output String Tag. 

String Unpack Extract data from Input String and place into one or more Numeric and/or String Output Tags. 

RLL Instructions Table (Continued) 
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RLL Instructions Table (continued)  

 
 
 
 
 
 
 

Instruction Description 

Communication Instructions 

Open Port Opens the serial port for communication using the parameters specified by the user. 

Send to Serial Port 
Send an ASCII string data from Source register to the serial port with control and character count from 
ǳǎŜǊ ŘŜŦƛƴŜŘ ά/ƻƴǘǊƻƭ !ŘŘǊŜǎǎέ ŀƴŘ ά/ƘŀǊŀŎǘŜǊ /ƻǳƴǘ !ŘŘǊŜǎǎέ ǊŜƎƛǎǘŜǊǎ ǊŜǎǇŜŎǘƛǾŜƭȅ. 

Receive From Serial 
Port 

Receives an ASCII string data from serial port to Source register with control and character count from 
ǳǎŜǊ ŘŜŦƛƴŜŘ ά/ƻƴǘǊƻƭ !ŘŘǊŜǎǎέ ŀƴŘ ά/ƘŀǊŀŎǘŜǊ /ƻǳƴǘ !ŘŘǊŜǎǎέ ǊŜƎƛǎǘŜǊǎ ǊŜǎǇŜŎǘƛǾŜƭȅ. 

Close Port Closes the serial port opened for communication (can be used for downloading projects again). 

Send to Marquee 

Sends ASCII instructions for marquee communication. The message to be displayed on a marquee is 
ǎŜƭŜŎǘŜŘ ōȅ ǘƘŜ Řŀǘŀ ǾŀƭǳŜ ƻŦ άaŜǎǎŀƎŜ bǳƳōŜǊέ ǊŜƎƛǎǘŜǊ ǿƘƛŎƘ ƭƻoks up the message number for a 
corresponding message from the central message database. If message number is not found in the 
message database, user selected action for unmatched messages is done. 

Modbus Master 
Sends Modbus Master Read/Write commands to a configured slave unit. Can be done over Modbus 
RTU or Modbus TCP/IP. Can read or write from any Modbus address up to 100 registers per time. 
EZRack PLC can be used as Modbus slave without needing this instruction. Just need to open port.  

Data Logging Instructions 

Log to Data File 

Allows to log to USB up to 10 tags per instruction. Maximum of 4 instructions are supported. Can log at 
set time interval, log based on event, or log based on event at set time interval. Needs tags for file 
name (can be constant), file size (will be updated based on current conditions), and status (current log 
status). 

Datatype Conversion Instructions 

X=Y Conversion 
Copies the data value of Input register, converts it into Result registers data type, and stores the data 
value in Result register. 

Format Conversion 
Converts the data value from Source register in Binary, BCD, or GRAY code to the data value of Result 
register in Binary, BCD or GRAY Code. 

Process Alarms / Faults Instructions 

Alarm 
Evaluates the current condition of Input Tag. Will set 4 output discrete tags based on value of Input 
tag. Compares Input to a tag based (or constant) setpoints (2 setpoints above and 2 setpoints below 
normal operating range). 

User Defined Faults 
Evaluates conditions based on multiple inputs and generates faults when conditions are true. For 
example if Input 1 Register is equal to Input 2 Register, will set fault number as fault code (Bit 0 of fault 
code = fault 1, etc.) and fault found tags. 

Analog Instructions 

Ramp Generator 
Increments / decrements an Output Tag based on Ramp Rate and Ramp Time tags (can be constant). 
Goes from minimum to maximum output, if exceed or equal extremes will set overflow tag. 

Scale (Linear) 
Scales the Input Tag to Output Tag linearly based on a 2 point reference (each point has input and 
output value). 

Scale (Non-Linear) 
Scales the Input Tag to Output Tag non-linearly using up to 10 reference points. Scale is linear between 
every 2 reference points. 
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RLL Instructions Table (continued)  

 
  

Function Block Instructions 

Alarm 
Evaluates the current condition of Input Tag. Will set 4 output discrete tags based on value of Input 
tag. Compares Input to a tag based (or constant) setpoints (2 setpoints above and 2 setpoints below 
normal operating range). 

Change of Value 
Finds the change of value of 1 Input Tag between 2 points of time. The Output Tag is the change value 
of the Input Tag between T1 and T2. 

Compare Values 
Compares 2 Inputs and evaluates whether Input 1 (>, <, =) Input 2. Turns on 1 of 3 discretes based on 
results. 

Find Min & Max 
Value 

Outputs two tags whose value is the maximum and minimum value the Input Tag has reached since 
last reset. 

Flasher 
Turns a discrete ON/OFF at a settable rate of time. The rate time is based on the Flash Rate tag (can be 
constant). 

Limit 
Allows power flow through this element if the data value of Input register is within the data values of 
άIƛƎƘ [ƛƳƛǘέ ŀƴŘ ά[ƻǿ [ƛƳƛǘέ ǊŜƎƛǎǘŜǊǎ. 

Ramp Generator 
Increments / decrements an Output Tag based on Ramp Rate and Ramp Time tags (can be constant). 
Goes from minimum to maximum output, if exceed or equal extremes will set overflow tag. 

Scale (Linear) 
Scales the Input Tag to Output Tag linearly based on a 2 point reference (each point has input and 
output value). 

Scale (Non-Linear) 
Scales the Input Tag to Output Tag non-linearly using up to 10 reference points. Scale is linear between 
every 2 reference points. 

String Pack Combines data from 2 or more Numeric and/or String Tags into 1 common Output String Tag. 

String Unpack Extract data from Input String and place into one or more Numeric and/or String Output Tags. 

User Defined Faults 
Evaluates conditions based on multiple inputs and generates faults when conditions are true. For 
example if Input 1 Register is equal to Input 2 Register, will set fault number as fault code (Bit 0 of fault 
code = fault 1, etc.) and fault found tags. 

IIoT Instructions (Industrial Internet of Things) 

IIoT (MQTT) Publish 
Allows the EZRack PLC to publish up to 10 tags to the Broker. Need to use the {ŜǘǳǇ Ҕ av¢¢ {ŜǘǳǇΧ 
option before this instruction can be used. Please see Chapter 8 for more information. 
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3.3.1 Available Data Types (Creating and Using)  
These are the available data types which can be used in instructions. This section will define the 
difference between the different data types. Also this section will also show how to define data 
types, set default data type, and how to work with auto generated data types. 
 
 
DATA TYPE vs MEMORY TYPE 
Data Type: The data type of a tag determines how the bits representing those values are stored 
in the PLC's memory. For example for the number 72 here is how they are stored: 
 
 
 
 
 
Memory Type: The memory type of a tag determines the size and location in the PLC where the 
tag is stored. For example discrete S Internals have a size of 1 bit than register R Internals which 
are 16 bits long. Therefore the memory location for them is different. 
 
 
Memory Type Table 

Memory Type Syntax Range Data Types Available 

Discrete 

Discrete Inputs I 1-128 DISCRETE 

Discrete Outputs O 1-128 DISCRETE 

Discrete Internals S 1-1024 DISCRETE 

System Discretes SD 1-16 DISCRETE 

Bit Access Registers* R 1-16384 / 0-15 DISCRETE 

Registers 

Register Inputs IR 1-64 SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32, BCD_INT_16, FLOATING_PT_32, 
ASCII_STRING 

Register Outputs OR 1-64 SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32, BCD_INT_16, FLOATING_PT_32, 
ASCII_STRING 

Register Internals R 1-16384 SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32, BCD_INT_16, FLOATING_PT_32, 
ASCII_STRING 

System Registers SR 1-20 SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32, BCD_INT_16, FLOATING_PT_32, 
ASCII_STRING 

Index Registers XR 1-4 UNSIGNED_INT_16 

Value Registers #R 1-4 UNSIGNED_INT_16 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using R1/0. For all 16,384 registers you can individually access all 16 bits of them. 

  

Data Type Value Representation in Bits 

UNSIGNED_INT_16 72 0000 0000 0100 1000 

ASCII_STRING 72 0011 0111 0011 0010 
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Data Type Table 

Data Type Min Value Max Value 
Number of 

Registers used2 
Memory Types 

where used 

DISCRETE OFF (0) ON (1) 1 I, O, S, SD, R1 

SIGNED_INT_16 -32,768 32,767 1 IR, OR, R, SR, 

SIGNED_INT_32 -2,147,483,648 2,147,483,647 2 IR, OR, R, SR, 

UNSIGNED_INT_16 0 65,535 1 IR, OR, R, SR, 

UNSIGNED_INT_32 0 4,292,967,295 2 IR, OR, R, SR, 

BCD_INT_16 0 9,999 1 IR, OR, R, SR, 

FLOATING_PT_32 -10,000,000,000.0000 10,000,000,000.0000 2 IR, OR, R, SR, 

ASCII_STRING 2 Char 126 Char Variable (1-63) IR, OR, R, SR, 
1 Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using Tag_Name.Bit_0. For more information see section 3.3.2. 
2 If 2 or more registers are used than for example if R1 is the Tag Address then R2 will also be used. If you use R2 in another 
register, results will be unpredictable. 

 
DISCRETE 
The discrete data type is the single bit data type. It is used to indicate an ON (1) or OFF (0) state 
controlling the operations of logic. It is used in instructions like Normally Open Contact, Normal 
Open Coils, and etc. Please see tables for more information. 
 
Note: For bit access discretes you will use the format of Tag_Name.Bit_Number. For example 
with tag Start (R1) to access bit 0 you will type Start.0 (R1/0). You can also add bits within a 
word in the tag database using the Add Bit-In-Register Tag button. 
 
UNSIGNED_INT_16 
The basic single word register data type. The most used register type when negative numbers 
are not needed. Almost all instructions can use this data type. Please see tables for more 
information. 
 
UNSIGNED_INT_32 
The basic double word register data type. Used when you need to store larger values and 
negative numbers are not needed. Almost all instructions can use this data type. Please see 
tables for more information. 
Note: This data type uses two register address for example if R1 is the Tag Address then R2 will 
also be used. If you use R2 in another register, results will be unpredictable. 
 
SIGNED_INT_16 
The basic signed single word register data type. The most used register type when need to have 
negative number. Almost all instructions can use this data type. Please see tables for more 
information. 
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SIGNED_INT_32 
The basic signed double word register data type. Used when you need to store larger values and 
need negative numbers. Almost all instructions can use this data type. Please see tables for 
more information. 
Note: This data type uses two register address for example if R1 is the Tag Address then R2 will 
also be used. If you use R2 in another register, results will be unpredictable. 
 
BCD_INT_16 
This is the binary coded decimal single word data type. Can only be used in specific instructions 
but is great for displaying decimal values and for ease of conversion. Please see tables for more 
information. 
 
FLOATING_PT_32 
This is double word data type used for working with really large or really small numbers. Using 
single-precision you can work with exponentially large numbers or decimal numbers. When 
displaying can be in either decimal notation or scientific notation. Almost all instructions can use 
this data type. Please see tables for more information. 
Note: This data type uses two register address for example if R1 is the Tag Address then R2 will 
also be used. If you use R2 in another register, results will be unpredictable. 
 
ASCII_STRING 
This is the data type that is used with string instructions. This data type stores character 
information as ASCII data. Each register address will store 2 characters and the maximum 
character length is 126. Therefore please note this data type can use from 1 to 63 registers. 
Note: This data type uses two or more register addresses for example if R1 is the Tag Address 
then R2, R3, R4, etc. can also be used. If you use R2 in another register, results will be 
unpredictable. 
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3.3.2 Auto Generated Tags / Auto Fill Tag Address  
The EZRack PLC Designer Pro will automatically fill in the next available address when a new tag 
is created. For I/O tags please configure the PLC with the modules you will be using. This will 
create the needed I/O tags for those modules. Please see below for other Auto Populate tags. 
 
To create a new tag please follow the process below: 
 
Ladder Logic Creation 

1. Add a new instruction to the ladder logic. For example an Add Instruction. 

 
2. Double click on the instruction and enter a tag name for your Input 1. Example Value 1 
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3. Hit enter or right click in the Tag Name area. The Add New Tag Details box will pop up. 
The box will be prepopulated with the next available Memory Address. The starting 
point from which these addresses are taken can be changed in the Address Suggestion 
section. The only change needed is to select the data type. The memory address can be 
changed but it should only be done if needed for instructions like Block Move also you 
might need to this for the Modbus slave Memory map (for more info see Section 7.2.4 
EZRack as Modbus Slave).  
 

a. If creating a Discrete the Tag Details box will not appear since the data type 
need not be modified. 

b. To use Input and Outputs please set select the used I/O modules in the I/O 
Table. For more information please see section 2.5.8 about IO Configuration. 

 

 
4. You can now add an Initial Value if you would like. Next just click OK and the tag will be 

created. 
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Address Suggestion Preference 
The EZRack PLC will suggest addresses based on the select starting point here. Initially it will start 
from Address 1 and suggest the next available address. The user can at any point tell the software 
to start suggesting from a different starting point. For example if starting address is set to 200 
then if 200 is available that will be the next suggested address, if it is not then it will go to 201 and 
so and so forth. 

 
Tag Database Creation 

1. In the tag database click on the Add Tag option. The Add New Tag Details box will 
appear. 

2. Enter the wanted Tag Name and then select the Tag Datatype.  
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3. Based on the tag Datatype you will either use the S Memory Type or the R Memory 
Type. The box will be prepopulated with the next available Memory Address. The 
starting point from which these addresses are taken can be changed in the Address 
Suggestion Preference. The memory address can be changed but it should only be done 
if needed for instructions like Block Move also you might need to this for the Modbus 
slave Memory map (for more info see Section 7.2.4 EZRack as Modbus Slave). 

4. You can now add an Initial Value if you would like. Next just click OK and the tag will be 
created. 

 
Note: The automatically filled in tag address can be modified at any point by the user. This 
means that while the auto fill will check and make sure that the used range does not overlap 
with any other tag, the user can make changes which mean that tags can overlap again. Please 
see example below. 
 
Example of user error: 
1. Project currently uses R2 and R3 for something. 
2. User creates a tag which is SIGNED_INT_32, the auto fill will put this tag at register address R4. 

3. The user can change the address to R1 but at that point this tag will use R1 and R2 -> this will cause overlap with 
the already created tag at R2. 
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Bits within a Word (Bit Access) 
To access the bits with a word you will use the format of Tag_Name.Bit_Number. For example 
with tag Start (R1) to access bit 0 you will type Start.0 (R1/0). You can also add bits within a 
word in the tag database using the Add Bit-In-Register Tag button. 

 
Note: The Register tag needs to exist before you can add bit access to that tag. 
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Auto Populated Tags 
There also exist some tags which will automatically be populated: 
 
I/O Modules tags 
Any IO module added to the project will populate the tag database with corresponding IO tags. 
Please see section 2.5.8 for more information. 
 
System Tags 
All systems tags are now automatically included in the project. For more information on system 
tags please see section 3.2. 
 
PID tags 
PID tags will be automatically created after a new PID Loop is created. You will have the choice 
of changing the memory location of those tags if need be. For more information on PID tags 
please see Chapter 6. 
 
 

Instruction Auto Generated Tags 
Certain instructions will auto generate 
some tags. These tags will have the same 
ƴŀƳŜ ŀǎ ǘƘŜ ōŀǎŜ ǘŀƎ ǳǎŜŘΣ ǿƛǘƘ ŀ άΦέ ŀƴŘ 
some more information afterwards. 
These tags cannot be deleted unless the 
base tag is deleted. The base tag used to 
generate these tags can be either the 
input or the output of the instruction. 
The instructions will inform you about 
the tags that were generated and their 
Tag addresses.  
 
Note: Please be careful that the tag 
address used by these Auto Generated 
tags are not used elsewhere 
unintentionally. This may cause 
unpredictable behavior. 
 

 

For example the Timer Instruction will create tags: TIMER.ACC, TIMER.RST, TIMER.EN, 
TIMER.DN, and TIMER.PRE with the base tag of TIMER. Base tag address is R10 and the rest of 
auto generated tags use R11 and R12.  
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These tags will appear in the tag database but they cannot be edited or deleted unless the base 
tag and its associated object  
 

 
 

Table of Tag Formats 
This table describes all the different possible tag formats that exist. While it may look 
complicated most of these are auto created for you so the user only needs to create the basic 
tags. Note: All tags can have their name modified except for system and reserved tags. 

 
Tag Name Structure Possible Data 

Types 
Description How Created Example 

TAG_NAME Discrete or 
Register 

This is the basic tag the suer 
can create and modify the 
address of. 

User Created. LIGHT, VALUE1 

TAG_NAME.# Discrete (Bit 
within word) 

Bit access to the register. 
Works with Registers only. 

User Created. VALUE1.0 

TAG_NAME.RES# Register Reserved tags for internal 
calculations. 

Auto Created for certain 
function blocks. 

VALUE1.RES1 

M#.INPUT_# Discrete Module # Inputs. User can 
changed name. 

Created during I/O 
Config. 

M1.INPUT_1 

M#.OUTPUT_# Discrete Module # Outputs. User can 
changed name. 

Created during I/O 
Config. 

M3.OUTPUT_7 

M#.INPUT_REG_# Discrete Module # Input Registers. 
User can changed name. 

Created during I/O 
Config. 

M7.INPUT_REG_
3 

M#.OUTPUT_REG_# Discrete Module # Output Registers. 
User can changed name. 

Created during I/O 
Config. 

M5.OUTPUT_RE
G_5 
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M#.TAG_NAME Discrete or 
Register 

Specialty module # tags. 
User can changed name. 

Created during I/O 
Config. 

M4.CNTR1_COU
NTS 

_SD_TAG_NAME Discrete System discrete. Always in project. _SD_FIRST_SCA
N 

_SR_TAG_NAME Register System register. Always in project. _SR_MINUTES 

 

 
 
I/O Address Format for EZRack PLC 
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3.3.3 Relay/Boolean Instructions  
Use discrete instructions to monitor and control the status of bits in the PLC. The bits that can 
be monitored / controlled by using relay instructions are inputs, outputs, internal bits and 
system bits. 
 
Adding Relay/Boolean Instructions 
To configure all of the various Relay/Boolean instructions, perform the following steps: 

1. Click on any Boolean instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click to place the instruction. 
3. To enter the Tag name/address, double click the instruction to open its Dialog box. 
4. Select a proper Tag name/address from the drop down list called Tag Name.  

a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag 

Details dialogue will appear. 
c. Enter the Tag Address in this screen. 
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Normally Open Contact: 
The Normally Open Contact instruction reads/examines an 

input or storage bit at memory location Aaaaa. If the corresponding memory bit is 
ON (1), power will flow through this element. 
 

Normally Closed Contact: 
The Normally Closed Contact instruction reads/examines an 

input or storage bit at memory location Aaaaa. If the corresponding memory bit is 
OFF (0), power will flow through this element. 
 
 
 
 
 
 
 
 

 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using R1/0. See section 3.3.1 for more information. 
 

Allowed Data Formats: Discrete and Bit Access to Registers 
 
 

 
 
 
 

In the example above, when input I1 is ON, output O1 will energize. 
 
 

 
 
In the example above, when input I2 is OFF, output O1 will energize. 
 
 
  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Inputs I 1-128 

Discrete Outputs O 1-128 

Discrete Internals S 1-1024 

System Discretes SD 1-16 

Register Discretes 

Bit Access Registers* R 1-16384 / 0-15 

Aaaaa 

TAG 

Aaaaa 

TAG 



 

109 
 

Positive Contact: 
The Positive Contact instruction reads/examines an input or 

storage bit at memory location Aaaaa. If the addressed bit has transitioned from 
the OFF (0) to the ON (1) state in the current scan, power will flow through this 
element for the rest of that scan.  
 

Negative Contact: 
The Negative Contact instruction reads/examines an input or 

storage bit at memory location Aaaaa. If the addressed bit has transitioned from the 
ON (1) to the OFF (0) state in the current scan, power will flow through this element 
for the rest of that scan. 
 
 
 
 
 
 
 
 

 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using R1/0. See section 3.3.1 for more information.  

Allowed Data Formats: Discrete and Bit Access to Registers (Only the first 64 
registers) 

 

 
In the example above, every time I3 makes an off-to-on transition in current scan, O3 will 
energize for a single scan. 
 
 

 
In the example above, every time I4 makes an on-to-off transition in current scan, O3 will 
energize for a single scan. 
 
Note: The Positive and Negative Contact instructions test whether a bit has changed from 0 to 1 or 1 to 0 during the current scan of 
ladder logic respectively. Therefore, to use these instructions, the logic to change the state of the bit MUST be placed before the logic 
containing this instruction. If the logic for change of state is placed after the instruction, the instruction will never see the transition, 
and therefore will never be true.  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Inputs I 1-128 

Discrete Outputs O 1-128 

Discrete Internals S 1-1024 

System Discretes SD 1-16 

Register Discretes 

Bit Access Registers* R 1-64 / 0-15 

Aaaaa 

TAG 

Aaaaa 

TAG 
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Normally Open Coil: 
As long as power flows to this element, the bit Aaaaa associated 

with the Normally Open Coil instruction remains ON (1). 
 
Normally Closed Coil: 
As long as power flows to this element, the bit Aaaaa associated 

with the Normally Closed Coil instruction remains OFF (0).  
 
 
 
 
 
 
 
 

 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using R1/0. See section 3.3.1 for more information. 

 
Allowed Data Formats: Discrete and Bit Access to Registers 
 
 

 
In the example above, O3 energizes when I3 transitions from 0 to 1. 
 

 
In the example above, O6 will be de-energized as long as I2 is ON. 
 
  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Outputs O 1-128 

Discrete Internals S 1-1024 

Register Discretes 

Bit Access Registers* R 1-16384 / 0-15 

Aaaaa 

TAG 

Aaaaa 

TAG 
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Set Coil: 
When power flows to this element, the Set Coil instruction 

sets/turns ON (1) the specified output or storage bit at memory location Aaaaa. 
Once the specified output or storage memory bit is turned ON (1), it will remain ON (1) even if 
the rung conditions change later to stop power flow to the element. The only way to change the 
status of the specified storage ƻǊ ƳŜƳƻǊȅ ōƛǘ ǎŜǘ ōȅ Ψ{Ŝǘ /ƻƛƭΩ is to ǳǎŜ ǘƘŜ ΨwŜǎŜǘ /ƻƛƭΩ 
instruction. 

 
Reset Coil: 
When power flows to this element, the Reset Coil instruction 

resets/turns OFF (0) the specified output or storage bit at memory location Aaaaa. 
Once the specified output or storage memory bit is turned OFF (0), it will remain OFF (0) even if 
the rung conditions change later to stop power flow to the element. The only way to change the 
status of the specified storage or memory bit ǊŜǎŜǘ ōȅ ΨwŜǎŜǘ /ƻƛƭΩ ƛǎ ǘƻ ǳǎŜ ǘƘŜ Ψ{Ŝǘ /ƻƛƭΩ 
instruction to set/turn ON (1). 
 
 
 
 
 
 
 

*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 
example for R1 you can access bit 1 using R1/0. See section 3.3.1 for more information. 

 
Allowed Data Formats: Discrete and Bit Access to Registers 
 

 
In the example above, bit 07 is Set when I1 is ON. Bit 07 will remain Set even after I1 becomes 
FALSE. 
 

 
In the example above, if I2 is ON, S1 will be Reset (turned OFF). 
 
  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Outputs O 1-128 

Discrete Internals S 1-1024 

Register Discretes 

Bit Access Registers* R 1-16384 / 0-15 

Aaaaa 

TAG 

Aaaaa 

TAG 
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Normally Open Immediate Input: 
The Normally Open Immediate Input instruction 

reads/examines the status of the specified Input point at location Aaaaa directly 
from the EZLGX IO module at the time of execution and NOT from the memory bit present in the 
Image Table. If the corresponding input state is ON (1), power will flow through this element. All 
the available inputs on corresponding module are read only. The Image Table is also updated 
with the read input memory locations. 

 
Normally Closed Immediate Input: 
The Normally Closed Immediate Input instruction 

reads/examines the status of the specified Input point at location Aaaaa directly from 
the EZLGX IO module at the time of execution and NOT from the input memory bit present in 
the I/O scan image. If the corresponding input state is OFF (0), power will flow through this 
element. When Aaaaa corresponds to an EZLGX IO input module, all the available inputs on the 
corresponding module are read only. The Image Table is also updated with the read input 
memory locations. 
 
 
 
 

Allowed Data Formats: Discrete Only 
 

 
In the example above, when instruction --|i| -- is executed, the input module addressed I8 is 
read, and then the rung is solved. All inputs (I1- I8) on that module are read and the memory is 
updated. 

 
In the example above, when instruction ---|i| --- is executed, the input module addressed I8 is 
read, and then the rung is solved. All inputs (I1- I8) on that module are read and the memory is 
updated. 
 
A Normal PLC scan consists of reading inputs (and saving the input status in memory or input image table), solving ladder logic, and writing outputs 
(from memory or output image table). During a logic scan, if a reference to an input comes up, the value stored in memory is used for that input. 
Similarly, if logic needs to energize an output, a corresponding memory bit is set, which is later written to the physical output during the I/O scan phase. 
 
The immediate input instructions allow you to read a corresponding input bit at the time of instruction execution, and use the most current bit status 
(instead of the status stored in memory during input read) in logic solving. Immediate input instructions update all the bits corresponding to an input 
module, even if only one of the bits is used in an Immediate input instruction. For example, if I1 is used for immediate input, which is on an 8 input card, 
bits I1 - I8 would be updated immediately.  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Inputs I 1-128 

Aaaaa 

TAG 

Aaaaa 

TAG 
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Normally Open Immediate Output: 
When power flows to this element, the Normally Open 

Immediate Output instruction sets/turns ON (1) the specified output point at 
memory location Aaaaa directly on the EZLGX IO module and the output memory bit in the 
Image Table at the time of execution. 
 

Normally Closed Immediate Output: 
When power flows to this element, the Normally Open 

Immediate Output instruction resets/turns OFF (0) the specified output point at 
memory location Aaaaa directly on the EZLGX IO module and the output memory bit in the 
Image Table at the time of execution. 
 
 
 
 
 

Allowed Data Formats: Discrete Only 
 

 
In the example above, if the power flows to the output instruction, O8 will be energized and 
immediately written to the physical output corresponding to O8. 
 

 
In the example above, if the power flows to the output instruction, O8 will be de-energized and 
immediately written to the physical output corresponding to O8. 
 
A Normal PLC scan consists of reading inputs (and saving the input status in memory or input image table), solving ladder logic, and 
writing outputs (from memory or output image table). During logic scan, if a reference to an input comes up, the value stored in 
memory is used for that input. Similarly, if logic needs to energize an output, a corresponding memory bit is set, which is later written 
to physical output during the I/O scan phase. 
 
The immediate Output instructions allow you to write to the corresponding physical output at the time of instruction execution, 
instead of waiting for the I/O scan to write the output. Only the output referred to by the instruction is updated. 

 
  

Memory Type Syntax (A) Range (aaaa) 

Discrete 

Discrete Outputs O 1-128 

Aaaaa 

TAG 

Aaaaa 

TAG 
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3.3.4 Compare Instructions  
Compare instructions allow you to compare values using a specific comparison instruction. 
When using compare instructions you must compare values of the same data and display type. 
The parameters you enter are program constants or logical addresses of the values you want to 
compare. 
 
Compare instructions perform comparisons of two addresses Input 1 and Input 2 defined by the 
data box selected. When the processor finds the expression is true, the power flows through 
these instructions. 
 
Adding Compare Instructions 
To add Compare Instructions, perform the following steps: 

1. Click on any Compare instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. To enter Data/Display types, double click the instruction to open its Dialog box. 

 
4. Select a proper Tag name/address from the 
drop down list for Input 1. Or add a new tag. 
5. Select a proper Tag name/address from the 
drop down list for Input 2. Or add a new tag. 
6. Choose the correct data format from the last 
drop down list on the dialog box. 
7. Data types for both Input 1 and 2 must be the 
same. 
 
 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag 

Details dialogue will appear. 
c. Enter the Tag Address in this screen. 

Note:  
1) Data of five different types SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32 or FLOAT 32 is allowed.  
2) Word Data Types default to decimal display type.  
3) UNSIGNED Data Types also allow Hex and Octal displays.  
4) Display Type allows you to select how the number will be displayed in the program. There are 
three display options  



 

115 
 

Equal To: 
The Equal To instruction can be used to 

compare two Inputs, Input 1 at memory location Aaaaa and Input 
2 at memory location Bbbbb. If Input 1 = Input 2 then power will 
flow through this element. Either Inputs can be assigned a 
constant value. Values can be displayed in Decimal, Hex, or Octal 
format. Both Input 1 and Input 2 must be of the same data type.  
 

 
Not Equal To: 
The Not Equal To instruction can be used to 

compare two Inputs, Input 1 at memory location Aaaaa and Input 
2 at memory location Bbbbb. If LƴǇǳǘ м ґ LƴǇǳǘ н ǘƘŜƴ ǇƻǿŜǊ ǿƛƭƭ 
flow through this element. Either Input can be assigned a 
constant value. Values can be displayed in Decimal, Hex, or Octal 
format. Both Input 1 and Input 2 must be of the same data type. 
 
 
 
 
 
 
 
 

Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, if R1 equals R2, power will flow out of EQ and O1 will be energized. 
 

 
In the example above, if R1 does not equal R2, power will flow out of NEQ and O1 will be 
energized.

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Greater Than: 
The Greater Than instruction can be used to 

compare two Inputs, Input 1 at memory location Aaaaa and 
Input 2 at memory location Bbbbb. If Input 1 > Input 2 then 
power will flow through this element. Either Input can be 
assigned a constant value. Values can be displayed in Decimal, 
Hex, or Octal format. Both Input 1 and Input 2 must be of the 
same data type.  

 
Less Than: 
The Less Than instruction can be used to 

compare two Inputs, Input 1 at memory location Aaaaa and Input 
2 at memory location Bbbbb. If Input 1 < Input 2 then power will 
flow through this element. Either Input can be assigned a 
constant value. Values can be displayed in Decimal, Hex, or Octal 
format. Both Input 1 and Input 2 must be of the same data type.  
 
 
 
 
 
 
 
 

Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, if R1 is Greater Than R2, power will flow out and O1 will be energized. 
 

 
In the example above, if R1 is Less Than R2, power will flow and O1 will be energized. 

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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 Greater Than Or Equal To: 
The Greater Than Or Equal To instruction 

can be used to compare two Inputs, Input 1 at memory 
location Aaaaa and Input 2 at memory location Bbbbb. If Input 
1 is Greater Than Or Equal To Input 2 then power will flow 
through this element. Either Input can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal 
format. Both Input 1 and Input 2 must be of the same data type.  
 

 Less Than Or Equal To: 
The Less Than Or Equal To instruction 

can be used to compare two Inputs, Input 1 at memory 
location Aaaaa and Input 2 at memory location Bbbbb. If Input 
1 is Less Than Or Equal To Input 2 then power will flow 
through this element. Either Input can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal 
format. Both Input 1 and Input 2 must be of the same data type.  
 
 
 
 
 
 
 

Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, if R1 is Greater Than or Equal To R2, power will flow out and O1 will be 
energized. 
 

 
In the example above, if R1 is Less or Equal To R2, power will flow out and O1 will be energized.

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Limit: 
The Limit instruction can be used to 

compare register data values of the Input at memory location 
Aaaaa with Low at memory location Bbbbb and High at 
memory location Ccccc. LŦ !ŀŀŀ Җ /ŎŎŎŎ ŀƴŘ !ŀŀŀŀ җ .ōōōō 
then power will flow through this element. Any of the 
registers (Input, High or Low) can be assigned a constant value. Values can be displayed in 
Decimal, Hex, or Octal format. All the registers must be of the same data type. 
 
Note: This is the same instruction that can also be found in the Function Instruction section. It is 
also located here for convenience sake. 
 
 
 
 
 
 
 
 

Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
 
In the example above, if the input R1 is within R2 and R3, power will flow out and O9 will be 
energized. 
 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Compare Values: 
The Compare Values instruction can be 

used to compare two Inputs, Input 1 at memory location Aaaaa 
and Input 2 at memory location Bbbbb. Based on the Input 1 
and Input 2 comparison the corresponding discrete tag (Ccccc, 
Ddddd, or Eeeee) will turn on. This instruction examines 
whether Input 1 and Input 2 are greater than, equal, or less than.  Either Input can be assigned a 
constant value. Values can be displayed in Decimal, Hex, or Octal format. All the registers must 
be of the same data type. Power constantly flow through this element. 
 
Note: This is the same instruction that can also be found in the Function Instruction section. It is 
also located here for convenience sake. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Allowed Data Formats: Discrete, all register data type except BCD and ASCII. 
 

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Memory Type Syntax (C,D, E) Range (cccc) Range(dddd) Range(eeee) 

Discrete 

Discrete Outputs O 1-128 1-128 1-128 

Discrete Internals S 1-1024 1-1024 1-1024 

Register Discretes 

Bit Access Registers* R 1-16384 / 0-15 1-16384 / 0-15 1-16384 / 0-15 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for example for R1 you can 
access bit 1 using R1/0. See section 3.3.1 for more information. 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

TAG 1 (Aaaaa) 

TAG 2 (Bbbbb) 

TAG 3 (Ccccc) 

TAG 4 (Ddddd) 

TAG 5 (Eeeee) 
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In this example: 
 

¶ If R1 > R2 then S1 will be ON and O12 will be energized. 

¶ If R1 = R2 then S2 will be ON and O11 will be energized. 

¶ If R1 < R2 then S3 will be ON and O10 will be energized. 
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3.3.5 Math Instructions  
The instructions listed within this chapter perform arithmetical operations on user specified 
values or addresses. All Math Instructions are always TRUE (that is, power flows through them). 
 
Adding Math Instructions 
To configure all of the various Math instructions, perform the following steps: 

1. Click on any Math instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. To enter Data/Display types, double click the instruction to open its Dialog box. 

 
4. Select a Tag name/address from the 
drop down list for Input 1. Or add a new tag. 
 
5. Select a Tag name/address from the 
drop down list for Input 2. Or add a new tag. 
 
6. Select a Tag name/address from the 
drop down list for Result. Or add a new tag. 
 
7. For Absolute, X=Y Conversion, and 
Binary Conversion instructions, select 
Source and Destination Tag 
names/addresses. 
 

8. Choose the correct data format from the last drop down list on dialog box. 
9. Data types for all Input 1, Input 2 and Result must be the same (Source and Destination 

for Absolute and Conversion instructions). 
 
 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag 

Details dialogue will appear. 
c. Enter the Tag Address in this screen. 
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Add: 
When power flows to this element, the Add 

instruction adds the register data values of two Inputs, 
Input 1 at memory location Aaaaa and Input 2 at memory 
location Bbbbb. The added value is stored in Result at 
memory location Ccccc. Input 2 can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal format. Both the Inputs and Result must 
be of the same data type.  
 

Subtract: 
When power flows to this element, the 

Subtract instruction subtracts the register data value of 
Input 2 at memory location Bbbbb from Input 1 at memory 
location Aaaaa. The subtracted value is stored in Result at 
memory location Ccccc. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. Both the 
Inputs and Result must be of the same data type. 

 
Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, R1 will be added to R2 and the result will be placed in R3. 
 

 
In the example above, R2 will be subtracted from R1 and the result will be placed in R3. 
 

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Multiply:  
When power flows to this element, 

the Multiply instruction multiplies the register data 
values of two Inputs, Input 1 at memory location Aaaaa 
and Input 2 at memory location Bbbbb. The multiplied 
value is stored in Result at memory location Ccccc. Input 
2 can be assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. 
Both the Inputs and Result must be of the same data type. 
 

Divide: 
When power flows to this element, 

the Divide instruction divides the register data value of 
Input 1 at memory location Aaaaa by Input 2 at memory 
location Bbbbb. The divided value is stored in Result at 
memory location Ccccc. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in 
Decimal, Hex, or Octal format. Both the Inputs and Result must be of the same data type. Power 
will stop flowing through this element if division by zero is attempted.  

 
Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, R1 will be multiplied by R2 and the product will be placed in R3. 
 

 
In the example above, R1 will be divided by R2 and the result will be placed in R3.

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Modulo: 
When power flows to this element, the 

Modulo instruction divides the register data value of Input 
1 at memory location Aaaaa by Input 2 at memory location 
Bbbbb. The Remainder Value is stored in Result at memory 
location Ccccc. Input 1 and Input 2 can be assigned a 
constant value. Values can be displayed in Decimal, Hex, or Octal format. Both the Inputs and 
Remainder must be of the same data type. Power will stop flowing through this element if 
division by zero is attempted. 
 
 

 
Allowed Data Formats: SIGNED and UNSIGNED data types only. 
 

 
In the example above, R1 is divided by R2 and only the remainder is placed in R3. 
 
  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Absolute: 
When power flows to this element, the 

Absolute instruction converts the signed (negative) register data 
value of Src at memory location Aaaaa to the absolute (positive 
only) data value and stores it in Dest at memory location Bbbbb. 
Both Source and Destination must be of the same data type. 
 
 
 
 
 
 
 

Allowed Data Formats: SIGNED and FLOATING_PT data types only. 
 
 

 
In the example above, R11 will contain the Absolute value of R10 (for example, if R10 was -10, 
R11 will contain +10). 
 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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X=Y Conversion: 
When power flows to this element, the 

X=Y Conversion instruction converts the register data type of Src 
at memory location Aaaaa to Res at memory location Bbbbb and 
copies the converted data value to Res at memory location Bbbbb. 
If Src has a Floating Point data type it can either be rounded off to 
the nearest integer value or truncated when converting to other data types. When the integer 
or floating point data value is converted to an ASCII type data value, the number of digits, 
decimal position and justification (leading zeros, leading spaces, or trailing spaces) can be 
assigned as per user. 
 
Note: This is the same instruction that can also be found in the Datatype Conversion Instruction 
section. It is also located here for convenience sake. 
 
 
 
 
 
 
 

Allowed Data Formats: all register data types. 
 
Note: If converting a signed 16 bit (with a negative value -1) to an unsigned 16 bit register the 
result will always be zero. 
 
 

 
In the example above, variable A, (R500) which is an UNSIGNED_32 (U32) Type, will be 
converted to an UNSIGNED_16 Type (U16) and saved in B. 
 
 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Format Conversion: 
When power flows to this element, the 

Format Conversion instruction converts the data format of From at 
memory location Aaaaa to To at memory location Bbbbb as 
follows: 
 
ω Binary to BCD  
ω BCD to Binary 
ω Binary to Gray Code  
ω Gray Code to Binary 

 
Both the From and To data types must be a 16 bit Signed Integer, 16 bit Unsigned Integer, or 16 
bit BCD for Format Conversion instruction. 
 
Note: This is the same instruction that can also be found in the Datatype Conversion Instruction 
section. It is also located here for convenience sake. 
 
 
 
 
 
 
 

Allowed Data Formats: SIGNED_INT_16, UNSIGNED_INT_16, BCD_INT_16 
 
 

 
In the example above, R1 which is in Binary format, is converted to Gray Code and saved in R2. 
 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Advanced Math: 
When power flows to this element, 

the Advanced Math instruction performs a selected 
operation on the register data values of Input at memory 
location Aaaaa. The resulting value is stored in Result at 
memory location Bbbbb. Input can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal format. The Input can be any data type 
but the Result must be of type Floating Point. Please see more information below and on next 
page. 
 
 
 
 
 
 
 

Allowed Data Formats: Input can be all register data types except BCD and ASCII. Result 
must be FLOATING_PT_32. 

 
Advance Math function  allows you to perform following mathematical operations in 

ladder logic:  

¶ Square Root  

¶ Log (base 10)  

¶ Exponent (e^ Input )  

¶ Natural Log (ln, base e)  

¶ Sin  

¶ Cosine  

¶ Tan  

¶ Inverse Sin  

¶ Inverse Cosine  

¶ Inverse Tan  

¶ Convert to Radians  

¶ Convert to Degrees  

 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Adding Advanced Math Instruction 

1. Click on the Advanced Math instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. To enter Data/Display types, double click the instruction to open its Dialog box. 
4. Select the Operation you would like to perform from the dropdown menu. For more 

information on operations see descriptions below. 
5. Select a proper Tag name/address from the drop down list for Input. Or add a new tag. 

You can also instead put in a constant. 
6. Select a proper Tag name/address from the drop down list for Result. Or add a new tag. 

Note: Result tag needs to FLOATING_PT. 

 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen. 

 

 

There are several operations under Advance Math Instructions you could use in your PLC 
program. 
 
1. Square Root & Exponent (e^ Input)  
Click on to the drop down button to select Square root 
Operation to see how this works. For example if the Input 
Tag R1 has the value 25 stored, the Result Tag R2 would 
have the output to be 5 in this case since square root of 25 is 
5. This Justifies Result = Input. 
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Similarly, if you want to Obtain the Exponential of a 
constant Value, then you would need to have the input 
Value stored in the Input Tag R1 and the Exponential of 
the Input Value applied would be stored in the Result Tag 
R2.  

 
2. Trigonometric Functions: 
Note: All Trigonometric functions require radians as the inputs (not degrees); (Convert to Radian 
function is available to convert degrees to radians) 
 

For Trigonometric functions, click on to the drop down button to 
select either SIN, COS or TAN Function (sine, cosine, tangent). 

 
Here the Input Tag R1 would 
have the Value stored in 
Radians and the Output of 
the Sine operation is Stored 
in the Result Tag R2. 
 

Input Tag Type could be either an Address such as R1 or a constant 
Value. 
 

Input Tag Type doesn't necessarily need to be of floating point type but the Result Tag must be 
of floating point Type. 
 
Similarly, you could apply the same steps for Cosine & Tangential functions. 
 
3. Inverse Trigonometric Functions: 
Note: Inverse Trigonometric functions return radians in the result tag (not degrees) (Convert to 
degrees function is available to convert radians to degrees) 
 
With the Advanced Math Functions, you would be able to calculate the Inverse Sin, Cosine or 
Tangent of a Value. Shown below is an example of Inverse-SIN to show how the inverse sine 
operation works. 

 
Input Value in Radians for which the Inverse-SIN operation is to 
be done is stored in the Input Tag R1 and the result of the sine 
inverse operation is stored in the Result Tag R2. 
 

Similarly, you would be able to calculate the cosine inverse and Tangential Inverse. 
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4. Logarithmic Function         

Click on to the drop-down button to select Log(Base 10). Here you 
could  find the Logarithmic function of any value. If the Input Tag R1 
has the Value 2, then the Result -> Log (2)= 0.414 is Stored in the 
Result Tag R2. 
 
 
Similarly, you could obtain the Natural Logarithm (Inverse function of 
the exponential function) of any value by following the same steps 
with the result getting stored in the Result Tag. 
 
 

 
5. Convert to Radians and Convert to Degrees: 
Here is the formula to convert degrees to radians 
 

═▪▌■▄ ░▪ ►╪▀░╪▪▼  ═▪▌■▄ ░▪ ▀▄▌►▄▄▼ z ╟░ Ⱦ  
 

 
 
Input Tag R1 would have the Value in Degrees stored 
and the Output in Radians would be stored in the Result 
Tag R2. 
 

 
 
The Formula to Convert Radians to Degrees is 
 

═▪▌■▄ ░▪ ▀▄▌►▄▄▼  ═▪▌■▄ ░▪ ►╪▀░╪▪▼ z  Ⱦ ╟░ 
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3.3.6 Bit Logic Instructions  
Bitwise Instructions operate on 16-bit or 32-bit SIGNED and UNSIGNED data types. Operations 
are performed on the bit patterns of two registers. After the operation, the results are stored in 
a third register (Res). Neither input is changed. 
 
Adding Bit Logic Instructions 
To configure all of the various Bitwise instructions, perform the following steps: 

1. Click on any Bitwise instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. To enter Data/Display types, double click the instruction to open its Dialog box. 

 
4. Select a proper Tag name/address from the drop down list for Input 1. Or add a new tag. 
5. Select a proper Tag name/address from the drop down list for Input 2. Or add a new tag. 
6. Select a proper Tag name/address from the drop down list for Result. Or add a new tag. 
7. Choose the correct data format from the last drop down list on dialog box. 
8. Data types for all Input 1, Input 2 and Result must be the same. 

 
 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen. 
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AND: 
When power flows through this element, 

the AND instruction performs a bitwise AND operation on 
data values of Input 1 at memory location Aaaaa and Input 
2 at memory location Bbbbb and stores the output in Res at 
memory location Ccccc. Input 1 and Input 2 can be assigned a constant value. Values can be 
displayed in Decimal, Hex, or Octal format. The Inputs and Res must be of the same data type. 
 

OR: 
When power flows through this element, 

the OR instruction performs a bitwise OR operation on data 
values of two registers Input 1 at memory location Aaaaa 
and Input 2 at memory location Bbbbb and stores the 
output in Res at memory location Ccccc. Input 1 and Input 2 can be assigned a constant value. 
Values can be displayed in Decimal, Hex, or Octal format. The Inputs and Res must be of the 
same data type. 

 
Allowed Data Formats: SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32. 
 

STATUS =  0001 0011 0101 0111 
MASK =  0000 1111 0000 0000 
STATUS After AND: 

 0000 0011 0000 0000 
 

In the example above, Status in R300 is ANDed with MASK in R305 and the result is stored in 
Status. 
 

STATUS =  0001 0011 0101 0111 
MASK =  0000 1111 0000 0000 
STATUS After OR: 

  0001 1111 0101 0111 
 

In the example above, Status in R300 is ORed with MASK in R305 and the result is stored in 
Status  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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XOR: 
When power flows through this 

element, the XOR instruction performs a bitwise XOR 
operation on data values of two registers, Input 1 at 
memory location Aaaaa and Input 2 at memory location 
Bbbbb and stores the output in Res at memory location 
Ccccc. Input 1 and Input 2 can be assigned a constant value. Values can be displayed in Decimal, 
Hex, or Octal format. The Inputs and Result must be of the same data type.  
 

NOT:  
When power flows through this element, the 

NOT instruction performs a bitwise NOT operation on data 
value of Src at memory location Aaaaa and stores the output in 
Dest at memory location Bcccc. Src can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal format. Both Source and Destination 
must be of the same data type. 

Allowed Data Formats: SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32. 

 
STATUS = 0001 0011 0101 0111 
MASK = 0000 1111 0000 0000 
MASK After XOR: 

 0001 0000 0101 0111 
 
 

In the example above, Status in R300 is XORed with MASK in R305 and the result is stored in 
Status. 

 
MASK = 0000 1111 0000 0000 
MASK After NOT: 

 1111 0000 1111 1111 
 
 

In the example above, the MASK is inverted and saved back in MASK  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Shift Left: 
When power flows through this 

element, the Shift Left instruction performs a Logical 
Shift Left on Input 1 at memory location Aaaaa by the 
value of Input 2 at memory location Bbbbb and stores 
the result in Res at memory location Ccccc. No bits are 
shifted into the right and any bits shifted from the left are lost. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. The Inputs 
and Res must be of the same data type. 
 

Shift Right:  
When power flows through this 

element, the Shift Right instruction performs a Logical 
Shift Right on Input 1 at memory location Aaaaa by the 
value of Input 2 at memory location Bbbbb and stores 
the result in Res at memory location Ccccc. No bits are 
shifted in from the left and any bits shifted from the right are lost. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. The Inputs 
and Result must be of the same data type. 

Allowed Data Formats: SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32. 
 

R1 =    1100 0000 0000 0101 
Shift Left by = 4 
R3 after shift =  0000 0000 0101 0000 
 
 

In the example above, the value of Level is shifted Left by 4. All bits are shifted left by 4 (MS bits 
are lost). 

R1 =    1100 0000 0000 0101 
Shift Right by = 4 
R3 after shift =  0000 1100 0000 0000 
 
In the example above, the value of Level is Shifted Right by 4. 

All bits are shifted right by 4 (LS bits are lost).  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Rotate Left: 
When power flows through this 

element, the Rotate Left instruction performs a logical 
Rotate Left on Input 1 at memory location Aaaaa by the 
value of Input 2 at memory location Bbbbb and stores the 
result in Res at memory location Ccccc. Bits are rotated 
into the right and any bits shifted from the left are rotated in. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. The Inputs 
and Result must be of the same data type. 
 

Rotate Right: 
When power flows through this 

element, the Rotate Right instruction performs a logical 
Rotate Right on Input 1 at memory location Aaaaa by the 
value of Input 2 at memory location Bbbbb and stores the 
result in Res at memory location Ccccc. Bits are rotated 
into the left and any bits shifted from the right are rotated in. Input 1 and Input 2 can be 
assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. The Inputs 
and Result must be of the same data type. 

Allowed Data Formats: SIGNED_INT_16, SIGNED_INT_32, UNSIGNED_INT_16, 
UNSIGNED_INT_32. 

 
MASK1 =   1100 0000 0000 0101 
Rotate Right by = 4 
MASK2 after shift =  0000 0000 0101 1100 
 

In the example above, MASK1 is rotated right by 4 and saved in MASK2. 
 
MASK1 =   1100 0000 0000 0101 
Rotate Right by = 4 
MASK2 after shift =  0101 1100 0000 0000 
 
In the example above, MASK1 is rotated left by 4 and saved in 

MASK2. 

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers  

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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3.3.7 Move Instructions  
Move Instructions allow the movement of data between registers. Move based instructions can 
also be used to move constant values into registers, move blocks of data from one location to 
another, or to fill a block of registers with the same value. 
 
Power Flow 
Move instructions are always true so power flow always passes through the rung. The exception 
to this is the Indirect Move Element. In this case, the move is considered invalid and power flow 
is false if either the source or destination register contains 0 (zero) or the length of the move 
exceeds the number of elements available in the controller. 
 
Adding Move Instructions 
To configure all of the various Move Instructions, perform the following steps: 

1. Click on a Move instruction icon on the right side of the screen. 
2. Position the mouse over the area on the Ladder diagram where you want to insert the 

instruction and click the mouse to place the instruction. 
3. To enter Data/Display types, double click the instruction to open its Dialog box. 

 
4. For a Bit Move instruction, choose if you want to move register bits to discrete or vice 

versa. 
5. Enter a Tag Name in the Data Type field or use the drop arrow to make your selection. 
6. Select a proper Tag name/address from the drop down list for Source. Or add a new tag. 
7. Select a proper Tag name/address from the drop down list for Destination. Or add a new 

tag. 
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8. Enter the number of elements to move/fill (only for the Move Block and Block Fill 
instructions). 

 
9. Enter the numeric constants in the Table of Constants and select a proper Tag 

name/address for the Destination from the drop down list (only for the Move table of 
Constants instruction). 

 

10. Choose the correct data format from the last drop down list on dialog box. 
11. Data types for both source and destination must be the same. 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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Move Data: 

When power flows through this element, the 
Move Data instruction moves data value from Src at memory 
location Aaaaa to Dest at memory location Bbbbb. Src can be 
assigned a constant value. Values can be displayed in Decimal, 
Hex, or Octal format. Both Src and Dest must be of the same data type. 

 
Move Block: 
When power flows through this element, the 

Move Block instruction moves a block of memory area. Src at 
memory location Aaaaa provides the starting address of the 
memory area to move from and Dest at memory location Bbbbb 
provides the starting address of the memory area to move to. The 
number of elements to move is user specified. The maximum number of elements that can be 
moved with one Move Block instruction is 128 for 16 Bit registers and 64 for 32 Bit registers. Src 
can be assigned a constant value. Values can be displayed in Decimal, Hex, or Octal format. Both 
Src and Dest must be of the same data type. 
 

 
Allowed Data Formats: all register data type except BCD and ASCII 

 
In the example above, R2 = R1 after the move. 

 
This instruction is used to copy multiple elements. In this example, 10 registers starting from 
R10 (R10-19), are copied to R50-49.

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Block Fill: 
When power flows through this element, 

the Block Fill instruction fills a block of memory area. Src at 
memory location Aaaaa provides the data value to fill with; 
whereas Dest at memory location Bbbbb provides the starting 
address of memory area to fill to. The number of elements to fill 
is user specified. The maximum number of elements that can be filled with one Block Fill 
instruction is 128 for 16 Bit registers and 64 for 32 Bit registers. Src can be assigned a constant 
value. Values can be displayed in Decimal, Hex, or Octal format. Both Source and Destination 
must be of the same data type. 

 
Move Table of Constants: 
When power flows through this 

element, the Move Table of Constants instruction loads user 
specified table of constants to consecutive memory addresses 
with the starting memory address defined by Dest at memory 
location Aaaaa. Src is the user specified table of constants. 
The maximum number of constants that can be moved are 128 for 16bit registers and 64 for 
32bit registers. N displays the number of Dest addresses occupied by the user specified table of 
constants. Source and Destination must be of the same data type.  
 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

TAG 1 

 

Aaaaa 
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REAL numbers less than zero must contain 
a leading zero (e.g., .999 is not valid, 0.999 
is valid). It is possible to copy and paste 
data to/from other Windows applications 
including Microsoft Excel and Word. 
Constants are placed one on each 
individual line. 
 
 
 
 
 

 

 
Allowed Data Formats: all register data type except BCD and ASCII. 
 

 
In the example above, Value of R1 is copied to 10 registers starting with register R3 (the number 
of elements in instruction is specified as 10). 
 

 
In the example above, a table of constant is copied to registers starting with R2. Number of 
elements are shown as N (4 in this case). 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 
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 Move Bit: 
When power flows through this element, the Move Bit instruction can either 

copy bits from a maximum of 16 contiguous discrete bits to a single 16-bit word register or a 
single 16-bit word register to a maximum of 16 contiguous discrete bits. The two available 
modes are available as follows: 
 
ω aŀǇ wŜƎƛǎǘŜǊ .ƛǘǎ ǘƻ 5ƛǎŎǊŜǘŜǎ 

When using the Move Bit instruction to map register 
bits to discretes, Src at memory location Aaaaa provides 
the address of the register from which the bits are to be 
moved. The Number of Bits selected by you defines the 
total number of consecutive bits which are to be moved starting from the Src address 
location. Dest at memory location Bbbbb provides the address of the register where bits 
from Src are being moved to. The user selectable Start Bit Number specifies the bit 
location in Dest register where onwards the bits are to be moved in. 

 
ω aŀǇ 5ƛǎŎǊŜǘŜǎ ǘƻ wŜƎƛǎǘŜǊǎ 

When using the Move Bit instruction to map discretes 
to registers, Src at memory location Aaaaa provides the 
address of the register where bits are to be moved 
from. The user selectable Start Bit Number specifies the 
starting point in the register where onwards the bits are 
to be moved and the Number of Bits specify the total number of bits to be moved. Dest 
at memory location Bbbbb provides the starting address for consecutive bits which are 
being moved into from Src register. 
 

 
 
 
 
 
 
 

  
 
 
 
 

Allowed Data Formats: SIGNED_INT_16, UNSIGNED_INT_16, BCD_INT_16, Discrete 
 
 

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Discrete 

Discrete Inputs I 1-128 1-128 

Discrete Outputs O 1-128 1-128 

Discrete Internals S 1-1024 1-1024 

System Discretes SD 1-16 1-16 

Bit Access Registers* R 1-16384 / 0-15 1-16384 / 0-15 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 
*Bit level access to registers is possible. You will be accessing bits of certain register (only 16 bit registers are allowed) for 

example for R1 you can access bit 1 using R1/0. See section 3.3.1 for more information. 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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In the example above, all 16 bits (N=16) of R1 are copied to Scratch Bits S100 to S115. The Least 
significant bit of R1 is moved to S100, and the most significant to S115. Value moved of register 
R1 is 255. 

Discrete 
Internals (S) 

115 114 113 112 111 110 109 108 107 106 105 104 103 102 101 100 

Value 0 0 0 0 0 0 0 0 1 1 1 1 1 1 1 1 

 
 
 

 
In the example above, 4 bits (N=4) starting from O1 are copied to Status Tag (R300). 

R300 Bits 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

Value of             O4 O3 O2 O1 
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3.3.8 Timer/Counter/Drum Instructions  
 
Timer, Counter and Drum instructions allow you to control operations based on time or number 
of events. 
 
Adding Timer Instruction 
To configure the Timer instruction, perform the following steps: 

1. Click the Timer instruction icon side of the screen. 
2. Position the mouse over the area on the Ladder diagram where you want to insert the 

Timer instruction and click the mouse to place it. 
3. To configure Timer types, double click the Timer instruction to open its dialog box. 

 
4. Check the box for desired Timer 
Action, Delayed ON, Delayed OFF 
or Delayed ON-Retentive Counts. 
 
5. Select one of the Time Base 
options. 
 
6. Select a proper Tag 
name/address from the drop down 
list for the Timer tag. Or add a new 
tag.  
 
7. The Timer instruction will auto 
generate Timer Tags which can be 
used for timer control. Note: It will 
use 2 register address right after 
the Timer address (even if they are 
used elsewhere). 

 
8. Check the Constant Preset Value if you would like to have it constant. 

 
 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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Timer Instruction: 
When power flows to this element, the 

Timer instruction starts timing. Once it reaches the Preset 
Value as defined by the Timer Preset register, it will stop 
timing and either allow power flow or stop power flow 
based on the type of Timer instruction used. When using a Retentive timer, you must use a 
Reset bit to reset the timer. When using a Non-Retentive timer then the timer will reset each 
time power flow is stopped. 

 
Timer Register and Timer Status Register: 
TIMER at memory location Aaaaa defines 
the timer register. The TIMER.ACC is also at 
location Aaaaa. The Timer instruction will 
automatically create tags at memory 
locations Bbbbb and Ccccc where Bbbbb = 
A(aaaa+1) and Ccccc = A(aaaa+2). The 
TIMER.EN at Bbbbb/14 is the timer enable 
bit which will be on when the timer is 
timing. Also the TIMER.DN at Bbbbb/15 is 
the timer done bit which will be on when 
the timer is done. 
 
Timer Preset Value (TIMER.PRE): 
Preset at memory location Ccccc defines the 
timer preset value, it is also automatically 
created as soon as TIMER is defined at 

location Aaaaa. Preset can also be assigned a constant value. The Timer preset value allows the 
Timer instruction to count to a certain value based on the Time Base Selected. 
 
Timer Reset (TIMER.RST) 
The timer reset bit at memory location Bbbbb/13 defines the reset input bit for the Retentive 
Timer ONLY. As soon as the TIMER.RST turns ON the TIMER.ACC will become zero till the 
TIMER.RST is turned OFF. Note: For other types of timers the reset bit exists but does not do 
anything. The other types of timers are automatically reset when they are not timing. 
 
Time Base: 
The Time Base is user selectable and allows one of the following time bases: 
ω м aƛƭƭƛǎŜŎƻƴŘ 
ω мл aƛƭƭƛǎŜŎƻƴŘ 
ω млл aƛƭƭƛǎŜŎƻƴŘ 
ω м {ŜŎƻƴŘ 

Aaaaa 

Bbbbb/13 

Bbbbb/14 

Bbbbb/15 

Ccccc 

Ccccc 
TAG 1.PRE 

Aaaaa 
TAG 1 
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e.g. If Preset = 15 and Time Base = 10 Millisecond, then the Timer instruction will time for 150 
Milliseconds. Similarly, if Pre =11 and Time Base = 100 Millisecond, then the Timer instruction 
will time for 1100 Milliseconds. 
 

Types of Timer: 
There are three types of Timers available as specified by you: 
Delayed ON, Delayed OFF, and Delayed ON-Retentive Counts. 
 
Delayed ON: When power flows to this type of Timer it starts 
timing until it reaches the Timer Preset Value. Once it 

completes the specified count, it allows power flow through this element. If power flow to this 
Timer stops before it reaches the Timer Preset value, it resets itself to zero and starts timing 
from 0 when power flows to this instruction again. 
 
Delayed ON Timing Diagram 
Shows Timer with Delayed ON that counts to 3 when power flows to Timer Instruction. 

 
 
Delayed OFF: This type of Timer allows power flow though it as long as power flows to this 
element. When power flow STOPS to this type of timer, it still allows power flow through it and 
starts counting at the same time. When the Timer reaches the Timer Preset Value, it STOPS the 
power flow through it. If power flows back to this Timer before it reaches the Timer Preset 
value, it resets itself and starts timing from 0 again anytime power flow stops to it. 
 
Delayed OFF Timing Diagram 
Shows Timer with Delayed OFF that counts to 3 when power flows to Timer Instruction stops. 

 



 

147 
 
Delayed ON ς Retentive Counts: When power flows to this type of timer it starts timing until it 
reaches the Timer Preset Value. Once it completes the specified count, it allows power flow 
through this element. If power flow to this timer stops before it reaches the count, it retains the 
count and starts from the point where it had stopped timing. Once it reaches the Timer Preset 
Value it will allow power flow through it. This remains true unless the Reset Input Bit is toggled, 
at which point it resets itself and starts timing whenever power flows to it. 
 
Delayed ON ς Retentive Counts Timing Diagram 
Shows Timer with Delayed ON τ Retentive Counts that counts (retentively) to 5 when power 
flows to Timer Instruction. 

 
 
 

Data formats supported: UNSIGNED_INT_16 
 

 
In the ŜȄŀƳǇƭŜ ŀōƻǾŜΣ ǘƘŜ ǘƛƳŜǊ ƛǎ ŀƴ hb ǘƛƳŜǊΣ ǿƛǘƘ лΦллмΩǎ ǘime base. The preset value is R3, 
and accumulated value in R1. If R1=1000, then once timer is enabled (S1 is ON), it will timer for 
1000x0.001=1s then power will flow out of it energizing the fan.  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Discrete  

Bit Access Registers* R  (aaaa + 1) / 13-15  

Registers 

Registers Internals R 1-16384  (aaaa + 2) 
*Bit level access to registers is possible. Timer instruction will auto generate these discrete bit access registers and they can be used to 
control/monitor the Timer in the rest of your ladder logic. 
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Counter Instruction:  
When called, the Counter instruction 

will count up or down by increments of one until the 
counter reaches the data value of the Preset Value 
register. The counter will then allow power flow through 
the rung. 
 
Adding Counter Instruction 
To configure the Counter instruction, perform the following steps: 

1. Click the Counter instruction icon side of the screen. 
2. Position the mouse over the area on the Ladder diagram where you want to insert the 

Counter instruction and click the mouse to place it. 
 
3. To enter Preset/Counter types, double 
click the Counter instruction to open its 
dialogue box. 
 
4. Check the box for desired Counter 
Action (Up or Down). 
 
5. Select a proper Tag name/address from 
the drop down list for the Counter tag. Or 
add a new tag. 
 
6. The Counter instruction will auto 
generate Counter Tags which can be used 
for counter control. Note: It will use 2 
register address right after the Counter 
address (even if they are used elsewhere). 

 
7. Check the Constant Preset Value if you would like to have it constant. 
 

 
 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen. 

Counter: 

Ccccc 
TAG 1.PRE 

Aaaaa 
TAG 1 

Bbbbb/13 
TAG 1.RST 
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When the power flow to this element is switched from OFF (0) to ON (1), this instruction keeps 
track of the number of times power flow switches. Once it reaches its specified preset, it allows 
power flow through it. 

 
Counter Register and Counter Status 
Register: COUNTER at memory location 
Aaaaa defines the Counter register value. 
The COUNT.ACC is also at location Aaaaa. 
The Counter instruction will automatically 
create tags at memory locations Bbbbb and 
Ccccc where Bbbbb = A(aaaa+1) and Ccccc = 
A(aaaaa+2). The COUNTER.EN at Bbbbb/14 
is the counter enable bit which will be ON 
when the counter is counting (COUNT.ACC 
not equal to COUNT.PRE). Also the 
COUNT.DN at Bbbbb/15 is the counter done 
bit which will be on when the counter is 
done (COUNT.ACC equal to COUNT.PRE). 
Note: If counter is using 32 bit register then 
memory addresses used are Bbbbb = 
A(aaaa+2) and Ccccc = A(aaaa+4). 

 
Counter Preset Value (COUNT.PRE): 
Counter preset at memory location Ccccc defines the Counter Preset Value, it is also 
automatically created as soon as COUNT is defined at location Aaaaa. This is the value that the 
counter will increment to or decrement from. Counter preset can occupy a 16 or 32 bit register 
and can also be assigned a constant value.  
 
Reset Input Bit (COUNT.RST): 
Reset at memory location Bbbbb/13 defines the Reset Input Bit for the Counter instruction. 
When this bit is enabled, the Counter instruction is reset to its default value based on the type 
of Counter instruction being used. There are two types of counters, Up Counter and Down 
Counter, which are user selectable as follows: 
 
Up Counter: When the Reset Input Bit is disabled (0) and the power flow to the counter 
instruction switches from 0 to 1, the count register increments one count. When the Counter 
Preset Value and Counter register value become equal, power flows through it. Whenever the 
reset input is enabled the Counter register value is set to 0 and the power flow through it is 
stopped. 
 
Up Counter Counting Diagram 

Aaaaa 

Bbbbb/13 

Bbbbb/14 

Bbbbb/15 

Ccccc 
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Counts up to the preset of 3. Reset will reset value to 0. Once preset reached output is ON and 
counter will no longer increment. 

 
Down Counter: When the Reset Input Bit is disabled (0) and the power flow to the counter 
instruction switches from 0 to 1, the count register decrements one count. When the Counter 
Preset Value and Counter register value become equal, power flows through it. Whenever the 
Reset input is enabled the Counter register value is set to Counter Preset Value and the power 
flow through it stops. 
 
Down Counter Counting Diagram 
Counts down from preset of 3. Reset will reset value to 3. Once zero reached output is ON and 
counter will no longer increment. 

 

Allowed Data Formats: UNSIGNED INT 16, UNSIGNED INT 32 
 
In this example, the counter is a 
16 bit UP counter [U16]. Once the 
count value = Preset value, the 
power flows out of the 
instruction.

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Discrete  

Bit Access Registers* R  (aaaa + 1) / 13-15  

Registers 

Registers Internals R 1-16384  (aaaa + 2) 
*Bit level access to registers is possible. Counter instruction will auto generate these discrete bit access registers and they can be used to 

control/monitor the Counter in the rest of your ladder logic. 



 

151 
 
Drum Instruction 
 
Introduction to Drum Sequencing 
Conventionally, electro-mechanical drums are used in control of processes where a certain 
number of steps is repeated over time. Such drums are a popular control technique because 
they save a lot of logic programming. Drum sequencing instruction in EZRack PLC mimics the 
electro-mechanical drums. There are 2 types of Drums, 1) Timed and 2) Timed with Event. 
 
ω Each row on a drum chart represents a step on the drum. When rung power condition is 

true the drum resets to a particular reset step defined by the user. 
ω Each column in a drum chart represents an output from the drum. We can have 16 

discrete outputs numbered from 1 to 16. The outputs are updated during each step. 
ω The Drum advances from one step to the next per the timer or after triggered by an 

external event. A Jog tag can also be used to control the drum movement. 
ω Checked boxes on the drum chart mark ON states of outputs on a particular step. Empty 

boxes represent OFF outputs. 
ω Each Drum sequences up to 16 steps having 16 discrete outputs per step. 
ω Counts have a specified time base and every step has its own counter along with an 

event to trigger the count. 
ω When power flows through this element, the Drum instruction starts its sequence while 

EZRack PLC continues with the logic after this instruction.  

Adding the Drum Instruction: 

Outputs 

Steps 

Count of how long 
at each step 

OFF Output Bit ON Output Bit 
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To configure the Drum instruction, perform the following steps: 

1. Click on the Drum icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. Double click the instruction to open its dialog box. 
4. Click on the Outputs tab on the top to define your Output bits. Add or select tags for 

total outputs used (Min: 1 and Max: 16) 
5. Return to the main dialog box by clicking onto the Instruction Details tab. 

 
6. Select the Drum type (timed or timed with event). 
7. Select the Preset Step (default preset step is 1). 
8. Choose the Time base (1 ms, 10 ms, 100 ms or 1s). 
9. Select or Add Reset, Current Step, Current Count and Jog tags. 
10. Define counters for each step. 
11. Check the ON-Off states of outputs in each step. 

 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen. 



 

153 
 

Drum 
When power flows through this element, 

the Drum instruction starts a sequence of outputs which 
can be either Timed or Timed with Event. The maximum 
number of steps that can be defined in a sequence is 16 
with the maximum number of outputs per step being 16 as 
well. 
 
Drum Type: 
There are two types of user selectable Drum types: 

ω ¢ƛƳŜŘ hƴƭȅ 
When you select this option, the Drum instruction completes its sequence based on 
time specified by Count with specified Time Base only. When the Count is completed, it 
enables (1) or disables (0) the specified outputs as selected by the user through 
checkboxes. 

 
ω ¢ƛƳŜŘ ǿƛǘƘ 9ǾŜƴǘ 
When you select this option, the Drum instruction completes its sequence based on the 
time specified by Count with specified Time Base and Events. When this selection is 
chosen, a tab for Events is available for you to select the desired addresses for events 
for every step. 

 
Step #: 
If using the Timed Only Drum instruction, the total number of programmable steps is 16. When 
using the Timed with Event Drum instruction then the total number of programmable steps is 
limited to 10. 
 
Counts: 
Every Step has a Count associated with it. The Count is a user specified constant which controls 
the duration of time before a certain step is executed. The Count can have a different time base 
as specified by the user in Time Base. 
 
Time Base: 
Time Base allows the Count variable to be mapped to different Time Bases as follows: 
ω м ƳƛƭƭƛǎŜŎƻƴd 
ω мл ƳƛƭƭƛǎŜŎƻƴŘ 
ω млл ƳƛƭƭƛǎŜŎƻƴŘ 
ω м ǎŜŎƻƴŘ 
If the Time Base is set to 1 millisecond, then a Count value of 10 would correspond to 10 
milliseconds. Similarly, if the Time Base is set to 10 milliseconds, then a Count value of 10 would 
correspond to 100 milliseconds and so on. 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 

TAG 3 

Ddddd 

TAG 4 
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Preset Step: 
This user selected value is used in conjunction with the Reset Tag. If the Reset Tag is enabled (1) 
then the drum sequence jumps to the step specified by the Preset Step. 
 
Reset Tag: 
Rst address at memory location Aaaaa is used to reset the drum sequence to a user selected 
Step location every time the Rst bit transitions from disable (0) to enable (1). When Rst is 
enabled, the Drum Sequence is immediately shifted to the Preset Step regardless of its current 
position and Count value. 
 
Jog Tag: 
Jog address at memory location Bbbbb is used to jog the Drum Sequence to the next step. If 
present on Step 16, it will be jogged to step 1. When Jog is enabled, the Drum Sequence is 
immediately shifted to the next step regardless of its current position and Count value. 
 
Current Step Tag: 
Stp address at memory location Ccccc is used by the Drum instruction to write the current value 
of Step where Drum Sequence exists at any given time during its operation. 
 
Current Count Tag: 
Cnt address at memory location Ddddd is used by the Drum instruction to write the current 
value of Count where the Drum Sequence exists at any given time during its operation. 
 
Outputs: 
The total number of Outputs that can be used per Step is 16 which is reduced to 10 when using 
the Timed with Event type Drum instruction. Every Output utilized in any step must have a 
Discrete memory location assigned to it. Memory locations are assigned in the second tab when 
adding a Drum instruction. During Drum instruction operation, if the checkbox corresponding to 
a certain Output is checked, it will be enabled, otherwise it is disabled. 
 
Events: 
This is an optional tab which only appears if the Timed with Event type Drum instruction is used. 
For every Step utilized in the Time and Event type Drum instruction, there must be a 
corresponding Event address assigned to a discrete bit. During Drum Sequence, after the time 
corresponding to a certain Step is elapsed, the instruction looks at the corresponding Event 
address. If enabled, Drum Sequence will advance to the next step; otherwise it will start the 
Count again for the same Step. Once the Count is elapsed it will look again at the Event address 
ǘƻ ǎŜŜ ƛŦ ƛǘΩǎ ŜƴŀōƭŜŘΦ LŦ enabled, it will move forward to the next Step, otherwise it will repeat 
until the corresponding Event address is enabled. 
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Allowed Data Formats: DISCRETES and UNSIGNED_INT_16 
 
 

In this example, once the Drum is enabled 
(S1 is ON), it will activate outputs like S3 
following the set pattern. The outputs are 
used to control process like here it turns 
on a Motor (O1). 

 

 

  

Memory Type Syntax (A, B) Range (aaaa) Range(bbbb)1 

Discrete 

Discrete Inputs I 1-128 1-128 

Discrete Outputs O 1-128 1-128 

Discrete Internals S 1-1024 1-1024 

System Discretes SD 1-16 1-16 

Register Discretes 

Bit Access Registers* R 1-16384 / 0-15 1-64 / 0-15 
1Jog tag behaves like positive and negative edge triggers and therefore is restricted to first 64 registers when used with 

bits within word registers 

Memory Type Syntax (C, D) Range (cccc) Range (dddd) 

Registers 

Input Registers IR 1-64 1-64 

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 
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3.3.9 Program Control Instructions  
Use the Program Control instructions to alter the sequence of Main Logic Program scan. 
 
Adding Program Control Instructions 
To configure Program Control instructions, perform the following steps: 

1. Click the instruction icon on the right side of the screen. 
 

2. Position the mouse over the Ladder Logic and click the mouse to place the instruction. 
 

3. Double click the Jump, For Loop, and Call Subroutine instruction to open the 
ƛƴǎǘǊǳŎǘƛƻƴΩǎ ŘƛŀƭƻƎ ōƻȄΦ Next and Return do not have dialog boxes. 

 
 

A) Jump Instruction 
Select a proper Rung label from the drop 
down list. Labels need to be added before 
using this instruction. Please see section 
2.5.5 for more information on adding 
labels to rungs. 
 

 
 
 
 
 

B) For Loop Instruction 
Select a proper Tag name/address from 
the drop down list for the Loop Count or 
enter a number in the Constant Value 
field. 

 
 
 
 
 
 
C) Call Subroutine Instruction 
Select a Subroutine from the drop down 
list. 
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Jump: 
When power flows to this element, the Jump 

instruction skips from the rung where 
used to a rung with the Label specified in the Jump instruction 
and continues executing the program thereafter. Before the 
Jump instruction skips to the specified label instruction, the rung 
containing the Jump instruction is executed first. The Jump 
instruction can only be used to skip forward in the direction of 
the ladder logic flow. When a new rung is created, you can add 
άƭŀōŜƭέ ŀƴŘ άŎƻƳƳŜƴǘǎέ Ŧor every rung added by right clicking on 
the Rung sidebar. Only rungs which are labeled can be utilized by 
the Jump instruction. The Select Label pull down menu only 
shows rungs which have been labeled by the user.  
 
 
 
 

 
For Loop: 
When power flows to this element, the For 

Loop instruction loops/repeats the ladder logic (RLL) between 
itself and the Next instruction for the number of times specified 
by the data value of the Loop Count at memory location Aaaaa. 
When the For Loop instruction is done executing the RLL between 
itself and the Next instruction by the number specified by the Loop Count, it allows execution of 
ladder logic after the Next instruction. The Loop Count can also be assigned a constant value. 
 
 
 
 
 
 

Allowed Data Formats: UNSIGNED_INT_16 
 

Next Statement: 
When power flows to this element, the Next Statement 

instruction specifies the end point of the For Loop instruction and shifts power flow back to the 
point where the For Loop instruction is located. Once For Loop execution is completed for the 
number of times specified by the Loop Count, power will flow through this element. 
 

Memory Type Syntax (A) Range (aaaa) 

Registers 

Input Registers IR 1-64 

Output Registers OR 1-64 

Registers Internals R 1-16384 

Aaaaa 
TAG 1 
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Call Subroutine:  
When power flows to this element, 

the Call Subroutine instruction invokes a subroutine as 
specified by SUB. You can either specify an existing 
Subroutine, or create a new one. When a subroutine is 
added in SUB which already does not exist, it is automatically added under Subroutine Logic. 
Once a subroutine is used, it must contain a Return instruction to return back to the main logic. 
 
Note: Subroutines are very useful for organizing the main body of ladder logic. They can be 
utilized to break the body of ladder logic into sections which are either specific to a certain 
operation or are repeated in the main logic. If certain logic is to be repeated several times, it is 
useful to place that logic in a subroutine and call that subroutine by using the Call Subroutine 
instruction instead. By utilizing subroutines efficiently, the number of rungs in ladder logic could 
be reduced drastically. 
 

Return Statement:  
When power flows to this element, the Return Statement 

instruction specifies the end of the Subroutine logic where present and returns back to the Main 
logic. The Return statement can only be used in a Subroutine. Any logic after the return 
statement is not executed so if you want to save no longer need logic you can do so in 
subroutines. 

 
In this example, any instructions between For and Next will 
be executed multiple times. The number of times the 
instructions will be executed is equal to the value of the 
ά[ƻƻǇ /ƻǳƴǘέ ǾŀǊƛŀōƭŜΦ 
 
 
 
 
 
 

 
When power flows to this instruction, subroutine 
ƴŀƳŜŘ ά{ǳōǊƻǳǘƛƴŜέ ǿƻǳƭŘ ōŜ ŎŀƭƭŜŘ 

 
 
In this example, when power flows to this instruction, the execution 
ƧǳƳǇǎ ǘƻ άwǳƴƎ омέΦ 
 

.
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3.3.10 String Instructions   
 
A string is succession of characters. EZRack PLCΩǎ ǎǘǊƛƴƎ ƛƴstructions operate on ASCII String Data 
files only. Please see Section 3.3.1 for more information on ASCII String Data type. 
 
Adding String Instructions 

1. To configure String instructions, click on the String instruction icon on the right side of 
the screen.  
 

2. Position the mouse over the Ladder diagram and click the mouse to place the 
instruction.  
 

3. To enter Tag Name/Address, double click the instruction to open its dialog box. 
 

4. To configure the String Move and String Compare instructions, perform the following 
steps: 

a. Select a Tag name/address from the drop down list for the Source register 
(Source1 for String Comparison Instruction). Or add a new tag. 

b. Enter a value in the Number of Characters field. 
c. Select a Tag name/address from the drop down list for the Destination register 

(Source 2 for String Comparison Instruction). Or add a new tag. 
 

5. Adding String Length Instruction 
a. {ŜƭŜŎǘ ŀ ¢ŀƎ ƴŀƳŜκŀŘŘǊŜǎǎ ŦǊƻƳ ǘƘŜ ŘǊƻǇ Řƻǿƴ ƭƛǎǘ ŦƻǊ ǘƘŜ Ψ{ǘǊƛƴƎΩ ǊŜƎƛǎǘŜǊΦ Or 

add a new tag. Needs to be ASCII String tag. 
b. Select a Tag ƴŀƳŜκŀŘŘǊŜǎǎ ŦǊƻƳ ǘƘŜ ŘǊƻǇ Řƻǿƴ ƭƛǎǘ ŦƻǊ ǘƘŜ Ψ{ŀǾŜ ƛƴΩ ǊŜƎƛǎǘŜǊΦ Or 

add a new tag. 
 

6. For adding String Pack and Unpack please see individual sections for those instructions. 
 
 
 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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String Move: 
When power flows through this element, 

the String Move instruction moves an ASCII string with a starting 
address of Src at memory location Aaaaa to Dest at memory 
location Bbbbb by the number of characters defined by the user. 
This instruction can move up to 126 characters with every two characters occupying one ASCII 
register. 
 
For example, if the number of characters to move is 2, this instruction will move the single Src 
register at memory location Aaaaa to Dest at memory location Bbbbb. If the number of 
characters to move is 4, then this instruction will move TWO consecutive registers with a 
starting address of Src to TWO consecutive registers with starting address of Dest. Similarly, 6 
characters would move THREE consecutive registers, 8 characters would move FOUR 
consecutive registers and so on. 
 
 
 
 

Data Format: ASCII only 
 
 

 
 
In the example abƻǾŜΣ ǘƘŜ άƴǳƳōŜǊ ƻŦ ŎƘŀǊŀŎǘŜǊǎέ defined in the dialog box are moved starting 
from R100 to the destination starting from R300. If a null is found in the source string before all 
the άƴǳƳōŜǊ ƻŦ ŎƘŀǊŀŎǘŜǊǎέ ŀǊŜ ƳƻǾŜŘΣ ǘƘŜ ǊŜǎǘ ƻŦ ǘƘŜ characters are padded with null in the 
destination. 
 
  

Memory Type Syntax (A) Range (aaaa) 

Registers 

Registers Internals R 1-16384 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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String Compare: 
The String Compare instruction is used to 

compare an ASCII String with a starting address of Src1 at memory 
location Aaaaa and Src2 at memory location Bbbbb by the number 
of characters specified by the user. If Src1 = Src2 power will flow 
through this element. This instruction can compare up to 126 characters with every two 
characters occupying one ASCII register. 
 
For example, if the number of characters to compare is 2, this instruction will compare the 
single Src1 register at memory location Aaaaa to Src2 at the memory location Bbbbb. If the 
number of characters to compare is 4, then this instruction will compare TWO consecutive 
registers with a starting address of Src to TWO consecutive registers with a starting address of 
Src2. Similarly, 6 characters would compare THREE consecutive registers, 8 characters would 
compare FOUR consecutive registers and so on. 
 
 
 
 

Data Format: ASCII only 
 

 
In the example above, the string starting from R100 is compared with the string at R299. The 
strings are compared up to the άƴǳƳōŜǊ ƻŦ ŎƘŀǊŀŎǘŜǊǎέΣ ƻǊ мнс, or up to a null character in 
either of the sources, whichever occurs first. 
 
 
 
  

Memory Type Syntax (A) Range (aaaa) 

Registers 

Registers Internals R 1-16384 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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String Length: 
When power flows through this element, 

the String Length instruction counts the number of characters in 
a null-terminated ASCII string specified by the starting address of 
Str at memory location Aaaaa. The result is stored in Len at 
memory location Bbbbb. 
 
 
 
 
 

Allowed Data Formats: UNSIGNED_INT_16, UNSIGNED_INT_32, and ASCII_STRING. 
 

 
In the example above, when power flows to the instruction, the length of the string starting at 
R100 is computed. The computation stops when a null character is found. The length value is 
saved in R5. 
 
 
  

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64  

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

Aaaaa Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Adding the Pack Instruction: 
To configure the Pack instruction, perform the following steps: 

1. Click on the Pack icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. Double click the instruction to open its dialog box. 
4. Select or Add Output Tag. Note: The total length of Output has to be equal or greater 

than the total combined lengths of the inputs to be packed. 

 
5. Add up to 16 Inputs you would like to combine in order of combination by clicking Add 

Input. (Input 1 will be first in the output, Input 2 is second, etc.) 
6. In the dialog Select or Add Input. 

a. For ASCII String Inputs specify the Input length. 
 
b. For other Register types specify both the length, the 
number of digits, Fill type and the decimal position. 

 
 

 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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String Pack: 
When power flows through this element, 

the String Pack takes any register type and combines them into 
an ASCII string. The resulting ASCII string is stored at memory 
location Aaaaa. The instruction takes up to 16 different inputs 
from multiple different memory locations. Any input can also be a constant. 
 
Note: This is the same instruction that can also be found in the Function Instruction section. It is 
also located here for convenience sake. 
 
For each input the string length to pack needs to be specified. If an input has a floating point 
data type it can either be rounded off to the nearest integer value or truncated. When an input 
of integer or floating point data value is converted, the number of digits, decimal position and 
justification (leading zeros, leading spaces, or trailing spaces) must be assigned. Power will stop 
flowing through this element if an error occurs such as overflow, underflow, or divide by zero. 
 
The String Pack instruction will only combine the inputted length specified for each input 
ŜƭŜƳŜƴǘ ŜǾŜƴ ƛŦ ǘƘŜ ƛƴǇǳǘΩǎ ǎƛȊŜ ƛǎ ƎǊŜŀǘŜǊ ŜΦƎΦ ƛŦ length specified is 10 but ASCII string is 12 long 
will only pack the first 10 characters of the ASCII String. 
 
Note: For signed registers and registers with decimals please note that the length to pack needs to be one greater 
than the number of digits due to the need for a +/- sign and or decimal point. If number has both then the length to 
pack needs to be 2 greater than the number of digits.  
 
Note: For Floating point registers be mindful of the scientific notation. Based on the numeric value of the register the 
number can be displayed in decimal notation (##.##) or scientific notation (#.##e+##). For scientific notation the length 
to pack needs to be four greater than the number of digits.  

 
 
 

Allowed Data Formats: all register data types. 
 
 
 

Memory Type Syntax (A, Inputs) Range (aaaa) Inputs 

Registers 

Output Registers OR  1-64 

Registers Internals R 1-16384 1-16384 

Aaaaa 
TAG 1 

N 
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In this example, string R100, register R20, 
and string R120 are packed together into 
R300 when power flows. For this example it 
would ŎǊŜŀǘŜ ǎǘǊƛƴƎ ά/ǳǊǊŜƴǘ ¢ŜƳǇŜǊŀǘǳǊŜ ƛǎ 
нлϲ/έΦ ²ƛǘƘ ǎǘǊƛƴƎ wмлл ōŜƛƴƎ но /ƘŀǊ ƭƻƴƎ 
όά/ǳǊǊŜƴǘ ¢ŜƳǇŜǊŀǘǳǊŜ ƛǎ άύΦ ¢ƘŜ ǊŜƎƛǎǘŜǊ 
R20 would be the temperature with length 2 
ŀƴŘ bǳƳōŜǊ ƻŦ ŘƛƎƛǘǎ н ŀǎ ǿŜƭƭ όάнлέύΦ Cƛƴŀƭƭȅ 
ǎǘǊƛƴƎ wмнл ǿƻǳƭŘ ōŜ н ŎƘŀǊ ƭƻƴƎ όάϲ/έύΦ 
 
 
 

In this example, string R100, and register 
R20 are packed together into R300 when 
power flows. For this example it would 
ŎǊŜŀǘŜ ǎǘǊƛƴƎ ά/ǳǊǊŜƴǘ ŎŀƭŎǳƭŀǘŜŘ ǾŀƭǳŜ ƛǎ 
нΦпрŜҌлоέΦ ²ƛǘƘ ǎǘǊƛƴƎ wмлл ōŜƛƴƎ ну /ƘŀǊ 
ƭƻƴƎ όά/ǳǊǊŜƴǘ ŎŀƭŎǳƭŀǘŜŘ ǾŀƭǳŜ ƛǎ άύΦ ¢ƘŜ 
register R20 would be the value with length 
у όάнΦпрŜҌлоέύΣ bǳƳōŜǊ ƻŦ ŘƛƎƛǘǎ о όάнΦпрέύΣ 
ŀƴŘ 5ŜŎƛƳŀƭ tƻǎƛǘƛƻƴ ƛǎ н όάΦпрέύΦ   
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Adding the Unpack Instruction: 
To configure the Unpack instruction, perform the following steps: 

1. Click on the Unpack icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. Double click the instruction to open its dialog box. 
4. Select or Add Input Tag. Note: Input Length has to be equal or greater than the total 

combined length of the outputs. 

 
5. Using the Add Output button add up to 16 Outputs you would like to unpack the input 

into. These outputs can be of any type and only the length needs to be specified. 
6. In the Add Output dialog select or add an output tag. Then specify the length to be 

outputted to the tag. 

Adding tags: 
a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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String Unpack: 
When power flows through this element, 

the String Unpack takes an ASCII String and splits it into different 
registers of any type. The Input ASCII string is stored at memory 
location Aaaaa. The instruction outputs to up to 16 different 
outputs from multiple different memory locations. For each output the string length to unpack 
needs to be specified. Power will stop flowing through this element if an error occurs such as 
overflow, underflow, or divide by zero. 
 
Note: This is the same instruction that can also be found in the Function Instruction section. It is also 
located here for convenience sake. 

 
The instruction will split the ASCII string starting from the beginning into the different registers 
per the specified length. Therefore if the length of the Input String is shorter than the total 
length of the outputs, only the outputs up to the Input String length will be split into. 
 
Note: An ASCII register takes 2 char per register address, e.g. for 10 char need R1-R5. Only the first address needs to be 
specified, the others are automatically used.  
 
Note: An ASCII character cannot be split into a non-ASCII register. Therefore if such is attempted the output register 
will be set to 0, e.g. if try to input AB into UNSIGNED_INT_16 this will result in the register being 0.  
 
Note: For Floating point registers be mindful of the scientific notation. Floating point values can be displayed in 
decimal notation (##.##) or scientific notation (#.##e+##). For scientific notation the length to unpack needs to be four 
greater than the number of digits.  

 
 

Allowed Data Formats: all register data types. 
 
Examples of how it will unpack different length strings: 
 
Example 1: 
Input: ABCDEF 
If splitting into Output 1 (Length 10) and Output 2 (Length 10). 
Then only Output 1 will be used since Input length < Output 1 length.  
Output 1: ABDCEF____ 
Output 2: __________ 
Example 2: 
Input: ABCDEFGHIJK 
If splitting into Output 1 (Length 10) and Output 2 (Length 10). 

Memory Type Syntax (A, Outputs) Range (aaaa) Outputs 

Registers 

Output Registers OR  1-64 

Registers Internals R 1-16384 1-16384 

Aaaaa 
TAG 1 

N 
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Then both Output 1 and Output 2 will be used but since Input length < (Output 1 + Output 2) 
length, then only some of Output 2 will be used. 
Output 1: ABDCEFGHIJ 
Output 2: K_________ 
 

In this example, R300 is unpacked into string 
R100, register R20, and string R120 when 
power flows. For this example it would take 
ŀǇŀǊǘ ǎǘǊƛƴƎ ά/ǳǊǊŜƴǘ ¢ŜƳǇŜǊŀǘǳǊŜ ƛǎ нлϲ/έΦ 
With string R100 being 23 Char long 
όά/ǳǊǊŜƴǘ ¢ŜƳǇŜǊŀǘǳǊŜ ƛǎ άύΦ ¢ƘŜ ǊŜƎƛǎǘŜǊ wнл 
would be the temperature with length 2 
όάнлέύΦ Cƛƴŀƭƭȅ ǎǘǊƛƴƎ wмнл ǿƻǳƭŘ ōŜ н ŎƘŀǊ ƭƻƴƎ όάϲ/έύΦ 
 

In this example, R300 is unpacked into string 
R100 and register R20 when power flows. 
For this example it would take apart string 
ά/ǳǊǊŜƴǘ ŎŀƭŎǳƭŀǘŜŘ ǾŀƭǳŜ ƛǎ нΦпрŜҌлоέΦ ²ƛǘƘ 
ǎǘǊƛƴƎ wмлл ōŜƛƴƎ ну /ƘŀǊ ƭƻƴƎ όά/ǳǊǊŜƴǘ 
ŎŀƭŎǳƭŀǘŜŘ ǾŀƭǳŜ ƛǎ άύΦ ¢ƘŜ ǊŜƎƛǎǘŜǊ wнл ǿƻǳƭŘ 
ōŜ ǘƘŜ ǾŀƭǳŜ ǿƛǘƘ ƭŜƴƎǘƘ у όάнΦпрŜҌлоέύΦ  
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3.3.11 Communication Instructions  
Use Communication instructions to open and close the serial port for sending ASCII data to 
communicate with external devices. 
 
Adding Communication Instructions 
To configure String instructions, perform the following steps: 

1. Click on the Communication instruction icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 
3. Double click the instruction to open its dialog box. 

 
Adding Open Port Instructions 
To configure the Open Port instruction, perform the following steps: 

 
1. Select a Baud Rate using the drop down list. 
 
2. Select a Parity value (None, Odd, or Even) using 
the drop down list. 
 
3. Select Data Bits (7 or 8) using the drop down 
list. 
 
4. Select Stop Bits (1 or 2) using the drop down 
list. 
 
5. Select Mode (RS232, RS422, or RS485) using the 
drop down list. 
 

6. Select a Protocol (None, Xon / Xoff, Modbus Master, Modbus Slave) using the drop 
down list. 

 
Enter Optional Parameters: 

1. Select how the Char Sequence is inputted (Hex or ASCII).  
2. Enter Send Start Characters in the Start Characters field (up to 4 characters). 
3. Enter Send End Characters in the End Characters field (up to 4 characters). 
4. Enter Receive Start Characters in the Start Characters field (up to 4 characters). 
5. Enter Receive End Characters in the End Characters field (up to 4 characters). 
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Adding Send To and Receive From Port Instructions 
To add the Send to Port and Receive From Port instructions, perform the following steps: 

 
 
1. Select or Add an ASCII tag that 
contains the string to be sent in the 
Source Tag field using the drop down 
list (for a Receive instruction: the 
String that will receive the characters 
from the serial port in the 
Destination Tag field). 
 
 
 

2. Select an integer register used by the instruction for status in the Control Register Tag 
field using the drop down list. The following table describes the control bits in the 
register: 
 

Bit Number Function 

Bit 0 (lsb) Enable (0 = Disabled, 1 = Port is Open AND Instruction is 
Enabled (Power flows to instruction)) 

Bit 1 Serial transmission done (1= function (transmit or receive) 
done, 0=not done) 

 
Other bits of the register are used for internal purposes and change state during 
transmission/receiving. 

 
3. Select or Add an integer register that displays the number of characters transferred 

from the source tag to the serial output buffer in the Character Count Tag field using the 
drop down list (for a Receive instruction: the Number of characters transferred from the 
serial port to the destination tag). 

4. Check either Send Start Character or Send End Character box if needed. 
 
  



 

171 
 
Adding Send to Marquee Instruction 
To add the Send to Marquee instruction, perform the following steps: 

 
1. Select or Add a Source Tag 
name/Address using the drop down list. 
 
2. Check the Use Mask box and enter a 
value, if you want to use Mask capabilities 
to compute message number. 
 
3. Enter a numeric constant as an Offset 
value to the message number if desired. 
 
4. Select or Add a Message Status Tag 
name/Address using the drop down list. 
 

5. Check one option for the action for Unmatched message numbers. 
 

6. Add/Edit the Message database by clicking on the View/Edit Message Database button. 
 
 
 
Adding Modbus Master Instruction 
Please go to Chapter 7. 
 
 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen. 
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Open Port:  
When power flows through this element, 

the Open Port instruction opens only Port 1 serial port using 
user specified parameters available as follows: 
ω Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400 
ω Parity: None, Odd, Even 
ω Data Bits: Seven, Eight 
ω Stop Bits: One, Two 
ω Mode: RS232, RS422, RS485 
ω Protocol: No Protocol, XOn /XOff, Modbus Master, Modbus Slave 

 
Note: When the serial Port 1 is 
being used for 3rd party 
communication, it cannot be used 
to communicate with the EZRack 
PLC Designer Pro. Please therefore 
use other communication options 
like Ethernet or Micro-USB. 
 
Send Character Sequence can be used to add up to a maximum of FOUR characters in the beginning 
and/or ending of every command that is sent out using this port. The 4 characters must be separated by a 
comma.  
 
Receive Character Sequence can also be used to verify a maximum of FOUR characters in the beginning 
and/or ending of every command that is received using this port. The 4 characters must be separated by a 
comma. You can also specify to make the Receive Character Sequence the same as the Send Character 
Sequence. 
 
If HEX values are used for the two sequences, two characters must be used to specify 1 HEX value. 

 
In this example, if S4 is on, the port will be 
opened with the parameters shown in the 
instruction. Please note that the Port command is 
executed ONLY once every time S4 changes state 
from 0 to 1. 
 

NOTE: The Open Port instruction is executed once every time the power flows to the instruction. It is recommended 
that the port be opened once, unless the com parameters have to be changed. In that case, the port should first be 
closed, and then reopened with different parameters. 
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Send to Serial Port: 
When power flows through this 

element, the Send to Serial Port instruction will send an ASCII 
string present in Src at memory location Aaaaa to the RS422 
port. The control and character count used for sending the 
ASCII string is specified by Cnt at memory location Ccccc and Ctrl at memory location Bbbbb, 
respectively. 
 
This instruction can only send out the specified ASCII string if the corresponding serial port has 
been already opened by the Open Port instruction in advance. If the serial port has not been 
initiated, the Send to Serial Port instruction will not send the ASCII string to the specified port. 
 
Start and End characters can also be sent along with the ASCII string being sent out from the Src 
register. You can specify Start and/or End characters to be included along with the ASCII string. 
The starting and ending characters are specified in the Open Serial Port Instruction. 
 

Receive From Serial Port: 
When power flows through this 

instruction, the Receive From Serial Port instruction will 
receive an ASCII string from the serial port and store it in 
Dest at memory location Aaaaa. The control and character 
count used for receiving the ASCII string is specified by Cnt at memory location Ccccc and Ctrl at 
memory location Bbbbb, respectively. 
 
This instruction can only receive the specified ASCII string if the corresponding serial port has 
been already opened by the Open Port instruction in advance. If serial port has not been 
initiated, the Receive from Serial Port instruction will not receive the ASCII string. 
 
Start and End characters can also be received along with the ASCII string being received. You can 
specify Start and or End characters to be verified when received along with the ASCII string. The 
starting and ending characters are specified in the Open Serial Port Instruction. 
 
 

Close Port:  
When power flows through this element, the 

Close Port instruction closes the serial port previously opened for communication by the Open 
Port instruction. Once the port is closed, it cannot be used unless it is re-opened by the Open 
Port instruction. 
 
  

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 
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Allowed Data Formats: ASCII and UNSIGNED_INT_16. 
 

 
In the example above, if S5 is ON (and the Port is Open), the Send Port command would send 
the ASCII string as per programmed parameters. If the port is not yet open, the instruction will 
do nothing, and the Enable Bit in the control register will remain 0, even if the S5 is on. 
 
 

 
In the example above, if S6 is ON (and the Port is Open), the Send Port command would receive 
the ASCII string as per programmed parameters. If the port is not yet open, the instruction will 
do nothing, and the Enable Bit in the control register will remain 0, even if the S6 is on. 
 

 
In the example above, if power flows to the close port instructions, the opened serial port is 
closed. Once the port is closed, it will not send any serial communication for any command 
(such as Send to Port, Send to Marquee) without reopening the port. 
  

Memory Type Syntax (A, B, C) Range (aaaa) Range (bbbb) Range (cccc) 

Registers 

Input Registers IR 1-64 1-64 1-64 

Output Registers OR 1-64 1-64 1-64 

Registers Internals R 1-16384 1-16384 1-16384 

System Registers SR 1-20 1-20 1-20 
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Send to Marquee: 
When power flows through this 

instruction, the Send to Marquee instruction sends out a 
message to a marquee based on the message number as 
specified in Src at memory location Aaaaa and Message 
Status Tag as specified by Ctrl at memory location Bbbbb. 
 
The Send to Marquee instruction must be used in conjunction with the Open Port instruction. If 
the serial port is not enabled by the Open Port instruction in advance, the Send to Marquee 
instruction will not be able to send messages to a marquee. 
 
Please Note: 
1. The port should be already open before this command can be used. 
2. The Send Marquee sends the message to Marquee only once each time power flows to it (rung condition becomes 
true) and does not send again until the Power flow is cycled to it (rung condition goes to false and true again). 

 
The Send to Marquee instruction uses a message database. You can place multiple Send-to-
marquee instructions in your ladder logic. But there is only a single message database. The 
database contains messages uniquely identified by message numbers. The Send-to-marquee 
instruction looks up messages from this database using the value in its source register as the 
Message number (or computed from it-- see below). If a message is found matching the number 
in source register, it is sent to the Marquee. If a matching message is not found, then the action 
depends on the option selected for unmatched messages. 
 
The messages can have embedded variables in them, allowing you to display dynamic data on 
the marquee. 
 
Message Number Computation: 
Src can also be assigned a constant value along with option to use Mask (in HEX). You can also 
add an offset to the message number based on the value specified. The Message number is 
computed as follows: 
 

Message Number = [(Source AND MASK) >> number of right 0s in MASK] + Offset 
 

MASK allows you to use only selected bits from a word as a message number. Offset 
allows you to add a constant to the message number which allows grouping of 
messages. 

 
Example:  Source number = 0x1234, MASK = 0xFFF0 

Source AND MASK = 0x1230 
Shift by 4 = 0x0123 (There are 4 zeros on right of MASK) 
Add Offset to get the message number 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 
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Message Status Tag: 
Ctrl is used by the Send to Marquee instruction to specify the status of the message being sent 
to a marquee. If the message is being transmitted to the serial port, the bit 0 (lsb) of Ctrl is 
enabled (1). When the message is successfully sent to the serial port, the bit 1 of Ctrl is enabled 
(1). 
Message Database: 
When the Send to Marquee instruction is assigned a message number through Src, the message 
corresponding to the message number is selected for transmitting to the serial port. The 
Message database is populated by ǳǎƛƴƎ ά±ƛŜǿκ9Řƛǘ aŜǎǎŀƎŜ 5ŀǘŀōŀǎŜέ ǘŀōΦ ²ƘŜƴ ŀŘŘƛƴƎ ŀ 
new message the text can be assigned a message number and attributes such as blinking, 
scrolling, and centering of messages etc. The very first message in the Message Database is the 
default message. This message is sent to the specified marquee(s) (broadcast or a certain unit) 
when the message number assigned by Src does not have the matching message in this 
database. 
Note: Only messages with the correct message number as per Src register will be displayed. 

 
Actions for Unmatched Messages: 
If the Src register points to a message number that does not exist in the Message Database, then 
there are three options, one of which can be selected by the user for appropriate action. 
ω {ŜƴŘ 5ŜŦŀǳƭǘ aŜǎǎŀƎŜΥ {ŜƴŘǎ ŀ ά5ŜŦŀǳƭǘ aŜǎǎŀƎŜέ ŀǎ ǎǇŜŎƛŦƛŜŘ ƛƴ ǘƘŜ aŜǎǎŀƎŜ 5ŀǘŀōŀǎŜ 
ω Send Blank Message: Sends out a blank message with no text; clears the display line of 

the marquee(s) specified in the Default Message 
ω Do Nothing: No action is taken if the correct message is not found  

 
 
 
 
 
 

Allowed Data Formats: ASCII, UNSIGNED_INT_16, UNSIGNED_INT_32, SIGNED_INT_32, 
and BCD_INT_16. 

In the example above, if S5 is On (AND 
the Port is open and not busy), the 
message is sent to Marquee. The message 
is sent ONLY once every time S5 changes 
state. So to refresh the message on the 
Marquee (for example, if an embedded 

variable changed), ensure that S5 changes state. Another example for the send marquee is 
shown on next page. In this example, the logic is monitoring 3 temperature ranges, and displays 
one of the 3 messages based on the temperature value. 
 

Memory Type Syntax (A, B) Range (aaaa) Range (bbbb) 

Registers 

Input Registers IR 1-64  

Output Registers OR 1-64 1-64 

Registers Internals R 1-16384 1-16384 

System Registers SR 1-20 1-20 
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Send to Marquee Example: 
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Modbus Master: 
Please see Chapter 7 for more information on EZRack PLC working as 

Modbus Master or Modbus Slave. 
 
Basic Modbus overview: 
EZRack PLC provides connectivity to other devices over Modbus RTU and Modbus TCP/IP 
protocol. You can use EZRack PLC either as a Modbus Master/Client or a Modbus Slave/Server. 
 
When used as a Modbus Master/client, EZRack PLC communicates and exchanges data with 
other Modbus slaves/servers. When used as a Modbus Slave, the EZRack PLC can respond to 
Modbus commands from a Master. The serial port on EZRack PLC is used for the Modbus RTU 
connection. The Ethernet Port is used for Modbus TCP/IP connection. 
 
Modbus Master Instruction basics: 
Select Modbus Master Instruction from the Menu item Instruction> Communication>Modbus 
or from the Instruction side bar. The instruction on ladder logic appears as follows: 

 
Please note the following about the Modbus Master instruction: 
ω The instruction is initiated when the rung is true (i.e. all instructions in the rung 

preceding the Modbus instruction are true) 
ω The instruction involves sending a command to the addressed slave, and processing the 

reply back from the slave, which is asynchronous to the ladder scan. The Power flows 
out of the instruction only after the instruction is completed, i.e. after either the reply is 
received or the instruction times out. Control Word can be used to see the progress of 
the instruction. 

ω If the rung condition becomes false before the completion of the instruction, the 
instruction is not completed. The sending of the command is completed but the reply is 
not processed, even if received. If the command was a write command, the values MAY 
be written, but cannot be guaranteed. 

ω It is advisable to use check the error code register for any potential errors after the 
instruction is completed. 
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Double click to bring-up the dialog box: 

 
 
The following attributes need to be set in the Modbus Master Dialog box. 

1. Communications 
Use this dropdown to select whether RTU or Modbus TCP/IP is used. If TCP/IP is used a 
filed will appear to input the IP Address of the Slave. 

Select whether using Modbus 
RTU or Modbus TCP/IP 

Control and Error are the 
EZRack registers with the 
Modbus Master Instruction 
status information.  

PLC Address is the starting 
location in the EZRack PLC 
where written or read 
information is stored.  

Enter how many 
consecutive registers or 
coils written or read from 
the Slave Device.  

For Register Communication 
select Byte Order 

Use the offset to select the 
address you will be 
communicating to.  If you 
use offset 5 then the address 
that will be read is 300005. 

Select the Modbus operation this instruction 
will do. The options including Read or Write, 
Coils or Registers, One or Many. 

For Modbus RTU enter the 
Modbus Slaves ID 

For Modbus TCP/IP enter the 
Modbus Slaves IP Address 
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2. Slave ID 
The Network ID number of the Slave Device we are communicating to. This may either 
be stored in a Tag or defined as a constant. Not used for TCP/IP. 

3. Modbus Command and Modbus Address  
{ŜƭŜŎǘ aƻŘōǳǎ ŎƻƳƳŀƴŘ ŀƴŘ ŀŘŘǊŜǎǎ ǘƻ ŎƻƳƳǳƴƛŎŀǘŜ ǘƻΦ ¸ƻǳ ŘƻƴΩǘ need to enter the 
command codes. In addition the Modbus address type is not entered; only the offset 
within the address type is entered. For example for holding register 400123, use only 
123. The address type is implied by the command. 

4. Byte Order 
Modbus registers are usually arranged as MSB-LSB. This flag allows you to change the 
order if necessary. 

5. Data Length 
Number of Data Items to process. The data length may either be stored in a Tag or 
defined as a constant. 

6. EZRack PLC Address 
Please enter the Starting EZRack PLC Address where information will be stored or read 
from. 

7. Control 
Enter the EZRack PLC address that will store the state of the execution of the Modbus 
Master instruction. Bit 0 (LSB) to Bit 4 of the Control address are used to indicate the 
status of the Modbus instruction as follows: 

 
 
 
 
 
 
 

8. Error 
Enter the EZRack PLC address that will store the Error codes if there is any error in 
execution of the instruction. A zero value (0) indicates no error has occurred. The error 
code must be checked only after the instruction is completed (i.e. the power flows out 
of instruction). See below for error codes and their descriptions. 

Bit Number Status when set 

B0 (LSB) Modbus serial Enable 

B1 Waiting on reply 

B2 Reply processed 

B3 Not used 

B4 Invalid length for starting address 

ERROR CODE Error Description 

01 Illegal Function 
The function code (command code) in the Modbus 
Master command is not understood by the Slave. 

02 Illegal Data Address 
The Modbus Master command tried to access an 
address not available in the Modbus slave device. 

03 Illegal Data Value 
The Modbus Master Instruction sent a value not 
acceptable to the slave. 

04 Slave Device Failure 
An error occurred in slave device, while the slave was 
trying to perform action requested by Modbus Master. 
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9. Timeout 
Enter the timeout period in tenth of seconds. EZRack PLC Modbus Instruction will time 
out if a slave does not respond to a command within this time. 

3.3.12 Data Logging Instructions  
Use Data Logging instructions to log tag data to an USB.  
 
Adding the Log Data to File Instruction: 
To configure the Log Data to File instruction, perform the following steps: 

1. Click on the Log Data to File icon on the right side of the screen. 
2. Position the mouse over the Ladder diagram and click the mouse to place the 

instruction. 

05 Timeout 
A reply was never received from the slave (the 
communication link Between the Master and the Slave 
may be disconnected.) 

07 Checksum Error Error in check sum of the reply 

08 Slave ID Failure 
The slave id in the master command message does not 
match the slave id Returned in the reply message from 
the Slave. 

09 Port not open error 
The Port on EZRack PLC is not opened for Modbus 
Master Instruction 
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3. Double click the instruction to open its dialog box. 

 
4. Select or Add a tag for Data Log Name. This can also be constant.  
5. Select whether to append hour, day, and month to Data Log Name. This means that 

every new hour, day and month a new .csv file is created. 
6. Select of Add a tag for File Size, Event/Enable and Status. 
7. Select the Log Type from the drop down. Descriptions are on next page. 
8. Enter Log Time Interval for time based data logging and select time base using the drop 

down options. 
9. Finally select up to 10 tags to data log. Options include data logging the date and time in 

the .csv file as well. 
 
Adding tags: 

a. If need be you can add a new tag by entering a new Tag Name. 
b. Now either press enter or right click on the Tag Name and the Add New Tag Details 

dialogue will appear. 
c. Enter the Tag Address in this screen.  
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Log Data to File 
When power flows through this instruction, 

the Data Log instruction will create and update a csv file on an 
inserted USB thumb drive (up to 64GB). The instruction will log the 
current value of up to 10 tags in this csv. You can use up to a 
maximum of 8 of these instructions. 
 

 
File Name: 
This option allows the user to set the File Name that the .csv is saved under in the USB. The user 
can either use an ASCII tag stored at memory location Aaaaa, or they can make this constant. 
Further options are to append the hour, day and moth that this data log happens. Appending 
these creates new .csv files each time the hour, day and month are different. 
 
Data Log Size: 
This is an unsigned 32 bit word stored at memory location Ccccc which will tell you the file size 
of the .csv on the USB.  
 

Aaaaa 
TAG 1 

Bbbbb 
TAG 2 

Ccccc 
TAG 3 

N 

File Name (Aaaaa) 

Data Log Size (Ccccc) 

Event/Enable Tag (Ddddd) 

Data Log Status (Bbbbb) 

Value 2 

Value 3 
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